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INTRODUCTION

The Nikobus home automation system is growing. Not only as a result of the introduction of a number of new
modules and components, but also because of the more extensive possibilities to tailor this home automation
system fully to the desires of the customer. The flexibility of the system is increased even further by the possibility of
configuring the Nikobus home automation system through the computer. The Nikobus software offers the installer
more possibilities for taking the wishes of the customer into account. In addition, the use of software saves time and
offers extensive documentation possibilities for each project.

How to use this manual

In this manual, we have assumed that you are familiar with the basics of the Nikobus home automation system and
with the functions of the different output modules. If you are not familiar with the basic characteristics of the Nikobus
system, we would refer you to the basic Nikobus manual. This manual is also included on the Nikobus CD-ROM.

This Nikobus software manual has been structured in two sections.

First, you will find several chapters explaining the different functionalities of the software and its possibilities by
means of practice-based examples, progressing step-by-step. These chapters can be used as study material or as a
support to master a particular item of the software and the programming. This relates to chapters 1 up to and
including 14.

Then comes the reference section (chapter 15) in which every detail of every screen is explained. Every part of
every menu, every icon and every button is clarified.

If you are taking your first steps with the Nikobus software, we suggest that you read through chapters 1 up to and
including 14. For most of these chapters, one or several practical examples have been provided. The files of these
examples are included on the Nikobus CD-ROM under the Examples directory. For each example, an empty file
also exists in the same directory. In these empty files, all the necessary inputs and outputs of the example have
been included, but no programming has yet been added. This will save the new user a good deal of typing work, and
will offer the option of using this empty file as a practice file. It is best to go through the step-by-step chapters while
you are sitting at a computer. The practical examples can then be rehearsed immediately by using the empty files.

If you already have more experience with the use of the Nikobus software, the Reference section (chapter 15) will
prove an excellent means for looking up detailed information in connection with all components and possibilities of
the Nikobus software.



nNiko

Iluminating ideas.

On paper or on the computer

The Nikobus software manual can be used in two ways. On the one hand, it can be printed out as a paper manual.
In certain circumstances it will be easier to use the manual in this way.

On the other hand, the manual can also be used directly on the computer. This offers a number of advantages, as
the manual is laid-out with built-in hyperlinks. On every page, there are certain buttons that can be used for
navigating through the manual. Furthermore, there are also a number of hyperlinks inside the text. These are always
printed in Bold and Underlined. When you click on such a link with the mouse pointer, you will jump to the related
section of a chapter or the beginning of a chapter.
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1. SYSTEM REQUIREMENTS

| System requirements for the computer configuration \

In order to be able to work with the program (Nikobus software 05-202-03), certain minimum requirements apply to
your computer configuration:

Pentium 100MHz processor:

Internal memory: 32Mb RAM

Video card: SVGA 800 x 600

CD-ROM drive: 4x

Mouse or mouse pad (portable)

Minimal 15Mb free space on the hard disk

Windows 95, 98, 2000, NT, Millennium, XP or Vista must be installed on the computer.

Obviously, a configuration with higher speeds will result in a better performance.

System requirements for the Nikobus installation

o ol e il e, e In order to be able to download the program to a Nikobus installation, the latter must, as a minimum, be fitted with a
-« TN NN logic module (PC-Logic 05-201), a calendar module (PC-Link 05-200) or a feedback module (05-207). For technical
N N \\\\\\\\\\\\h\\\ details concerning these modules, please refer to the Nikobus manual.
““““I'_‘““__\“‘:r In addition, an RS-232 cable must be provided to establish the link between the PC and the installation. This cable is
L_N e } fL:E supplied together with the PC-Link 05-200 or the PC-Logic 05-201.
Makess
s 05-200

I The reference of the output modules in the installation (switching modules, shutter modules and dim controllers)
oM RO ST S must finish in at least xx-xxx-02 (or a higher number). These modules have been provided with the option of
- Ees -"'.,.,.-’\; .\; ) -\X_/j' transferring their addresses to the computer. If you wish to upgrade an installation that is using older modules, this is
R gttt possible by returning the older modules to your wholesaler and replacing them by modules of this version. Please

1Y consult your wholesaler or your local Niko representative for more information.
.9 B
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2. INSTALLATION OF THE SOFTWARE PACKAGE

| Installation of the software on the PC |

The Nikobus software is delivered on a CD-ROM. Place the CD-ROM in the relevant drive of the computer. Click the
Windows® Start button in the left bottom corner of the screen. Then click Run. The window shown below will open.

Run 2

Tvpe the name of a program, Folder, document, ar
Inkernet resource, and Windows will open it For vou,

open: | diinikobus, exe| w
Select Language x| [ K ] [ Cancel ] l Erowse... ]
Pleaze select the language that you would like to uge during the
installation.
i sl i semdlisdens Smashen Type d:\nikobus.exe in the field Open. It is possible that the character d will have to be replaced by the character
Wwihlen Sie eine Sprache aus der unten aufgefithten Liste aus that defines the correct path of the CD-ROM drive of your computer. Click the OK button to continue.
In the next window, you can select the language that will be used during the installation. There is a choice between
TR English, Dutch, French, German, Spanish or Slovak. Click the language to be used and then the OK button.
2. EnglE
Nederlaﬂds
Francais
Deutsch
Cacel_|

41 Welcome E I

‘wielcome bo Mikobus Setup program. Thes program
S vl ingtall Nikobess on your computer,

=
It iz strongly recommended that you exit al \Windows programs:
bedowe unning this Setup Program.

Chick Canced bo quit Setup and close any programs pou have
mnring. Click Nest bo cantinue with the Setup program

- It is recommended to close all other computer programs before continuing with the installation procedure. If you

have not done this yet, click the Cancel button on the following screen, close all other programs, and then start
s e e e e again with de installation procedure. If all programs have already been closed, click the Next button.

and will be prozecuted to the masimum extent possble under
Iz,

[ _coe |
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In the following screen, the installation program suggests a directory on the hard disk into which the program data
can be copied. In most cases, this is a good choice. It can be confirmed by clicking the Next button.

Should you prefer to use another location on your computer hard disk, you can do this by clicking the Browse button
and then selecting another location.

Following this, the installation program suggests using the name Nikobus for the new program group. Confirm this
choice by clicking the Next button.

4% Choose Destination Location

Setup will install Nikobus in the following folder
Tomstal inko a diferent folder, chok Browss, and select
another foider.

“'ou can choosa not to install Nikobus by chcking Cancel to
et Satup.

7~ Destination Folder

C:\Program Files\Nikobus Epowss. . |

cho [Tt ] _coen |

5 Saiect PRGNS All the data required for the installation is now known. Click the Next button to continue the installation. Data will now
s the oo olthe Fiogan Haneom 90.p 2 sid N be copied to the hard disk. If you wish to make modifications, this can be done by using the Back button, which will
allow you to return to previous screens.

[Ficbs

Adobe

Adobe Acrobat 4.0
bass

Blus Byte

Bureau-accessoies

Coeel GALLERY Magic
DesignCAD Express Vession 12
Domati

Do

FileMakei Pio §

FREEDOM Furmware Loader B - Flemish

FREEDOM Wi B - Flemsh

Hewlett-Packard =

Bk [THed> || concdl |
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42 Stait Installation
“Y'ou are nows neady to nstall Nikobus.
P ot b e b eSck Installing |
= -
— Current File
Copying file:
C: 3w IMD OS5 YS T E MYwbar332 dil
<Back [ Hes Cancel |

— &l Files

42 Installation Complete

Nikobus has been successhully installed.

Press the Finish button to esst this nstallation.

< Back e =

The last screen indicates that the installation has been successful. Leave the installation procedure by clicking the
Finish button.

The installation program will now be closed. You will see that a shortcut to the Nikobus software has been installed
on the computer desktop. The icon shown below can be found on the desktop.

hik.obiLz
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3. GETTING TO KNOW THE NIKOBUS SOFTWARE

3.1. Starting the program

The Nikobus software can be started in several ways. On the one hand, the Windows® Start button can be used,
while, on the other, the program can be started conveniently using the shortcut on the desktop.

Starting by means of the start button

Once Windows® has started, click the Start button on the bottom left of the screen using the left mouse button.
Subsequently, select and click Programs, Niko, Nikobus. The Project info window will be opened.

Miko 2001
Mikobuz

M ik obuz

@ Matebook Manager
a#e] Favarieten ¥ @ O pztarten

| Starting using the shortcut on the desktop

A shortcut was placed on the desktop during the installation. Double-click the Nikobus icon to start the program. The
Project info window will be opened.

nik.obuz

11
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3.2. The Project info window

When starting the program, the Project info screen will always be the first to be activated. If you wish to start a new
project, please follow the description in Starting a new project. If you wish to open a project that already exists,
please follow the instructions in Opening an existing project.

Creating a new project

e When creating a new project, it is important to first complete the Project info window. This data is used, among

L | others, in the print-outs and when working with clocks.
Talephone number installer ,7

Mame client |

Telephone number customer

The following data can be entered:
- name of the installer

S i - telephone number of the installer
A - name of the customer
i W ' telephone number of the customer
e —— Below thls there is a Project info field where additional information concerning the project can be entered.
I ‘Wadnasday I Thursday

Weekend days |~ \yonda O Tu;g;;y' At the bottom of the screen, you will find the Weekend days field. If the customer has fixed weekend days, these

I Wednesday I Thursday should be marked here. The PC-Link module (05-200) makes use of this data to only carry out certain clock

:: Friday ¥ Saturday functions on weekend days or only on working days. As a standard, Saturday and Sunday are selected as weekend

¥ Sunday dayS.

Complete all the data and then click the OK button. The basic Nikobus software screen will be opened.
OK | All data in the Project info window can be modified or completed at a later stage.

12



Open

Look in: [ () Examples

A Q Nikobus project 1.nkb

=l

« @ o B

nNiko

Iluminating ideas.

| Opening an existing project

If you wish to edit a project that has already been created, you can directly click the OK button in the Project info
screen. The basic Nikobus software screen will be opened. Click on File and Open... in the menu bar. Find the

directory and the file you wish to open and click on the Open button.

Working with directories and files is explained later in this manual.

2%

My Network  File name: [Nikobus project 1.rikb

Files of type: |* kb

Lef Lo

13
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3.3. The starting screen and its components

AT The basic Nikobus software screen consists of several components.

. Title bar: Similar to other Windows® programs, the title bar has been placed at the top of the screen.
[&] nikobus - [Nikobul] _[&]x]

Menu bar: The menu bar is located just below the title bar. This contains the menus File, Edit, Program, View,
Window and Help.

File Edit Program Yiew Window Help

Standard toolbar: Different icons enabling you to directly access the most common menu items without having to
] BT [ e P E R open the menu structure are located on the standard toolbar (below the menu bar).

[DeEHRE BAaES=E7H | B2 % (2R

Function bar: The icons of this bar (located next to the standard toolbar) allow direct access to most of the Nikobus
functions.

Blo-<fiHET-o00GEOg O




Praject

GlaEE o w]

In this windouw you realise a tree view and introduce the
room {location) of the Mikobus components.

/@\. Adding a location.
@ Deleting a location,

Adding Mikobus components (Sensors, actors and
interfaces)

Deleting Nikobus components (sensar, actor and
interfaces)

Define Inputs
IN #

ouT Define Outputs

No pecture availabla

Display all connections ™
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In addition, the basic screen has been divided into two large sections. The first section is the Project overview
window. This is located on the left of the screen. At the moment, you will see the Project toolbar with large icons. In
the opening screen, a brief explanation of the different Project icons is given under the Project toolbar.

In the Project overview window you will be able to draw up a project tree structure. Here, all output modules and
input components will be entered per room. Rooms or locations can be added or deleted. In addition, Nikobus
components (sensors or actors) can also be added or deleted.

The connection list: The info window Connection list can be found on the right hand side of the Project overview
window. It will provide you with detailed information on the different components of your project and their
programming.

Status bar: On the left hand side, the status bar offers you context-related information. On the right hand side of the
status bar, icons and information relating to your project are displayed. Again, these are dependent on the screens in
which you are situated. More details on this will be provided later in the manual.

For Help, press F1 [ [ [ B | 00000

15
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4. FIRST PROGRAMMING IN A FEW STEPS

Project info

Name installer
Telephone number installer

Name client

HE

|r-1 kabus installer

00237601470

|I-l kabus customer

Telephone nurnber customer |00E237601470

Project info

L

Version [12.002

Weakend days

™ Maonday

I Wadnesday
™ Friday

F Sunday

Starting prograrnming the Mikobus software
Explained in a few steps

™ Tuesday
™ Thursday
¥ Saturday

|

o

In this section of the manual, you will be introduced to some initial, simple programming with de Nikobus software.
The best way is to carry out these steps yourself. If you would like to see the end result, you can open the file
Nikobus-project 1.nkb. This file is delivered as part of the CD-ROM and can be found in the directory \Examples\.

Starting the program

Start the Nikobus software.

Completing the project data

Complete all items of the Project info window: Name and telephone number of the installer and name and
telephone number of the customer. If desired, additional information concerning the project can be entered in the
Project info field.

If it is intended to be able to call up the customer’s installation by means of a modem, the telephone number of the
customer must be entered in the Telephone number customer field. Only figures may be used in this field. You
must write, for example, 037601470 and not 03/760.14.70. Obviously, the area code of the customer must also be
included. If the installer's modem is connected to an analogue internal switchboard line, it may be necessary to
insert another number (usually 0) to precede the area code so that an outside line can be selected for the
connection. Consult the switchboard manual for more information on this.

In the lower part of the screen, put a tick next to the weekend days that are applicable for your customer. For most
people, the standard setting (Saturday and Sunday) will be sufficient. If, however, your customer owns a hairdresser
business, it may be quite possible that his weekend days will be fixed on Sundays and Mondays. It is very important
to complete this information at this point in time. When you are working with the calendar functions of the PC-Link
module (05-200), this information will be used to differentiate between clock actions that must take place on
weekend days or on working days.

For this first project, you may retain the weekend days as Saturday and Sunday.

Click the OK button in order to store the data in the Project info window and to close the window.

16
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Opslaanine [ Nikobus fles 3 & A e

2 Nkobus project 1.nkb:

Bestandspaam: [Nikobus project 1.nkb Opslaan l

Opslaan als type: I'nkh _'] Anrudeten l

——————— Frsject i —_—

Gl ] k] o |

A

Froject survey ———————————————— x|

(o} | (k| =] = ot v

g Distribution panel garage

Ut
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Naming your first project

It is advisable to give each new project its own name. If you do not do this yourself, the program will automatically
assign a name to a new project. For the first project, the name Nikobu1.nkb will be used. For all subsequent
projects, the number in the name will be increased by one unit.

If you program several projects, it will be easier if the name of the file tells you something about the project. For
example, the name of the customer could be used as the file name.

Open the menu item File and click on Save as. The Save as window will be opened. In Save as, select the directory
in which you would like to save the new file. If required, you can create a new, separate directory in which to save
your projects. You could, for example, create a directory Nikobus projects. In this directory, you could create
another separate sub-directory for each customer (for example Customer X). In each customer directory, you could
then create the directories Nikobus files and Nikobus drawings. In this way, all the data can be stored in an
identical, well-organized structure.

Under File name type Nikobus Project 1. Click on the Save button. The program will add the extension “nkb” behind
each new file name. The window will disappear and the name of the new file will appear in the title bar.

@nikuhus - [Mikobus project 1.nkh]

| Adding a location or a place

You will find the icon with the house and the plus symbol (add location) In both the standard toolbar and in the
Project overview window toolbar. Click on this icon. A small house with the name Location_1 will appear In the
Project overview window, below the Project overview toolbar.

Type the name Distribution panel garage and close with the Enter or Return key. You have thereby indicated that
a distribution panel has been mounted in the garage for your project.

| Adding an output module

Please ensure that the OUT toolbar button on the Project overview toolbar is activated (pressed in), as you wish to
install a switch module in the distribution panel in the garage. Switch modules, shutter modules and dim controllers
belong to the output components (output units) of the Nikobus home automation system.

17



module or the dim controller.

iste de produits

5]

03-000-02 : Swvitch madule
05-001-02 : Shutter module
05-002-02 : Compact switching unit
05-007-02 : Dimcortroller
05-003-02 : Compact dimcontroller
0:3-203 : SM3 interface

05-205 : Audio link

Switch madule

T e

Double-click Switch module.
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Clicking the New modaule icon opens the Product list window. Here, you can select the switch module, the shutter

By doing this, the new switch module will be listed under Distribution panel garage in the window Project
overview. You will see that code S1 has been assigned to this module.

———— Fraject sverview

=

(o} ] {o

= for o

witch module

Eﬁ Distribution panel garage

18
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You can open the switch module S1 by clicking the box with the plus symbol in front of the name. This will give you
an overview of all switch outputs of this module. The name of each switch output starts with a number. For example,
you wish to connect the lighting of the garage to switch output O01. You will therefore adapt the name of this switch
output. Using the right mouse button, click 001: Switch output. A pop-up menu will appear with, among others, the
option Change output name. Click this menu item with the left mouse button. Type LP garage and confirm with the
Return key. You will see that the name of output 1 has been changed to O01: LP garage. Any desired name can be
used. The abbreviation LP stands for light point, and can save you quite some typing work when introducing alliance
names.

You will see that the program retains the numbering 001 for the new name.

You will further notice that there is a drawing of the switch module on top of the screen in the info window. As you
have currently selected output O01, a small black box can be seen on output 1 of the drawing.

| Add a new location and a push button

You will consider the distribution panel in the garage as a separate location; the garage itself is a different location.
You create the location Garage by clicking the New location icon. Now, change the name suggested by the
program to Garage. Then enter this name by clicking the Return key.

19
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As you wish to add a push button, click on the IN icon in the toolbar of the Project overview window. Push buttons
are part of the input components of the Nikobus home automation system.

Select the location Garage and click the New module icon. The content of the Product list will now be modified. In
this list, you can now only select input components. Assume you would like to install a Nikobus push button with 2
operating buttons in a particular place in the garage. Double-click the name 05-060: Bus push button, 2 operating
points.

05-045 : Nikobus PIR B

5] 05-055 : Modular interface

[ 05-056 ; Pushbutton interface

(m] 05-057 ; Switch interface

] 05-080 : Bus pushbutton, 2 aperation points
=] 05-081 : Push buttan, 2 operation paints + LED
[T 05-064 : Bus pushbutton, 4 aperation points
05-081 : IR bus pushbutton, 2 operation points
05-085 : IR bus pushbutton, 4 operation points

[E] NE NG - 10 ke mehbadton idanticsl sddeanone =
|Eius pushbutton, 2 operation points
= =

i = ® BF
™) ® | pso60 e &
‘m. mY

Advice

As a result, the name BP1: Bus push button, 2 operating points will appear under Garage in the Project
overview. At the same time, the bus push button will be pictured in the info window.
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Programming the push button

You now wish to program the installed push button. With this push button, you want to switch the light point in the
garage on and off. Pressing the upper part of the push button should result in switching the light point on, while
pressing the lower part will result in switching the light point off.

You add a link or connection (between an output and an input) by clicking the New connection icon in the info
window or on the toolbar. The icon will only be displayed if you select a new component in the project overview.

As a result of this, the window Create connections will be opened, as pictured here on the left.

In this window, you will always work from left to right. This means that, for the programming, you will start from an
output, then you will select the connection mode or function, and only then will you select the push button that will
carry out this function.

The output to be programmed can be selected by clicking S1: Switch module. When doing this, all outputs of the
first switch module will be shown. As you wish to do something with the light point in the garage, you now select the
first output of this switch module by clicking 001: LP garage.

When clicking the arrow in the white, upper window in Connection mode, all possible functions of the selected
module will be displayed. You wish to use mode M1, which is a dual button operation. You will therefore click M01
(on/off).

In the Input window (on the right of the Create connections window) all inputs will now be displayed. And, indeed,
push button BP1 is listed under Garage. Clicking on BP1: Bus push button, 2 operating points, will result in the
visualisation of the operating points of this bus push button. Now click AB: Input.

For mode M1, no parameters exist. You therefore cannot enter any. In this case, you also do not wish to introduce
any condition that is dependent on the status of 230V A and/or B inputs of this switch module. Do not, therefore,
touch the small window AB condition.

Finalise your programming for this push button and output by clicking the Add connection button. If you wish to
stop programming, click the Close button as well. This will close the Create connections window.

You will see that the Connection list window has been updated. The Connection list for BP1 is displayed. From
this list, it is clear which operating points are involved, which output of which module is involved, which mode has
been programmed, and possibly the status of the setting wheels T1 and T2, whether there is a condition
programmed with the 230V inputs A and/or B of the module concerned, and possible filter functions. But more about
this later on.

21
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—— Connection list BP1: Bus pushbutton, 2 operation points

Cutput Description Connection kMode | T1

Filter condition

AB: Input 001: LP garage

This was your first programming session. The next step will be downloading the program to the installation. This will
be discussed in chapter 10. In chapter 5, the development of a larger project will be discussed.

22
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5. DEVELOPING A SIMPLE PROJECT

In this chapter, you will develop a simple project. For the moment, we will not yet make use of the clock module or
the logical functions module. You will, however, make use of the 230V inputs of the modules as an input. In addition,
you will create groups in order to be able to carry out group controls, and will also try to use different functions, the
programming of which will serve as an example for your projects. For some of the functions, you may be inspired by
the practical Nikobus examples, as described in the Nikobus Manual. The practical examples described below can
be found in the Nikobus project 2.nkb file, fully developed. This file is located on the CD-ROM under the Examples
directory. In the same directory, you will also find the empty file Nikobus project 2 empty.nkb. This file consists of a
project structure, but does not include programming. You can use this file for practice.
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5.1. The floor plans

For the development of this project, you will base yourself on certain parts of a one-family-house. The ground floor
contains an entrance hall with a cloakroom and toilet, an office, a garage, a kitchen and a dining room/lounge. In
addition, there is a terrace at the back of the house, which is fitted with a sunblind. Every window on the ground floor
is fitted with a shutter. The garage door is operated electrically by means of pulses. In the lounge, two wall sockets
have been fitted for the control of standard lamps. The office is also equipped with a wall socket of this kind. The
ground floor has 4 separate heating circuits (central heating with gas).

On the first floor, there are two children’s bedrooms (bedrooms 1 and 2). There is also the parent bedroom, a play
and guest room and a bathroom. All rooms and the bathroom have a separate heating circuit (central heating with

gas).

One electrical distribution panel will be installed in both the garage and the attic. The toilet on the ground floor and
the bathroom are both fitted with a ventilator.

Clicking on the drawings on the left will enlarge them.
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5.2. Opening an existing project

In chapter 4, you created your first Nikobus project. In order not to waste this preliminary work, you will now use this
Open 3] existing project to create a new project.
Lookir: [ C5 Examples +| « @& ckE-
) = hikobus project 1.0kb) You open the previous project by clicking File and Open on the menu bar. In the window that is now opened, you
=9 first select the directory in which you have saved your previous project. You then select Nikobus-project 1.nkb and

My Recent

Documents click the Open button. Your previous project will now be opened.

€

Desktop

~l

My Documents

49
My Computer

4 _ |
My Network File name: Nikobus project 1.nkb =]

Flaces
Files of type: “nkb | Cancel
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Save As

Save in: | ) Examples

5 =) Nikobus project 1.nkb

£

My Recent
Documents

u

Deaskiop

My Documents

48

My Computer
4

My Network.
Places

File narme:

Save as ype:

- «e®mckE-

7%

Nikobus project 2 kb

“.nkb

Save |

Cancel

5.3. Re-naming your project

You now wish to give your project a new name. To do this, click on File and Save as in the menu bar. In the field
File name fill in the new name for your project: Nikobus-project 2.nkb and click the button Save.
The new name will appear in the title bar.

|ﬂ nikobus - [Mikobus project 2 _nkh]
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5.4. Deleting modules and rooms

In your previous project, you installed a switch module in the distribution panel in the garage. This first switch input
was named LP garage. You would like to retain these items.

In addition, you created the room Garage and installed a push button there. You would temporarily like to delete
both these items from your new project. To achieve this, proceed as follows.

| Ensure that the IN icon is selected.

Select the push button that is to be deleted from the garage by clicking on it. Using the right mouse button, click
BP1: Bus push button, 2 operating points. Now click the field Delete module.

=6} Garage
L EP1: B 5] A mode inh points Click on the OK button in the confirmation screen. The bus push button will be deleted.
E=] Change moduls name
% Delete maodule nikobus |
Mevy connection

i q Thiz module contains linked ohjects.
\'\r) Are you sure you wyant to remove this module

All connections will be lost.

In the same way, you can now delete the room garage. Using the right mouse button, click Garage and then Delete
location. The room Garage will be deleted.
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fai Distribution panel garage
a7 Distribution panel attic
fa; Garage

i Office

iai Entrance hall

tai Toilet ground floor

i Staircase

imr Kitchen

ta; Living room

iah Front door outside

£4 Night hall

it Bathroom

it Bedroom 1

i0t Bedroom 2

iah Guest room

fai Bedroom parents

f Terrace

5.5. Adding other rooms

You can now enter all the rooms of the house into the software. To do this, always click the relevant icon first (house
with plus symbol), type in the name and close with the Return button. First of all, create a new distribution box.
Name it Distribution panel attic. Only after this has been done will you enter every actual room of the house. The
result will look like the illustration on the left.
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5.6. Adding components to the distribution panels

ouT

El

El ﬁ Distribution panel garage
. ®m-BE D1: Dimcaontroller
H-E3 R1: Shutter module
E-Ep S1: Switch module
E-E8 52 Switch module

Elﬁ Distribution panel attic
--E 02 Dirncontroller
m-E2 53 Switch module
B-ER 54: Switch module

It is now time to place and name all alliances of the house in the distribution panels. Make sure the OUT icon on the
Project overview window toolbar is activated. In this way, only the output modules will be displayed in the Product
list.

In Project overview, select Distribution panel garage. Now click the New module icon. If the Product list had not
been opened yet, it will now become visible. In this list, you can either select the dim controller, the shutter module or
the switch module.

Double-click Switch module and a second switch module will be added to the distribution panel in the garage. In
this distribution panel, you will also require a shutter module and a dim controller. Double-clicking these modules in
the Product list will result in placing these modules in the first distribution panel.

Now you wish to add a few modules to the second distribution panel. To achieve this, select Distribution panel

attic and proceed in the same way as when adding the output modules in the first distribution panel.
Add a dim controller and two switch modules.
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5.7. Adding and naming alliances

The moment has now come to assign a place on the output modules to each alliance in your project and to assign
each of them an unambiguous name. This will simplify matters later when you will start programming and you will
need to select particular alliances.

You must ensure that the OUT toolbar button is activated.

| Adding alliances to switch module 1

In the Project overview window, you first double-click Distribution panel garage and then S1: Switch module.
You will see that the first output of this module has been assigned the name 001: LP garage, as this was already
done in your first project.

With the right mouse button, click 002: Switch output. Then click on the new field with the message Modify output
name with the left mouse button. Now type the name of the alliance that will be connected to the second output of
the first switch module. In this case, this will be LP kitchen central. This indicates that the central light point of the
kitchen is linked to this output. Close this operation by pressing the Enter key.

With the right mouse button, click on output O03: Switch output. Click on Modify output name and enter the name
LP kitchen cooking area. Close by pressing the Enter key.

All other alliances of switch module 1 are entered in the same manner. This will result in the screen below.

For the time being, we have left output O06 of switch module 1 alone. This output will be used later for special
programming.
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It is recommended to delete the name Switch output next to unused outputs. In this way, it becomes quickly

visually clear which outputs have already been used, and which outputs are still free. In order to do so, select the

free output, click the right mouse button and select Modify output name. Subsequently, press the Backspace key

of the keyboard and the Enter key. As you will see from the picture on the left, it is clear at a glance which outputs
are in use, and which outputs are still free.

Adding alliances to the other modules

You included a second switch module in distribution panel 1 of the garage. In addition, a shutter module and a dim
controller were also installed. You must also add and name the alliances for these modules. This will take place in
the same way as described above. For your second project, the result will appear as follows:

| Adding the alliances to distribution panel 2

You can now place and name all alliances that will be connected to the modules of the second distribution panel
(attic) in exactly the same way. The result is shown below.

BB 53 Switch module B2 D2: Dimcontroller
2§ 001: LP bathroorn central 1 e £ 001: LP bedroom parents central

B-E2 =4 Switch module 2§ 002 Yentilatar bathroom e £ 002: LP bedroom parents bed left

=g 001: LP night hall office 2% 003 LP bathroom washbasin =~ 1 €9 003 LP bedroom parents bed right

2§ 002 LP bedroom 1 central 2§ 004: LP bathroom hath + shower 1 e £ 004 LP guest room bed

2§ 003 LP bedroom 1 wardrobe -Z& 005 LP bedroom parents wardrobe | - £ 005 LP night hall central

2§ 004: LP bedroom 1 office -Z& O0B: LP bedroom parents table | - £ 008 LP bedroom 1 bed

2§ 005 LP bedroom 2 central 2§ 007: LP guest room central 1 e £ 007: LP bedroom 2 bed

-Z§~ 006 LP bedroom 2 wardrobe 2§ 008: LP guest room wardrobe 1 b £ 005

~ZF 007 LP bedroom 2 office -Z& 009: LP guest room office 1 £ 009

2§ 008 LP attic 2% 010: Bathroom heating night 1 2 010

2F 009 2§ 011: Bedroom parents heating night ~— § - 2 011

-=§ 010 LED heating first flaor 2§ 012: Guest raom heating night 1 e 2 012

2% 011: LED heating ground flaar

-Z& 012: Bedroom 2 heating night

Here also, you will immediately spot the unused outputs if you delete the standard name.
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5.8. Transferring alliance codes to the drawings

In order to be able to work easily, quickly and clearly, it is of vital importance to enter a code on the alliance symbols
in the drawings. This code can be found in the software program.

Example: The light point in the garage will be connected with output 1 of switch module 1. The code you will use
here will therefore be $1.1. The central light point in bedroom 2, which is connected to output 5 of switch module 4,
will be S$4.5.

If a alliance has been connected to a dimmer, and the latter is controlled by a dim controller, you will start the code
with the letter D. For alliances connected to the shutter module, you will use the letter R.

In this way, it is not only clear from the floor plan which alliances are connected to what type of module, but also to
which output they are connected. Please also provide each module that is placed in the distribution panel with a
sticker with its code name (81, S2, S3, S4, D1, D2, R1, ...).

R12 R13
i 5 = =

! SIS

& & z &
3.2 =12 512 s1.2 @ T @
kitchen D1z
3
z = st @
g | @ Q-/

O

!
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5.9. Indicating operating locations on the drawings

The moment has come to indicate the location where one or several operating elements (push buttons) must be
placed on the drawings. For a traditional electrical installation, you would tend to show every switch and push button
on the drawings. For a Nikobus home automation installation, however, this is not the case. One reason is that this is
not required for the inspection report, as a very low safety voltage is used. The push buttons that are supplied by this
very low safety voltage need not be indicated on the inspection circuit drawings. But there is more.

A home automation system has a flexible set-up. Today, for example, three push buttons will be placed in one
particular operating location, tomorrow, however, it could be four or two. This would mean that, for each change,

527 your plans must be adapted accordingly. You prefer not to do this, and have opted for a different, timesaving
method.
] R14 R1.2 On each location where one or several push buttons must be placed under the same cover plate, you mark a
& $522 o - 522 _ coloured square on the plans. This will make you already aware that a flush mounting box will be installed in these
i+ locations.
S —
& The exact number of push buttons to be placed in one specific operating location is not yet clear at this point in time.
u - S“D The Nikobus software will show you how to solve this. At a later stage, all these operating locations will also be
N i assigned a code on the floor plans
& & 2 2 &
SAC 2 812 g1z s12 This methodology also favours a clear overview of the drawings. Assume you have to draw four push buttons with
Kitchen their accompanying codes. It would not take long before your drawings would become unclear. As a result, mistakes
3 NN could be made on the building site. You will try to avoid this by keeping the drawings simple and, at the same time,
|;§[ L P clear.
— Og)| 8 | @
-ﬁ| O On the drawing on the left, the operating locations are marked with a yellow square.
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™

E| ﬁ Garage |

..... ﬁ |:|0fﬁ : Bus pushbutton, 2 operatio EAdd el

_____ ﬁ Entrance hall % Change module natme
------ {4 Toilet ground floor ESJ Delete moduie

""" ﬁ Staircase New connection

------ £} Kitchen -

EI ﬁ- Garage
...... |:| EF1: LF garage ondoff

=- ﬁ Distribution panel garage
' l =-E D1: Dirmcontroller
! =-E R1: Shutter module
B2 51: Switch module

;i’- 001: LP garage

annectinn rmode

MO1 (On / off)

5.10. Placing and programming the first push buttons

| Placing and programming the first push button

In the Nikobus software, you will now place and program push buttons in a first room. Make sure that the toolbar
button IN is activated. As a result, the Product list will list all the push buttons that could possibly be used, one after
the other.

Your starting point is a first operating location in the garage, by the door to the kitchen. In the Project overview
window, select the room Garage. For all operating locations, the agreement is that the push buttons (if several push
buttons must be installed) will be placed horizontally next to each other.

Start by placing a first push button for the operation of the lighting in the garage. In the Product list, double-click 05-
060: Bus push button, 2 operating points. This bus push button is now visible under Garage in the window
Project overview.

EI ﬁ Garage
SR CF1: Bus pushbutton, 2 operation points

On clicking BP1: Bus push button, 2 operating points, with the right mouse button, a short drop-down menu will
appear. Here, click Modify module name. As a result, you can now modify the name BP1 in LP garage on/off. You
close the text entry by pressing the Enter key.

The name of this bus push button is now BP1: LP garage on/off. This indicates what the function of this push
button will be. The result is shown in the picture on the left.

Select this bus push button and click in the Info window on the New connection button. The window Create
connections will be opened as a result. Search for and select the light point in the garage in the output list. This can
be found under switch module 1, first output.

Here, you wish to have the light point in the “on” position when you press on the upper part of the push button and in
the “off” position when pressing on the lower part of the push button. Click on the arrow under Connection mode
and select M01 (on/off).
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Only now you will see the relevant bus push button appear in the input list under Garage.
Eﬁ Distribution panel garage
- BB S1: Switch module
=-fa) Garage
=-[2] BP1: LP garage on/off
E'ﬁ Click on BP1: LP garage on/off and subsequently on AB: Input.
E||:| BP1: LF garage onfoft
LE AR Input As you do not wish to add any parameters or conditions to this programming, close by clicking the field Add

connection. Exit the window by clicking the Close button.

Add connection | The programming of your first push button has now been completed.

Copying a push button

- Copying between touch screens is possible

If a touch screen is selected in the project overview (feedback link with activated touch screen), you can copy this
module entirely (right mouse button, menu, icon). Add the new hardware and copy all connections (keys + LEDs)
Only the unique address is canceled.

- Cpying the functions for controls is carried out in the same way.

Project overview =

] (k| | | our || v

-I-fai Location_1
E BP1: Feedbackbution, et
B B add module
B3 change module name
B3 Delete module

Copy (hutton) module

EE' Mew connection
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A second push button next to the first one \

At the same operating location, you wish to place a second push button for the operation of the shutter in the
garage. You proceed largely in the same way as described above.

In the Project overview window, select the room Garage. Double-click 05-060: Bus push button, 2 operating
points in the Product list. Modify the name of this bus push button into BP2: shutter garage up/down.

Add a connection to this push button and select as output O06: Garage shutter under the shutter module in the
distribution panel of the garage. As mode, select M1 (open — stop — close). In the input window, select BP2: shutter
garage up/down and subsequently AB: Input. For T1 Run time, set the time for this shutter. In this case, choose
20 seconds. Click Add connection and subsequently the Close button.

Transferring the codes to the floor plan

On the floor plan, you place the code BP1-2 next to the yellow square (operating location) in the garage by the door
to the kitchen. This will indicate that BP1 and BP2, the two push buttons you have programmed in the software, have
actually been placed here.
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5.11. Placing and programming the other push buttons in the garage

| Placing the other push buttons \

You also wish to place a few bus push buttons at the operating location by the garage door. First of all, you would
like to have a push button for operating the garage lighting and for the exterior lighting. The push button for the
garage lighting has the same functionality as BP1. Refer to section 5.10 of this manual for the programming. The
functionality of the push button for the exterior lighting, however, is different. Pressing the upper part of the push
button must result in switching on the exterior lighting at the terrace and the garage door for a time period of 5
minutes. When pressing the lower part of the push button, the same light point should alternately switch on and off.

In addition, you require a push button for operating the garage door. Pressing the upper part will make the garage
door go up. Pressing the lower part will close the garage door. Pressing either the upper or the lower part while the
garage door is moving will make it stop.

A last bus push button in this location in the garage will be used as a simple master-off button. At this point in time,
5 you do not yet make use of the special bus push button for switching between presence simulation, week or
4"“ E'-F'4] BPSJ weekend schedule. You must create an output group for the master-off function.

You will use a four-way bus push button (05-064) for the lighting, a two-way bus push button (05-060) for the garage
door and you will install a bus push button with LED (05-061) for the master-off function.

--fnf Garage In the Project overview window, select the room Garage. Add the different bus push buttons by double-clicking in
[Z] BP1: LP garage on/off the Product list window.

[E] BP2: Shutter garage up/down

[Ed BP3: Bus pushbutton, 4 operation paints

=l EP4: Bus pushbutton, 2 operation paints Programming the exterior lighting

Program the AB section of the first push button (BP3) for the lighting of the garage as described in section 5.10 of
this manual.

Now program part C and D of BP3 for the lighting of the rear outer wall. Modify the name of the push button to BP3:
LP garage / rear outer wall.

Click New connection, which will open the Create connections screen. Among the outputs, select 002: LP rear
outer wall for switch module 2 in the distribution panel in the garage. Select M6 (delayed-off) as the connection
mode and set the parameter T1: Long time frames (up to 2 h) for 5 minutes. In the input list, select BP3: LP
garage / rear outer wall and subsequently C: Input. Close this programming by clicking the Add connection
button.
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Now modify the Connection mode to M5 (impulse) and click D: Input in the input list of BP3: LP garage / rear
outer wall. Close this also to add the connection.

When exiting the Create connections window (by means of the Close button), you will see the programming for
bus push button BP3 displayed in the Connection list window.

—— Connection list BP3: LP garage / rear outer wall

Input Description | Output Description Cannection Mode | T1 T2 AB C... | Filter conditian
& 2B: Input O01: LP garage (S31: Switch...  MO1 (On / off)

L9 C: Input 002 LP rear outer wall (52:... | MOG (Delayed ... | 5 m None

[d D Input 002 LP rear outer wall (52:... | MOS5 {Impulse) None

Programming the garage door

For the garage door, it is recommended to work with a system that uses two separate pulses for raising or lowering
the garage door. BP4 has been renamed to BP4: Garage door. Activate the screen Create connections and select
output O07: Garage door pulse open of switch module 2. Select M11 (delayed-off short). T1: Short time frames
(up to 50 s) as the mode, and set to 1 s. In the input list, select A: Input of BP4: Garage door. Add the connection.

Select output 008: Garage door pulse close of switch module 2. Select the same mode and time settings, but now
select B: Input of BP4: Garage door. Again, close by adding the connection. Exit the Create connections screen,
and you will see the following in the connection list:

Light scene / Central function: the objectif of this function is to group a mited number of outputs.

—— Connection list BP4: Garage door

e Input Description | Output Description Connection hMode | T1 T2 AB C... | Filter condition
A Input 007 Garagedoor pulse ope...  M11 (Delayed ... 1s
=] B: Input 008 Garagedoor pulse clos... | M1 (Delayed ... | 1s None

Creating an output group

- P ) _ You want to program your master-off button. Up to now, you have always programmed for one single alliance. The
LoV AR T master-off function, however, must affect most alliances. You will therefore create an output group first.

Click on the Light scene / Central functions icon in the Function toolbar, as pictured on the left.
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The Guide window will be opened. Click the field Create new. ‘ Make mau |

In the newly opened window, enter the name of your output group. Type the name Master-off in
the intro window and click the OK button.

Hew Light scene ! Central Function I B3

Please enter the name of the new light scene / Central Function:

IMaster—Dﬁ

ok Cancel

In the next window, select either a 1-button, 2-button or 4-button operation with which to carry out this central
function. In this case, we wish to use a 1-button function. Therefore click the 1 Button and then OK, by which you
will exit this screen, and the Light scene / Central functions screen will be opened.
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Light scene / Central functions

Light scene / Central function Type [lew function
IMaster—oﬁ' j |1-buttnn Modify type | Delete function

Change function name |
F-¢3 Distribution panel garage Output description Mode [ |12 [sB. ]

w-{5} Distribution panel attic

=2 Addi=s |

== [Delete == |

Click Distribution panel garage, which will display the contents of this distribution panel. Then click D1: Dim
controller and all the outputs of this dim controller will become visible.

Now add an output to our new group Master-off by selecting it in the left window and then clicking the Add button.
Now do this for all used outputs of the dim controller D1, which will result in the following picture.
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Cutput description Mode T1 T2 AB conditi...
€2 001 LP staircase (D1: Di... | MD4 (Light scene on) 1s None
€2 002: LP dining table (D1: ... | MD4 (Light scene on) 1s None
2 003: LP couches (D1: Di... | MD4 (Light scene on) 1s None
2 004: LP coffee table (D1: ... | MD4 (Light scene on) 1s None
£2 005: LP television cabinet.. | M04 (Light scene on) 1s None
2 006: Standing lamp dinin... | M04 (Light scene on) 1s None
2 007 Standing lamp loung... | M04 (Light scene on) 1s None
25 008: Standing lamp office. . | M04 (Light scene on) 1s None

All these outputs can be included in the Master-off function. To do so, click next to each alliance in the Mode
column. A list will then be displayed with all the possible functions. In this case, select mode M6 (off). As you only
wish to carry out the Master-off function after you have pressed the relevant button for 2 seconds, select 2 s in the
column T1. If required, it is possible to set a switch-off time for each dimmer in column T2. These time frames range
from 1 s up to a maximum of 5 minutes. For reasons of safety, set the switch-off time for the staircase lighting to 30
seconds. All other dimmers are assigned a switch-off time of 10 seconds. The result will look as follows:

Dutput description fode T1 T2 AB conditi...
£ 001: LP staircase (D1: Di... | MOG (Off (eventually... | 2 s s None
€0 002: LP dining table (D1: ... | MOG (Off (eventually... | 2 s 10 s None
€0 003: LP couches (D1: Di... | MOG {Off (eventually... | 2 s 10s None
£ 004: LP coffee table (D1: .. | MOG {Off (eventually... | 2 s 10s None

21 005: LP television cahinet. . | MOG {Off (eventually... | 2 s 10 s None

£ 006: Standing lamp dinin... | MOG {Off (eventually... | 2 s 10 s None
. standing lamp loung... | MOG6 [Off (eventually... None

Output description Mode T |12 | ABconditi_ Then add the output 001: Terrace sunblind for the shutter module in the right window in the same manner. Here,
001: Terrace sunblind (R1 {Clos: F. . .
R m-,[oﬂ (ventmaee 120 |32 select mode M3 (close). Set the run time in T1 to 20 seconds.
€2 002: LP dining table (D1 {Dﬂ[wemually... 2s 10s HNone
4 003: LP couches (D1: Di MO6 (Off jeventually... | 2s 10s None
€2 004: LP coffee table (D1 MOG (Off (eventually... | 25 10s None
€2 005: LP television cabinet Nﬂi[l.lﬂ[eue:t:all;.,. 2s 10's Nn:e H H
06 Standing lamp drin__| M0 (OFf {eventually... | 2s [ 10s | None Add the outputs 1 to 5, as well as the outputs 7, 8, 10, 11 and 12, for switch module 1. Leave output 9 (ventilator
(9 O07: Standing lamp loung... | W06 (Off {eventually... | 2s [10s | None toilet) untouched. If this output is in the “on” position, you will later ensure that it will automatically switch to the “off”
4 008: Standing lamp office. MO6 (Off jeventually... | 2s 10s None

position. Select M3 (off) as mode for each output, with the exception of outputs 11 and 12, and set the parameter T1
to 2 seconds. This means that you will have to press the push button for 2 seconds in order to activate the Master-
off function. This function does indeed have to be carried out in a conscious manner.
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[ Output descripti Made T T2 [ABco.
|£‘ 001: LP garage (S1: Switch mo MO3 (Off, with opera... | 2s Hone
=%~ 002: LPkitchen central (S1: Sw MO3 (Off, with opera... | 2s None
" 003. LP kitchen cooking area (. MO3 (Off, with opera... | 2s None
|=F" 004: LP kitchen washing up (S MO3 (Off, with opera... | 2s None '
}i" 005: LP cloakroom (S1: Switch MO3 (Off, with opera... | 2s None
=% 007: LP entrance hall (S1: Swit MO3 {Off, with opera... | 2s Hone ”Ifum,na tl‘lng l‘deaS
|§' 008: LP office wall (S1: Switch MO3 Off, with opera... | 2s None
4 010: LP toilet (S1: Switch mod MO3 (Off, with opera... | 2s None
ﬁ 01 Maste of 51 w.c "- w"m-- s Dne In order to indicate that your Master-off function is activated, arrange for the LED on the relevant push button to
= 1 Staircase (S Wil 2 (On, with opera... 5 one . . . . . . . .
1 001: Termace sunblind (R1- Shu... | MO3 (Close) 20s None light up. Do this by linking mode M2 to output 11 of switch module 1 with an operating time of 2 seconds.
€2 001: LP staircase (D1: Dimcon. MO6 (Off (eventually ... | 2s s | None
€2 002: LP dining table (D1: Dimc MO6 (Off (eventually ... | 2s 10s | None . . . . i
£2 003: LP couches (D1: Dimcont... “B_t_l_'rOff eventually ... | 2s |10 | None | In addition, you want to arrange for the LEDs of the push buttons for the staircase lighting to light up (as the
€2 004: LP coffee table {D1: Dime tOﬂ [evenluel_ly |28 10s | None . . . . . . . .
2 005 LP television cabinet (D1, | M0 (OFf ~[2s [10s [None staircase lighting is off). To do this, select mode M2 for output 12 of switch module 1. The operating time should also
(2 006: Standing | dining n MOG (Off tually ... | 2 10 N
G o Sy | Of oty 22100 |t be set to 2 seconds.
2 008 Standing lamp office (D1: ... | MO6 (Off (eventually ... | 2 s 10s | None
- 001: LP front outer wall (52 5| M03 (Off, with opera... | 2s None Enter the outputs 1 to 5 and 10 to 12 for switch module 2. The first 5 outputs are also set to the “off” position by
=% 002 LP rear outer wall (S2: Sw. M03 (Off, with opera... | 2s None H H H
= 005 1P ofice (S Swich mod | 103 (OFF with opers-- |75 o sglectlr)g modIe M3 (off). The outputs 1Q, 11 and 12 will, howeyer, control the night contact of the thermostat. You
= 004 LP ofice cabinet (S2_Swi_| M3 (Off, with opera... |2's None will activate this night position when leaving the house. To do this, use mode M2 for these outputs.
=%~ 005 LP lwving room wall (S2: 5. | MO3 (Off, with opera... | 2s None
= 010: Office heating nicht (S2: S MOZ (On, with opera... | 2s None
ag 011: Living rooms heating night MO2 (On, with opera... | 2s None

By 012 Bedroom 1 heating night (

MOZ (On, with opera... 2s

None

Furthermore, also enter the connected alliances of dim controller 2 and switch modules 3 and 4. Here also, set
everything to the “off” position, except the night control for the thermostats, which will be set to the “on” position.

The creation of the group Master-off is now finished. Exit the current window by pressing OK. This output group can
be viewed in detail, as it is part of the Nikobus-project 2.nkb, which is included on the Nikobus CD-ROM. See
directory Examples.

Connecting the master-off output group to a push button

Click the OUT button in the Project overview window. You will see that the Groups directory has been added and

B ﬁ Groups
- =-[€ _CF1: Master-off
Eﬁ Distribution panel garage

822 @

that the output group CF1: Master-off is listed underneath. Select this group and click the New connection button.

In the Create connections window, you will see that your output group has been placed in the split window Output.
Now select this group. For Connection mode, click MCF (Activate light scene / Central function). In the split
window Input, and then select B: Input of BP5: Master-off. By doing this, you allocate the function Master-off to
the lower part of the push button. Finish the programming by clicking Add connection and then the Close button.

You can create a new group for the upper part of this push button, with which, according to your requirements, you
can arrange for some light points to be in the “on” position and through which, for example, the heating on the
ground floor and the bathroom can be returned to the comfort position.

BP3-5| |

On your floor plan, indicate BP3-5 next to the operating location in the garage by the garage door.

er1-2[ ||
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5.12. Creating an input group for the kitchen

| Creating an input group \

||I' — £ T — In the kitchen, enter operating locations 6 and 7. Operating location BP6 is a push button with 2 operating points.
1 L - BP7, on the other hand, is a push button with 4 operating points. Install these push buttons in the room Kitchen by
= first double-clicking on 05-060: Bus push button, 2 operating points in the Product list, and then on 05-064: Bus
51‘4 push button, 4 operating points. Rename these push buttons Lighting kitchen.
| |L_IBFE B Eﬁ Kitchen
¢ 8 ¢ s s L.[=] BPE: Lighting kitchen
51.2 q .2 51.2 =2 ] 51.2
Kitchen
Two operating points of both operating locations will perform the same function, as you wish to operate the central
‘ F] S lighting for the kitchen (S1.2) from both kitchen door openings, as well as creating a master-off kitchen. Let’s start
L L " [l W] oq 2 . .
D{} -z with the first.
=19
i | O In the Function toolbar, click the Input groups icon. ==

The Guide screen will now be opened. Here, click on the Create new button.

The New input group screen will be opened, and you can now enter the name for the new input group. Type LP
kitchen central on/off in the intro field and then press the OK button.

Hew Input Group ﬂ

Flease enter the name of the new Input Group:

ILF' kitchen central onfoff

T Do e Pty EeTIE ST (0] Cancel |

W {Ligel scece ouich) =
W1 Sre an

g e || In the following window, select either a 1-button, 2-button or 4-button operation. As you wish to make use of the
Impulse function, click the 1-button field. Close this window by clicking the OK button.

The Input groups screen will be opened.
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Input groups HE
Inputgroup Type New input group
LP kitchen central on/off |1'h““°" Modify type | Delete input group
Change name input group
Input object |l" I t |Lacati0n #{a) Garage
+ (o Kitchen
I o |
= fat Kitchen
El |:| BFE: Lighting kitchen By clicking the plus symbol next to Kitchen, you will see your two bus push buttons in the kitchen. In the same way,
_____ B A Input open BP6 and BP7. The result can be seen in the picture on the left.
""" [= B Input Select A: Input of BP6. Then click Add. You can do the same for A: Input of BP7.
& |:| BP7: Lighting kitchen
..... E g::npUI << Add <<
..... npu
----- 9 C Input , , -
_____ 0 D Input The added push button elements will be displayed In the left split window of the Input groups screen.
| Input object Component Location
=] & Input BFA: Lighting kitchen Kitchen
]

We have now created our first input group. Create a second one straight away by clicking the New input group
button in this screen. This group will be named Master-off kitchen. Here also, select a 1-button operation.

44



nNiko

Illuminating ideas.

The buttons you wish to add in this group are: B: Input of BP6 and B: Input of BP7. The result can be seen in
screen below.

Inputgroup Type
Master-off kitchen j I1 Button
Input object Component Lacation
[==] B: Input BPFE: Lighting kitchen Kitchen
]

Exit the screen Input groups by clicking OK.

| Programming the new input groups

Eﬁ' ?TUUPS In the Project overview window, you will find the two new input groups listed under the Groups directory. This is, of
i *~ 1G1: LP kitchen central on/off course, only the case if the IN icon has been activated.

== |G2: Master-off kitchen

You want to assign programming to both groups. To do so, click the New connection button.
For our first input group, select output 002: LP kitchen central of switch module S1.

: _ For the Connection mode, choose M05 (Impulse).

=B850 Switch module In the split window Input, select our input group 1G1: LP kitchen central on/off, and click the Add connection

- .ZF 001: LP garage button.

= 002 | Pkitchen central

;ﬁ' 003: LF kitchen cooking area E'ﬁ Groups

' |E| [G1: LP kitchen central onfoff
L] 1G2: Master-off kitchen

With this, the first input group has been programmed.

Tackle the second input group straight away. Start by selecting output 002: LP kitchen central of switch module S1.
Choose M03 (Off, with operating time) as the function, and select IG2: Master-off kitchen as the input group.
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Once again, exit the programming by adding the connection. You also wish to switch O03 and O04 off with the same
button.

Following this, use the same procedure for the outputs 003: LP kitchen cooking area and O04: LP kitchen
washing up.

Exit the Create connections screen.

If you consecutively click on the groups IG1 and IG2 in the Project overview window, the related connection lists for
these input groups will be displayed.

Input Descri Connection Mode | T1 Filter condition

| IG1: LP kitc... 002 LPkitchen central (S1:...  MD5 {Impulse)

Input Description | Cutput Description Connection Maode | T1 T2 AB C.. | Filter condition
IG2: Master-...  0O0Z: LPkitchen central (51:...  MO3 [Off, with ...

=] I1G2: Master-... | 003: LP kitchen cooking ar... | M03 (Off, with ... | 0's None

=] 1G2: Master-... | 004: LP kitchen washing u... MO3 (Off with ... | 0's None
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5.13. Linking a ventilator and a light point

B | Toilet, ground floor \

. In the ground floor toilet, there is a light point, a ventilator and a bus push button. Pressing the upper or the lower
- part of the push button should result in switching the light point on or off. In addition, the ventilator should come on
S (O for 2 minutes as soon as the light point is switched off.
V L
@ : Place a two-way bus push button in the toilet and call it BP8: LP toilet. Open the Create connections screen and
select output O10: LP toilet of S1. Select the connection mode M01 (On/off) and assign this programming to AB:
Input of BP8: LP toilet. Adding the connection will complete the programming for the light point.

® H Now select output O09: Ventilator toilet and select M06 (delayed-off) as a function with a timing of 2 minutes.
Connect this programming with B: Input of BP8.

BP8 This example is also described in the Nikobus manual under Nikobus-example 5.

The ventilator in the bathroom

| The bathroom is also fitted with a ventilator. You want to switch the central light point on and off with this bus push
button. As soon as the light point is switched off, the ventilator should come on for 5 minutes. If, however, the light
point remains on for longer than 9 minutes, the ventilator should automatically start working from the ninth minute

3 | <P onwards.
2 Place BP9: LP bathroom central in the room Bathroom.
Bath 2 In the Create connections screen, select output O01: LP bathroom central of switch module S3 in the distribution
arnroom b¢ panel located in the attic. The function to be used is M01 (On/off) and the programming should be assigned to AB:
b4 Input of BP9.
BPo * »

Now select the ventilator output 002: Ventilator bathroom on the same switch module. Select function M07
[] (Delayed switch on) with a time of 9 minutes and assign the programming to A: Input of BP9.

Finally, select the ventilator output once again, but now with M06 (Delayed-off) as connection mode with a time of 5
minutes. Place this programming under the push button in B: Input of BP9. The following is displayed in the
Connection list.
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Connection Mode | T1 T2 AB .| Filter condition
[= 2B Input 001: LP bathroom central .. W01 (On f off)
=] A Input o02: Yentilator bathraom (5. | MOV (Delayed ... | 9 m None
[=] B: Input o02: Yentilator bathroom (5. | MOB (Delayed ... | 5 m None

This example is also described in the Manual Nikobus under Nikobus-example 7.
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5.14. A delayed-off staircase lighting system

7 517 UK | Objective ‘
Hall D ‘
s1.7 BP0 Nothing is more annoying than staircase lighting that suddenly and automatically switches to the “off” position. Try to
* avoid such a situation by installing a staircase lighting system with a delayed-off light point and a blinking LED.
: 7
H @ Placing push buttons and creating input groups
| D11 | 7B |
. You installed bus push buttons with LEDs in the staircase. Name them BP10 and BP11. In the software, place them

in the Entrance hall and in the Night hall respectively. Both push buttons will now be renamed as LP staircase.

First, create two input groups for both push buttons. To do this, click the Input groups icon in the Function toolbar.
T - The first input group will be named LP staircase on, and a 1-button operation will be selected. Place A: Input of
BP10 and BP11 together in the group.
Then create an input group LP staircase switching and also select a 1-button operation here. Here, however, you
. . i add the lower part of the push buttons. This is always the B: Input of the push buttons concerned. Our input groups
will now appear as follows.

1 I
et -
U vy
-~ ~J_._\_|_|_1
r

Night hall

E-fa Groups

(2]

+ 1G1: LP kitchen central on/off
+ _1G2: Master-off kitchen

= 1G3: LP staircase on

=+ 1G4: LP staircase switching

BP I,-I-. |:

el
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Diagram

The diagram shown below will be used.

T T T T TRUrRET I | -
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T

O 0000® 20 ®

Notice that the contacts 6 and 6’ of the two-way contact are connected to the 230V inputs B and A respectively of
the switch module. The staircase lighting is connected with a dimmer, which, in turn, is connected with the first
output of a dim controller. For your example, make use of switch module S1 and dim controller D1.
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[M07 (Delayed off) B
Dielay tirme

o 1

Dirmring speed

A |

Elﬁ Distribution panel garage
- =-E2 51 Switch module
@ LOCA Local input A
Y LOCE: Local input B

=4
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Programming

Open the screen Create connections and select output 0O01: LP staircase of dim controller D1. As function,
choose M07 (Delayed-off). The delay time will be set to 5 minutes, and the dim speed to 2 minutes.

Connect these settings with IG3: LP staircase on.

E-fa} Groups
- =] IG1: LP kitchen central anfoff

----- 5] 1G2: Master-off kitchen

Then select output 006 of switch module S81. Here, choose the connection mode M06 (Delayed-off) with a time of 7
minutes. This normally represents the total time that the light point of the staircase is in operation. Also connect this
programming to IG3: LP staircase on.

If output 6 is high, the 230V input B is high. Select output O12: LED staircase of switch module S1. Then select
connection mode M8 (Blinking) and connect this programming to LOCB: Local input B of the same switch module.

Program the same output O12: LED staircase, with M02 (On, with operating time) for LOCA: Local input A of
S1. As a result, the LED will switch on as soon as the light point is off.

You still have to program the lower part of the push button. When the lower part of the push button is pressed, you
want the staircase lighting to remain on. The LED must then be off. This function is handy when you need light on
the staircase for a longer period (for example, when cleaning).

Select output O01: LP staircase of dim controller D1. Then select function M05 (On) and assign this programming
to IG4: LP staircase switching.

Now select output O12: LED staircase of switch module 81. As connection mode, select M03 (Off) and assign the
programming to 1G4: LP staircase switching.

You will now find the programming for input group LP staircase switching in the connection list.
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—— Connection list 1G4: LP staircase switching
Input Description | Cutput Description Connection Mode | T1 T2 ABC.. | Filter condition
| 1G4: LP stair...  012: LED Staircase (S1: 5., W03 (Off, with ... D's

[=] I1G4: LP stair... | O01: LP stalrcase [D1. D|m... MOS (On (ifne.. | 0s 1s | None

This example is also described in the Nikobus Manual under Nikobus-example 4.
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6. THE SEQUENCER

@ nikobus - [Nikobus project 3.nkb]

@ File | Ecit Program Yiew Window Help

b=

G
=t

@ Sequencer

[®] Project info

== Creste input group

=— Light scene / Central functions
Mew connection

= Logical function
27 Fiter

Clock function

(% Pressnce simulation

Eze s

— =

o v |

fay &dd location

fay, Modify location name

{ny Delete location

E5 Add module

E=] Change madule name

E=3 Delete module
Madify output nstme

New connection

MGty conmeEten

T Dl Canieetan

Selected srquencer

Step | Cutput

wada [ Dalay

| Description \

The sequencer is available as a function (or mode) on the switch module of the Nikobus home automation system.
In order to program this special function within the Nikobus software, separate screens have been developed. The
working methodology is explained below.

Starting the sequencer

Open the Nikobus software and start a new project, in which you will enter a switch module. This example can be
found on the CD-ROM under the name Nikobus-project 3.nkb in the Examples directory. You can practice your
own programming using the Nikobus-project 3 empty.nkb file (without programming).

The programming of the sequencer can be started in two ways.

a. First option
Open the Edit menu and click Sequencer. In order to be able to create a sequencer, the project must at least
contain 1 switch module.

The Sequencer screen will now be opened.

odue Selected sequencer
Step | Cutput wada [ Dalay |
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Please enter the pame of the new Sequencer.

| Garden sprinkling|

o]

LCancel

b. Second option

nNiko
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If the Function toolbar is not visible, open the View menu and tick Function bar. The Function toolbar can be

found next to the Standard toolbar.

Bl === &7 b =0y 5] O

Click the icon F& in order to open the sequencer.
The Sequencer screen will be opened.

Creating and naming a new sequencer

Click the field New sequencer in the Sequencer window.

Mew sequencer

In the newly opened window New sequencer, enter a name for the sequencer. For this example, use the name

Garden sprinkling. Exit this screen by clicking the OK button.
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| The sequencer window
In the Sequencer window, you will find the following under Selected sequencer:
oelected sequencer
SEQD1: Garden sprinkling j
=-fa} Distribution panel garage In this example, we will assume that your project involves a switch module, the first three outputs of which are linked
2-Ef 21 Switch madule to three sprinkling installations for a large garden. Due to a limitation of the water supply, the three sprinkling

installations should not be in operation at the same time. With the sequencer, you will switch the three groups on
and off consecutively. Certain areas of the garden are more humid than other areas. The sprinkling time will be
reduced for these more humid areas.

Mew sequencer I
Module Selected sequencer
[S1: Switch module |SEQD‘I Garden sprinkling j Delete sequencer |

Modify sequencer name

Step | Output [ Mode | Delay

Add output

QK

55



tdodule

Add output

Clutput

001: Sprinkling group 1

002: Sprinkling group 2
'DDS' Sprinkling group 3 3

P
1)
1)

Q03: Sprinkling grougp 3
004: Switch output
205 Switch output
206 Switch outpot
007 Switch output
208; Switch output
09 Switch output
010: Switch output
0171: Switch output
12 Switch output

g Mowe up

Add output

Delete output

¥ Move down
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In the Sequencer window, choose S1: Switch module as Module (upper left of the screen), as the outputs you
wish to use for the sequencer are part of this module.

Click the Add output button. As a result, a program line will be added in the info window of the Sequencer screen.
At the moment, we are not worried about its content. As you wish to add three outputs of switch module S1, click the
button Add output twice again.

The info window now contains three program lines.

Step | Output hode Delay
1 001: Sprinkling group 1 M13 (Sequencer on ! offi 10 s
2 002: Sprinkling group 2 M13 iSequencer on / of 10 s
i 003: Sprinkling group 3 M13 (Sequencer on / off]

Observe that the correct outputs have been selected under the Output column. This is, however, pure luck, because
you connected the first three outputs of the switch module to the three sprinkling groups. You are able to select any
desired switch module output by clicking a row in the Output column.

You still have to set the time for each output. To do this, click in the Delay column in each output row and select the
time for which the respective output should be active.

Delay

120m

The sequencer you created will function according to the sequence of the rows. If a certain output must be activated
first, it must be placed in the first row. You can adapt the order of the rows by using the buttons Move up or Move
down.
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Exit this screen by clicking the OK button.

In the Project overview window, the created sequencer will be added to $1: Switch module. Obviously, this will
only be visible when the OUT toolbar button has been activated.

————— PFrsject i —_— ¥

Gl | (o} [ S[ S our |

=-{a} Distribution panel garage
E-EF S1: Switch module

=5~ 001: Sprinkling group 1
=5~ 002: Sprinkling group 2
=5 003: Sprinkling group 3
-Z§ 004 Switch output

2§~ 005 Switch output

2§ O0B: Switch output

2§ 007 Switch output

2§~ O08: Switch output

2§ 009 Switch output

2§ 010: Switch output

-ZF O11: Switch autput

-2f 012: Switch autput

-4 SEQD1: Garden sprinkling

b,

| Assigning the sequencer to a push button

In order for the sequencer to function, it must be assigned to a push button. To do so, click the New connection
button in the basic screen. The Create connections window will be opened as a result. In this window, select
Output SEQ01: Garden sprinkling.

] .
Mew connection

|—;|...|:| BEP1: Bus pushbutton, 4 operation paoints Under Connection mode, you are only able to click M13 (Activate sequencer). You will select the desired bus
P BEE ~E: Input push button subsequently in the Input window. Close the programming by clicking the Add connection button and
E3 CD: Input then the Close button.
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7. WORKING WITH PORTS AND FILTERS
7.1. Working with ports

| Description

When a PC-Logic module (05-201) is included in the installation, you will have powerful logic functions available.
You will work through a simple example below. This example is included on the CD-ROM as Nikobus-project 4.nkb
under the Examples directory. With the Nikobus-project 4 empty.nkb file (without programming), you can start
practicing by yourself.

A simple sunblind control

Assume a sunblind has been installed on the terrace of the house. You want to control this sunblind automatically. If
there is too much sunlight on the terrace, the sunblind must slide open. In case of little sunlight, it must be up. If the
shutter is opened, and a strong wind comes up, it must automatically close again. If the shutter is up, and there is
too much wind, and at the same time there is also too much sunlight, it must stay up, because the wind could
damage the sunblind.

We will create a small project in which we include a shutter module and a PC-Logic module. When you click on the

=-{a} Distribution board OUT and IN buttons in the Project overview window, the following will resuilt.

El@ F1: Shutter module

----- = 001: Sunhblind =-fa; Distribution board
..... B ooz 3 nonent
..... B 003
----- B 004 You will also see that the sunblind is connected with the first output on the shutter module. The anemometer will be
..... & o005 connected with input LM01: Logic input 1 of the PC-Logic module. You will connect the sun sensor with the LM02:
,,,,, = oo Logic input 2 of the PC-Logic.
Creating two logic functions
a. Little sunlight and little wind
= Logical function Open the Logic functions screen by clicking the command Logic function in the Edit menu.
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Via the Guide screen, click on Create new. Enter a name for the logic function you wish to create. As you wish to
create a logic function for which the output is high when there is little sunlight and wind, name it Light low / wind
low.
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Please enter the name of the new Logical function:

ILight lowe / wind |ow]

Cancel
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After clicking the OK button, you will enter the Logic functions screen. You will see the name of your first logic
function already displayed in the Logic function selection window.

Logical functions

Logical module

Logical fenction

|_DM1 Master PC-Logic componant

5 o
=B LOM1 Master PC-Logic compone
B LMO1: Local input 1
B LMIA Local input 1
4 LMO1B: Local input 1
B LMO2: Local input 2
4B LMI2A: Local input 2
& LMO2B: Local input 2
4B LMO3: Local input 3
B LMO3A Local input 3
4 LMOI3E: Local input 3
B LMO4: Local input 4
4B LMO4A: Local input 4
B LMO4B: Local input 4
B LMOS: Local input 5
& LMO5A: Local input §
& LMISE: Local input 5
4 LMOE: Local input &
W LMOBA: Local input B
4 LMOEB. Local input 6

j ILD] Light levw £ wind low

Mew Logical function

Delete Logical function

Maodify name logical function

_I_I | J Simulation
= | T

_I_I | J Function nanme:
=3 [ 7 [0 Cight Tow 7 van
=1 " = ins k

= =] | B I

i —

- | 11—

- 3

In the left split window, you will see an overview of all the inputs of the installation. The logic inputs of the PC-Logic

module are included.

In this list, select LM01: Logic input 1. By clicking the first arrow key (with the arrows pointing to the right), enter this
input into the logic grid. In the selection field, click the option Off / on, as you want to create a function when the

wind is low.

q:.;:l ;;,l ILMEH: Local input 1 (LOM1T: Mas
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In the same way, enter the input LM02: Logic input 2 into the second line of the logic grid. Here also, select Off /

on. This will result in the following picture.

j_

ILMEH: Local input 1 (LOMT: Mas ICIFH on

ILMEIE: Local input 2 (LOMT: Mag IOﬁI an j—l__
| | =
| | ]—

| | 1—

| | I
| | ]—

Simulation

,_

Function narne:
ILEI1: Light o / wir

,_:_

Do not change anything on the AND functions, which are standard for the screen. In order to check whether your
function works as it should, carry out a simulation. To do this, click on the Simulation button.

In the screen below, you will see that the output of your logic function L01: Light low / wind low will be high when
there is no wind (LMO1 low) and there is too little sunlight (LMO2 low).
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By clicking the squares to the left of the inputs, you can see what your output will do. The different options are listed
below.

L]

n i, [

N

=S

62



Mew Logical function

ILMD1: Local input 1 (LOK1T: Master PC-Logic com IOfH on

|:| [LD2: Local input 2 (LOM1: Master PC-Logic com  [Off/ on

r
- L.
Ao
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The output of the logic function remains low as long as one or both inputs are high (green square). On the other
hand, your output will be high when both inputs are low. Exit the Simulation screen by clicking the OK button.

b. Sunlight high and wind low

If there is little wind, but a lot of sunlight, you want the sunblind to slide open. In the Logic functions screen, create
a new logic function by clicking the New logic function button in the right upper corner of the screen. Enter the
name Light high / wind low in the New logic function screen.

Hew Logical function

Please enter the name of the new Logical function:

ILight high # wind low

oK

Cancel

7] %]

Exit this screen by clicking OK, and you will see that your new function has already been selected in the Logic
function selection window in the Logic functions screen. Place the same inputs (LMO1 and LMO02) in the logic grid.
For LMO01, again select the Off / On function. For LM02 (the sun sensor) you will now, however, select the On / off
position. Once again, leave the two AND functions as they are. The logic grid will now look as follows:

ILMD1: Local input 1 (LOM?1: Mas IOﬁf on
ILNID2: Local input 2 (LOM1: Mas (el TR

Simulation |

Function name:
LO2: nght high / wir

]
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If you go to the Simulation screen, you can view the different options.

D [[M01: Local input T (LOMT: Master PC-Logic com  [Off/ on J—I_
—1—

LhD2Z: Local input 2 (LOM?1: haster PC-Logic com IOn { off j . | Low

[LMOT: Local input 1 (LOM1: Master PC-Logic com  [Off/ an j—|_
— L

D [M02: Local input 2 (LOM1: Master PC-Logic com  [On / of B 5 | Low
e
| | [ .
D [LMOT: Local input 1 (LOMI: Master PC-Lagic com  [Of / an j—l_
— L]

m LM02Z: Local input 2 (LOKT: Master PC-Lagic com IOn { off j . | High
[LMDT: Local input T (LOM1: Master PC-Logic com  [Off/ on j—|_
LMO2: Local input 2 (LOM1: Master PC-Logic com IOn / off j_l_ | Loy

You will find that the output of our logic function L02: Light high / wind low will only be high when the wind (LM01)
is low and the sunlight (LM02) is high at the same moment. Exit the Simulation screen and also the Logic
functions screen. You will see the two newly created logic functions In the Project overview window.
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=-[B] LOMI: Master FPC-Logic component
LO1A: Light low £ wind low
LOTE: Light low /wind low
LOZA: Light high / wind [ow
LOZB: Light high / wind low

-

LMO1A:
LWO1E:
LWAD2A:
LWO2E:
LhO3A:
LhO3E:
LhA04 A,
Lh048:
Lh05A;
LhOSE:
LhA0BA:
LWOGE:

Local input 1
Local input 1
Local input 2
Local input 2
Local input 3
Local input 3
Local input 4
Local input 4
Local input &
Local input 5
Local input B
Local input B

=-E F1: Shutter module

LOCA: Local input A

----- B LOCE: Local input B
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Creating connections with the logic functions

You are now ready to connect the created logic functions to the output for the sunblind. Open the Create
connections screen. In the left split window Output, select 001: Sunblind under shutter module. Then select
connection mode M03 (Close). Enter a run time of, for example, 20 seconds. In the right split window Input, select
LO1A: Light low / wind low, and confirm the programming by clicking the Add connection button.

Your objective for this programming is quite simple. If the sunblind is opened, and this only when there is little wind,
and the sun light then disappears (e.g. when it becomes evening), it will be closed automatically.

Also make a connection to our second logic function. To do this, select output 001: Sunblind again. Now, however,
select M02 (Open) as the connection mode. Here also, enter a run time of 20 seconds. As input, select L0O2A: Light
high / wind low, and confirm with the Add connection button.

If more and more sunlight appears, and only in cases of low wind, the sunblind will be opened.

You still need a solution for a situation in which the sunblind is open, and a strong wind is rising. In order to protect
the sunblind, it must slide up. You must therefore select the sunblind output again and M03 (Close) as connection
mode. Here also, set the run time for 20 seconds. This time, however, select input LM01A: Logic input 1. Add this
connection.

When the sunblind is rolled out, and wind rises, the logic input 1 of the PC-Logic module will be high. As a result,
the sliding-up of the sunblind will be activated.

If you now select the PC-Logic module in the Project overview screen, you will see the following display on the
Connection list screen.
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Input Descri Clutput Description Connection Mode Filter condition
[ LO1A: Light | 01: Sunblind (R1: Shutter ... (Close)
D= LO2A: Light ... OD1. Sunblind (B1: Shutter ... | MOZ [Open) 20s None
4 LWO01A: Loc... | 001: Sunblind (R1: Shutter ... | MO3 (Close) 20s None
4 LM0T: Local... | LO1: Light low § wind low Off £ an
4 LM02: Local... | LO1: Light low § wind low Off £ an
4 LW01: Local... | LOZ: Light high / wind low Off £ an
i LW0Z: Local... | LD2: Light high { wind low On / off

The first four lines add the logic inputs LM01 and LMO02 to the two logic functions that you have created. In lines five

and six, you will see programming for the logic functions at the moment that these become high. The last line
indicates that when logic input LM01A becomes high, the sunblind will be closed.

We will conclude the development of this simple example at this point. The PC-Logic module obviously offers many

more possibilities. Find out more in the Reference section, and, in particular, in section 15.9. Screen Logic
functions.
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7.2. Working with filters

| Description \

You are already familiar with filters from working with the local 230V inputs A and B of the output modules. With
these, it is possible to either carry out or not carry out a bus push button function, depending on the position of the
230V input.

In the basic Nikobus manual, the example of the Shift key is described (Nikobus-example 1). Here, you will design
such a Shift key in the software. To do this, you will create a new project in which you include a switch module, a
PC-Logic as master, a Bus push button with two operating buttons and LED and a Bus push button with four
operating buttons. This example is included on the CD-ROM under file Nikobus-project 5.nkb. If you wish to
practice by yourself, use the file Nikobus-project 5 empty.nkb. Both files can be found in the Examples directory.

Rename the bus push button BP1 as BP1: Shift key. For BP2, select the name BP2: Interior and exterior
lighting. Using the four buttons of BP2, you want to operate the first four outputs of the switch module by means of
the impulse function MO0S5 if the Shift key is not on. If the Shift key is in the “on” position, the four buttons of BP2 will

E-fai Distribution panel Eﬁ Distribution panel
N 1 Switch module o LOM1: Master PC-Logic compone
...... &4 Living room Eﬁ Living room
~-[Z] BP1: Push button, 2 operation points + LED

------ 5 BPZ: Bus pushbutton, 4 operation paoints

then operate outputs 7 to 10 with the impulse function. The first four outputs of the switch module are, for example,
lighting points in the lounge. The outputs 7 to 10 are connected to 4 light fittings in the garden.
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Creating the shift key

In the Project overview window, select our BP1: Shift key. Click the New connection button through which the
screen Create connections will be opened. On the left side, select 012: Switch output of the switch module, as
you wish to use LED output 12 for switching the LED of the Shift key. When pressing the upper part of the Shift key,
the LED should be on. Pressing the lower part will switch the LED off. This is all the Shift key must do.

As Connection mode, select M01 (On / off).

Connection mode

M1 (On / off K

Then select the AB: Input of BP1: Shift key in the split window Input.

=-fa} Distribution panel

: LOMT: Master PC-Logic component

- BB S1: Switch module

Elﬁ Living room
=-2] BP1: Shift key

AB: Input

#-[] BP2: Interior and exterior lighting

Add the connection by clicking the relative button. With this, the Shift key has been programmed.
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Setting a filter function for BP2

Before programming BP2, you must add a filter function. To do this, click on the Filter function icon. This icon can
be found on the bottom left of the Create connections screen. The screen Filter will be opened.

Click in the first row in the column Input to be filtered and, from there, select ABCD: Input (BP2: Interior and
exterior lighting — Lounge), as this is the bus push button for which you want to make the function to be performed
dependent on the position of the Shift key. Then select the push button that will be used as Shift key in the same
row in the Filter conditions column. You thereby select AB: Input (BP1: Shift key - Lounge). This will result in the
following screen.

Exit this screen by clicking OK.

e |
Define Filters:
Number  input to be filtered | Filtre condition =

ABCD: Input (BPZ: Interior and exterior lighting - Living room| AB: Input (BP1: Shift key - Living room}

BRI s e il ool kop

QK I Delete row
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Programming bus push button BP2

In the Create connections screen, select the first output of the switch module. Then select connection mode M05
and the A: Input of BP2. In the Filter condition field, select False. You want to carry out the programmed function
for the upper left side of this bus push button only when the Shift key is in the off-position. Finally, add this
connection by clicking the button Add connection.

The same procedure is repeated for the outputs 2, 3 and 4 of the switch module. They will be linked to the inputs B,
C and D of BP2, respectively. The Filter condition is placed on False for all these cases.

You will then separately program the outputs 7 to 10 of the switch module with connection mode MO05 for the inputs
A, B, C and D of BP2. For all these cases, the Filter condition is, however, now set to True.

When all the programming for BP2 has been finished, exit the Create connections screen by clicking the Close
button. When you now select bus push button BP2 in Project overview, you will see the connection list pictured
below.

Input Descri [ Connection hade | T1 Filter conditian
A Input o01: Switch output (31 5w, WMOS {Impulse)

] B: Input 002 Switch output (31: Sw... | MO5 (Impulse) None | False

£F C: Input 003 Switch output [31: Sw... | MOS5 {Impulse) None | False

[ D Input 004: Switch output [31: Sw... | MOS5 {Impulse) None | False

F A Input 007 Switch output [31: Sw... | MOS (Impulse) None | True

] B: Input 008; Switch output (51 Sw... | MDA (Impulse) None | True

[F] C: Input 009 Switch output (51 Sw... | MDA (Impulse) None | True

[d D: Input O10; Switch output (31 Swe.. | MOA (Impulse) None | True

i ABCD: Input FO1: Filter condition (LOM1:... | input to be filte...

In the first four lines, you will see that inputs A, B, C and D of the bus push button operate outputs 1, 2, 3 and 4 with
the impulse function if the filter condition is false.

The next four lines show that the same inputs operate the outputs 7, 8, 9 and 10 with the impulse function if the filter
function is true.

Finally, you can see on the last line that the inputs A, B, C and D of the bus push button have a filter condition.

This is as far as we wish to go with the development of this simple example. There are obviously many more
possibilities with the PC-Logic module.
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8. WORKING WITH CLOCKS

8.1. Using clocks

| Description \
ol el el e ';-. When a Link module (05-200) is included and connected in a Nikobus installation, time control can be carried out.
-~ CIC B d This means that controls (the switching on or switching off of a alliance or a group of alliances) can be carried out
- N \\\\\\\\\\\\\\\\ automatically at pre-determined moments in time.
LRLEE N
““““‘::LH»‘ i As an application possibility, you could, for example, consider switching on the wall socket of the coffee maker, so
i i 2 CE that the coffee is ready when you get up in the morning. But it is also possible to switch on heavy alliances. In this
WD&-R{IU way, you could take advantage of the less expensive night tariffs for, e.g., the washing machine, tumbler,
dishwasher and the hot water boiler. This could represent quite a saving on your energy bill.

- |.\‘; /f -ﬁ;;_/;" '\X Clocks can also be introduced as user-friendly and energy-saving devices for heating control. Heating blocks can be
N - 3 created for each day. It is even possible for these blocks to have a different setting every day, depending on the
w requirements of the family members. The heating control on a working day will look different from the heating control

® T on a weekend day. The clock program of the Link module offers extensive possibilities.

General methodology

Time channels and time blocks are created in separate screens. Several time blocks can be programmed in each
channel, if this is required. A total of 100 time channels and over 500 time blocks are available. After programming
the time blocks and channels, a new connection can be made between each channel and one or several alliances.
The mode can thereby be freely selected. If required, conditions can be added by means of the A and/or B 230V
inputs of an output module.

Opening the clock function screen

Clock function Open the Clock function screen by clicking the Clock function command in the Edit menu. A PC-Link module
must obviously be included in the project to achieve this. The screen shown below will be opened.
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Clock function ﬂ

FC-module Channel Modify channel name |

CALT: PC-Link module [cHOD1: Channel 7

Delete channel |

Weekday Weekend day Simulation Caontinuous I Exception

I anth Year | I? j IAugust j |2DI33 :I

| 1l2falalslef7]elsf10lra]13]14]15]16]17]16]19]20]21]22] 23] 24| 25] 28] 27] 26] 29| 0] 31| 2
CHOO1
CHOOZ
CHOO3
CcHO04
CHO0S
CHOOE
cHoo7
CHO0S
CHO0S
cHO10
CHO11
CHO1Z
cHO13
cHO14
CHO15
CHO16

Day | Weak

Mew tirme block Delete tirme block: il ity tirme: blaek: oK

We will work with an example below. The Nikobus-project 6.nkb file is included in the Nikobus CD-ROM. If you
prefer to practice by yourself, you may use the file Nikobus-project 6 empty.nkb. Both files can be found in the
Examples directory.
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Modify channel name:

CHOOT
CHOOZ

CHOOS

CHOO4

|Eia1h|00n. heating night working day

o]

Cancel
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| Creating a new clock channel for the bathroom heating

In this screen, it is possible to create up to 100 clock channels or clock lines. Every line or channel can contain
several time blocks. Select an empty channel by clicking, in this case for example, the CH001 button, on the left of

the screen.

With this clock channel, you would like to set the bathroom heating on working days between comfort temperature
and night temperature. You will operate a thermostat’s pilot contact with an output contact of a switch module. When
the pilot contact is closed, the set comfort temperature on the thermostat will be decreased by 5 °C. The contact will

be closed if you wish to change to night position.

L—‘_IEE 53: Switch module

=& 001: LP bathroom central

25" 002: Ventilator bathroom

25~ 003: LP bathroom washhasin

2% 004: LP bathroom bath + shower
=& 005: LP bedroom parents wardrobe
2%~ 006: LP bedroom parents table
~-Z& 007: LP guest room central

--2% 008: LP guest room wardrohe

~Z& 009: LP guest room office

: Bathroom heating night
~Z& 011: Bedroom parents heating night
-Z% 012: Guest room heating night

You will find that output 010: Bathroom heating night of Switch module S3 has been foreseen for this function in

your project.

Click the button Modify channel name. By doing this, the screen opposite will be opened. Write the name for the

channel: "Bathroom heating night working day" here.
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| Creating a new time block

Within the newly created clock channel, you can now enter one or more time blocks. To do so, click the New time
block button at the bottom left of the screen. The Time block window will be opened.

As you wish to create a control for the working days, click on the coloured button with the caption Weekday. The
screen below will be displayed.

[tern info

Channel ICHDD1: Bathroom heating night Wurj Duration: I

Start Date: IThursday I? j IAugust j IQUU3 j Starts: |12:DD:DD j
End Date: [Thursday 7 =l]august ooz 4 Ends [120000 =

In this screen, the correct channel has already been selected. Furthermore, you will find that the current day has
been selected for the start date and the end date. You wish to start our night position for the bathroom at midnight.
You therefore set the start time to 00:00:00. The comfort temperature must start at 6:00 a.m. on working days. You
therefore set 06:00:00 as the end time.

Then tick Repetition use and click the Daily button. After this setting, click the OK button in order to return to our
Clock function screen.

As you will see, green squares have been placed on the first clock line starting with the current date and for all the
following working days. You will note that the program is aware of the working days, because you entered the
weekend days of the end user in the Project info window (see Edit/Project info menu).

Clicking the buttons Week, Day, Year or Month consecutively will give an idea of the time block on a weekly, daily,
annual or monthly basis. You will obtain the following screens respectively.

Day I Week Manth | Year | I 'l IAugust j IEDEIB :’
| | honday - 4 | Tuesday -5 | Yyednesday - B | Thursday - 7 | Friday - 8 | Saturday -3 | Sunday - 10 | ﬂ

Batt
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Day Week | fanth | ear | I 'l IAugust j IQDDS :I
o 1 2 I3 |4 |5 |6 Iz I8 Jo [mo 11 a2 13 J24 15 [16 |17 _J1a 19 Jzo0 [21 |22 |23 | il

Bathroom heating night working «

Day Week hMonth I ear I? j IAugust j IEDDS j
| | Jan. | Febh. | lar. | Apr. | EL | Junge | July | A | Sep. | Oct. | Moy, | Dec. |i|

Day | WWeek | I Month Yfear | I? 'I Augus

L 1 R e e R PSR

| Creating several time blocks in the same clock channel

On a working day, of course, the bathroom heating does not need to operate from 6:00 to 24:00. You must include a
few additional time blocks in the same clock channel. To do so, select channel CH001, and click the New time
block button. The Time block screen will open again. Now fill in 07:30:00 as the start time, and 18:00:00 as the end
time. Tick Repetition use again and click the Daily button. Exit the screen by clicking OK.

Back in the Clock function screen, perform the same procedure again with, for example, 22:30:00 as the start time.
The end time will be 23:59:55. On returning to the Clock function screen, your first line, in Day mode, will now
appear as follows.

Day Waek | tanth | Vear | Ii“.ﬂ\ugust j |2D|33 j
0 I 2 I3 Js Js s [7 Je 3 lio Jui 12 113 Jua |15 16 Ji7 l16 19 [20 [21 |22 Jos | 4

Bathroom heating night working ¢ Bathroom heating night working day Bathrog
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Connecting a alliance to the clock channel

You have now created a clock channel with three time blocks. Use this clock channel as follows:
During the times of the green bars, the thermostat will be switched to the night position. During the time frames in
which there is no control (white sections), the heating in the bathroom will be in the comfort position.

You now must make the connection between this clock channel and the output that will control the pilot contact of
the thermostat. To do so, exit the Clock function screen by clicking the OK button.

You can then activate the Create connections screen. In the split window Output, select output 010: Bathroom
heating night of Switch module S3.

As Connection mode, choose M01 (On / off). Do not set a condition. Within the split window Input, now select
CHO001: Bathr. heating night working day.

B- ﬁ Distribution panel garage
= I CALL: PG Link module

Now click the Add connection button and exit the screen by clicking the Close button. When selecting output 010
of S3 in the Project overview window, you will now find the programming for this output in the connection list. The
output will only be controlled by the newly created clock channel on working days.

—— Connection list 53: Switch module{6.3 % ) - 010: Bathroom heating night
Desc Input Des Connection kode | T1 T2 AB C.. | Filter condition

m heating n...  MOT (On / off)
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8.2. The presence simulation

| Description \

In order to preventatively combat theft, a reliable presence simulation is very important when the family members are
not at home. With the Presence simulation function, the Nikobus software, together with the Link module, is able to
provide extensive applications in this area.

You will work on a practical example below. This example can be found on the CD-ROM under the name Nikobus-
project 6.nkb. If you wish to practice by yourself, use the file Nikobus-project 6 empty.nkb (not programmed).
Both files can be found in the Examples directory.

Creating a presence simulation ‘

(T Presence simulstion To create a presence simulation, click the Presence simulation command in the Edit menu, or click the presence
simulation icon in the Function toolbar or in the Create connections screen. The screen below will be opened.
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Presence simulation

Starts

| Ends

| Output

| Caonnection mode
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W =

YWariation

INnne j

QOutput for feedback |

Add activities |

[Welete activity |

Tl ity S ctivity |

| Adding an action to the simulation

In a simulation, you will arrange for several actions to be carried out when the simulation is activated. To do this,
click the Add actions button. This results in the opening of the Select an output screen.

In the split window Outputs, select output 001: LP Staircase of dim controller D1. Set 23:18 as the start time, and
23:27 as the end time. Exit the screen by clicking the Add action button.
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Select output

Clutputs

{37 Distribution panel garage
=-E D1: Dimcontroller

----- (4 001: LP staircase

----- €2 00Z: LP dining table

----- £2 003: LP couches

----- i3 004 LP coffes table

----- e2 O05: LP television cabinet
----- (& 006: Standing lamp dining roam
----- £ 007: Standing lamp lounge
----- €2 008: Standing lamp office
..... @ Qng:

..... (23 010:

..... @ 011:

..... (23 012

#-BE R1: Shutter module

-BE 51: Switch module

R-E2 52 Switch module

E-fat Distribution panel attic

w23 D2 Dimcontraller

=B 53 Switch module

=-BE S4: Switch module

Clutput

IOEH: LP staircase

connection mode

[MO1T (Dim an / off (2 buttons)

Tirne (OniOpen)
- =
|23.E =

Time (OffClose)

|23:2? —

[

Add activity

Cancel
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Add a further action for the central light point of the bathroom and for the central light point of the parents’ bedroom.

Following this, exit the Select an output screen by clicking the Cancel button.

The result of these activities can be seen in the Presence simulation screen.
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EI fat Entrance hall
- .[Z] BP10: LP staircase
...... O BB

Simulation front door

Choose output ﬂ E

Select the output that will flash 5 times
if the simulation is activated.

Elﬁ Distribution panel yarage
=B D1: Dimcaontroller
2B 21: Switch module
-Z8~ 001: LP garage
2§ 00Z: LPkitchen central
25 003: LP kitchen cooking area
2§ (004: LP kitchen washing up
g 005 LP cloakroom
25 O0R:
2§ O07: LP entrance hall

25~ 008: LP office wall
g~ (009 Wentilator toilet
=& (010: LP toilet
W 011: LED Master-off
- 012 LED Staircase
B-B 52 Switch module
H-faj Distribution panel attic

(8] Cancel
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Starts Ends Clutput Connection mode
2318 X327 001 LF' staircase (01 Dirncontrolles MO1 (Dim on £ off (2 buttonsT)
2326 2343 2071 LP hathroom central (53 Switch m.. 01 (Cn f off)
e 2351 001: LP hedroom parents central (TG [0 01 (Dim on £ off (2 buttons)

| Selecting a feedback output and connecting a push button

When a presence simulation is activated, it is useful to be aware of this. Normally, you will use the special Feedback
bus push button to select particular clock schedules. Now, however, you would like to activate the simulation by
means of a two-way bus push button with LED. When the LED lights up, the simulation is active. You therefore place
a bus push button with two operating points and LED in the Entrance hall and rename it BP15: Simulation front
door.

In the Presence simulation screen, click the button Output for feedback. In the Select output screen, select
output 011: LED Master-off of switch module S1. Exit this screen by clicking the OK button. You also exit the
Presence simulation screen the same way.

In the Project overview window, select input BP15: Simulation front door and click the button New connection.
Here, you select SIM: Simulation as the output. The Connection mode is to be set for MSM (Activate presence
simulation). Among the inputs, select AB: Input of BP15 in the Entrance hall. This connection is then added by
clicking the relevant button, and you can exit the screen using the Close button.

= ﬁ Distribution panel garage
= I CAL1: PC-Link module
- MO1: YWeek mode
rOZ: Wieekend mode
MO3: Automatic mode
MEIfl Exceptmn mode

EI ﬁ Entrance hall
' l [E] BP10: LP staircase

= |:| BF15: Sirmulation front door

= AB: Input
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8.3. The different clock schedules

| Description \

Within the Nikobus software, clock channels can be assigned to clock schedules. You will distinguish between 5
clock schedules, with the following names: weekday, weekend day, simulation, continuous and exception.

YWeekday Weekend day Simulation Continuous Exception

In the Project info screen, you have already entered the weekend days for the end user.

\heekend days Monday I Tuesday
[ Wednesday [T Thursday
I~ Friday ¥ Saturday
W Sunday

For most people, the standard setting (Saturday and Sunday) will agree with their time schedule for work and leisure
time. The hairdresser at the corner of the street, however, works from Tuesdays up to and including Saturdays. For
him, the weekend days are therefore Sunday and Monday. For other people, it is possible that their leisure days are
on other days. The weekend days in above screen will be ticked depending on the living pattern of the user.

By means of this indication, the program will be aware of the normal weekend days and working days. Events that
must be carried out at a specific time will be dependent on whether it concerns a working day or a weekend day.

In section 8.1. Using clocks, you created a clock channel for the heating control of the bathroom on weekdays.
These time settings may of course be different for the weekend days. For that reason, you will create an additional
clock channel for the heating control of the bathroom that will be carried out on weekend days.

During the times that you are away from home, it does not make sense to carry out clock channels for the heating
control. It is not necessary to generate a comfort temperature when nobody is at home. When the presence
simulation is switched on, nobody is at home, and the clock schedules Weekday, Weekend day or Exception must
then be switched off. When you are at home again, the simulation must be switched off and the correct clock
channels must be carried out (weekend or weekday), depending on whether or not it is weekend.
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Weekday

Weekend day

Only one of these four clock schedules
can be activated at the same time.

Exception

The continuous clock schedule is always
activated and can't be deactivated.

Continuous

In addition, you will distinguish the Continuous clock schedule. This is always active and cannot be placed in the
“off” position. Time blocks in clock channels that are part of this schedule are always carried out. For time blocks and
clock channels that are part of the Exception schedule, however, the user is able to put them in the active or non-
active position (by means of a bus push button).
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The Nikobus regime bus push button

Niko has developed a special feedback bus push button in order to allow the user to set and select schedules in an
easy manner. This bus push button is designed with four push buttons and four LEDs.

When pressing on the upper left, the weekday schedule will be selected. All clock lines that have been programmed
under Weekday in the software will be carried out. The weekend, exception and simulation schedules are switched
off. The relevant LED will light up.

When pressing on the lower left, the weekend day schedule will be switched on. The weekday, exception and
simulation schedules are switched off. All clock lines that have been programmed under Weekend day in the
software will be carried out. The relevant LED will light up.

Pressing on the upper right will switch on the exception schedule. The weekday, weekend day and simulation
schedules are switched off. All clock lines that have been programmed under the button Exception in the software
will be carried out. The relevant LED will light up when the schedule is active.

By pressing on the lower right of the feedback bus push button, the simulation schedule can be activated. The
weekday, weekend day and exception schedules are switched off. The relevant LED will light up.

If the LEDs for the weekday, weekend day, exception or simulation schedule do not light up, the installation is in
automatic mode. This means that the PC-Link module will carry out those clock channels that correspond with the
type of day it is. If it is a weekend day, the weekend schedule will be active. If it is a weekday, the weekday schedule
will be active.
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9. COMPACT MODULES
9.1. The compact switching unit

....... This chapter is a continuation of the options that were described in relation to the standard switch module with 12
output contacts. Please familiarise yourself with the chapter on the switch module first (chapter 4.1. of the Nikobus

.................. basic manual), as well as with the general approach to working with the Nikobus software (from chapter 3 of the
ce T above-mentioned manual) if you are not familiar with the Nikobus home automation system, the Nikobus switch
. / / / /:[., K module or the Nikobus software.

— _"_!__m.wf'm Hardware

The compact switching unit has 4 outputs (230V/10A). It is possible to protect each output separately if need be. In
addition, a 230V power supply is required for the operation of the unit. Finally, there is a Nikobus connection, for
which the polarity (B1 and B2) must be respected when other components are connected to the bus.

The compact switching unit does not have the outputs necessary to control LED’s. In addition, it does not have 230V
inputs A and B either. As a result, there is no SET button, unlike the standard switch module.

Each output still has its own LED, which indicates whether the output is “on” or “off”. LED indications are no longer
used for the different modes, however. These are now indicated digitally.

About Nikobus...

|
Nikabus Version 2.00 | 3

1 Database version 16,006

The memory

The compact switching unit uses the same memory as its larger brother. In practice, this means that with the
compact switching unit, in comparison to the standard switch module, it is possible to program three times as much
per output before the memory is full. On the other hand, it is not possible to replace the EEPROM here, as is
tch module possible for the standard switch module.

05- 02 : Shutter module
05-002-02 : Compact switching uni|
05-007-02 : Dimcontrolier

Programming with the Nikobus software

i It is also possible to program the compact switching unit with the Nikobus software. Please ensure that you are
P T T working with Nikobus version 2.00 or later. You can check the version of your Nikobus software by clicking About
e, Nikobus... in the Help menu.
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Place a compact switching unit in the fuse box by selecting Distribution panel 1 and pressing the OUT button.
Following this, press the Add module button. This will open the product list.

From this list, select 05-002-02 Compact switching unit and double-click this selection.

The new module will be added to the fuse box in the software.

o Distribution panel 1

-|-E i 51: Compact switching unit
%’.
i;:
-

-

=

The outputs can be re-named by clicking on them with the right mouse button and then selecting the item Modify
output name.

If bus push buttons have already been added to the project, click the New connection button. As a result, the
Connection editor screen will be opened.
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Connection mode

W01 (Cn / off)
W02 {On, with operating time})

W03 (Off, with operation time)

04 (Pushbutton)

W05 (Impulze)

WM0§ (Delayed off (long up to 2h))
MO7 (Delayed on (long up to 2h})
W08 (Flazhing)

W11 (Delayed off (zhert up to S0sec.
W12 (Delayed onn (ghort up to S0=ec
W14 (Light scene on)

W15 (Light scene on / off)

21X

Output LConnection mode Input
=-fay Distribution panel 1 | j No available inputs
BB 51 i
- Parameter 1
T Switch output I j
003 Switch output
004: Switch output Parameter 2
| [Z
AB Condition
| B
Fiter condition
| [4
ki | [T Display only unused inputs
>|<|a|o|=|ml o] & BRI~ -
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Select the output of the compact switching unit that is to be programmed. Then, select the function that is to be

carried out in the Connection mode field. In this field, the one-key modes are indicated in black and the two-key
modes in blue.

Input Finally select the bus push button that will carry out the function in the split window Input. End the programming by
= £ Location_1 clicking the Add connection button. Continue with a new program, or leave the screen by clicking the Exit button.
= |:| BP1: El_ua pushbutton, 4 operation points . . . . . .
EE All functions and options of the compact switching unit correspond to those of the standard switch module.

ok
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9.2. The compact dim controller

This chapter is a continuation of the options that were described in relation to the standard dim controller with 12
outputs. Please familiarise yourself first with the chapter on the dim controller (Chapter 4.3. of the Nikobus basic
manual), as well as with the general approach to working with the Nikobus software (from chapter 3 in the above-
mentioned manual) if you are not familiar with the Nikobus home automation system, the Nikobus dim controller or
the Nikobus software.

Hardware

_______ The compact dim controller has 4 outputs (0-10V controls). A 230V power supply is required for the operation of the
29 %2090 9299 module. Finally, there is a Nikobus connection, for which the polarity (B1 and B2) must be respected when other
EEREEEEEREEREERE components are connected to the bus.

The compact dim controller does not have 230V inputs A and B. As a result, there is no SET button, unlike the
standard dim controller.

Every output still has its own LED, which indicates whether the output is “on” or “off’. LED indications are no longer
used for the different modes, however. These are now indicated digitally.

I FEEEEEREREEREEERF

The memory

The compact dim controller uses the same memory as its larger brother. In practice, this means that, with the
compact dim controller, it is possible to program three times as much per output before the memory is full, compared
to the standard dim controller. On the other hand, it is not possible to replace the EEPROM here, unlike the standard
dim controller.
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Two new functions

03-000-02 :
05-001-02 :
05-002-02:
05-007-02 :

Swritch module

Shutter module
Compact switching unit
Dimcontroller

{08 n0g 02"

Compact dimcontroller

05-201 : SMS interface
05-205 : Audio link

Compact dimcontroller

Advice

All functions or modes of the compact dim controller are exactly the same as those of its larger brother. The compact
dim controller, however, has two additional functions or modes available (M13 and M14).

a. Mode M13 Dim on/off (1-key)

Mode M13 is a one-key function. Briefly pressing the bus push button will switch the connected lamp “on” to the D-
max value. Briefly pressing the bus push button again will switch the consumer to the “off’ position (0%). If the
dimmer is switched “on”, pressing the bus push button for a longer time (longer than 0.3 sec.) will increase or
decrease the dimming, depending on the previous dim direction. The dim direction is reversed each time the bus
push button is pressed for a longer time. Full dimming upwards or downwards takes place at a dim speed of 4 s. A
specific particular curve can be selected for switching the dimmer “on” or “off” (pressing the bus push button briefly)
by means of setting wheel T1. The time for dimming upwards and/or dimming downwards can be adjusted using
setting wheel T2. This is fully comparably to, for example, mode M1 of the dim controller.

b. Mode M14 Dim on/of memory (1-key)

Mode M14 is very similar to mode M13. In the case of mode M14, however, the dimmer will not be switched to the
D-max value when it is switched “on”, but to the value the dimmer was on the last time it was switched “off”. In other
words, this mode operates with a memory function.

M14 is also a one-key function. Briefly pressing the bus push button will switch the connected lamp “on” at its
memorized value (the value the dimmer was at when switched “off” the previous time). Pressing the bus push button
briefly once again will place the consumer in the “off” position (0%). If the dimmer is switched “on”, pressing the bus
push button for a longer time (longer than 0.3 sec.) will increase or decrease the dimming, depending on the
previous dim direction. The dim direction is reversed each time the bus push button is pressed for a longer time. Full
dimming upwards or downwards takes place at a dim speed of 4s. A specific curve can be selected for switching the
dimmer “on” or “off” of (pressing the bus push button briefly) by means of setting wheel T1. The time for dimming
upwards and/or dimming downwards can be adjusted by means of setting wheel T2. This is fully comparably to, for
example, mode M1 of the dim controller.

Programming with the Nikobus software

The compact dim controller can also be programmed by means of the Nikobus software. Ensure that you are
working with Nikobus version 2.00 or later. You can check which Nikobus software version you have by clicking
About Nikobus... in the Help menu.

Place a compact dim controller in the fuse box by selecting Fuse box and pressing the OUT button. Then press
the Add module button. The product list will now be opened.
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Select 05-008-02 Compact dim controller in this list and double-click this selection.

The new module will be added to the fuse box in the software.

{0t Distribution board
--E. iD1: Compact dimcontroller |
(2
2
2
2

The outputs can be renamed by clicking them with the right mouse button, and then selecting the item Modify
output name.

If bus push buttons have already been added to the project, click the New connection button. The Connection
editor screen will then be opened.
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Connection editor 2%
Output LConnection mode Input

= ﬁ* Distribution board | j Mo available inputs
—-E32 [1: Compact dimcontroller
¢4 001: Dimmer output 0-10W Parameter 1
£ D02: Dimmer output 0-10W | J
€2 003: Dimmer output 0-10W
2

0O04: Dimmer output 0-10V Parameter 2

| -

AB Condition

| H |

Fitter condition

| i1

Connection mode |

I~ Display only unuzed inputs
BEER _ =

Select the output of the compact dim controller that is to be programmed. Then select the function that is to be
carried out in the Connection mode field. In this field, the one-key modes are indicated in black, the two-key modes
are in blue, and the four-key modes are in violet.

= = Hl= miE el &

MO (Dim on / off (2 buttonz})

02 (Dim on / off (2 buttonz})

03 (Light cene onfoff)

MO4 (Light scene on)

MOS (On (if necessary with operating
MOS (Off (eventualty with operating ti
MOT (Delayed off)

M0& (Flazhing}

11 (Preset onfoff)

M12 (Pre=et on)

W13 (Dim onfoff (1key))

14 (Dim onfoff memory (1key))
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Finally, select the bus push button that should carry out this function in the Input split window. Finish the
programming by clicking the Add connection button. Continue with a new program, or leave the screen by clicking
the Exit button.

All functions and options of the compact dim controller correspond to those of the standard dim controller. The
compact dim controller has two additional one-key functions (M13 and M14) available.
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05-000-02 : Switch module
05-001-02 : Shutter module
5-002-02 : Compact switching unit
5-007-02 : Dimcontroller

5-008-02 : Compact dimcentroller
5-201 : SMS interface

Audio link

WAdvice
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10. The Audio Link

The Audio Link module (05-205) can either be used on a stand-alone basis or can be installed in a Nikobus
installation. With this module, functions on the Allegretto multi-room, multi-source audio system can be carried out, if
desired, from any bus push button, clock function or logic function.

Hardware

The Audio-Link (05/205) requires a 230V power supply for operation. In addition, it requires a B1 and B2 bus
connection. Polarity must be respected if other Nikobus components (e.g., output modules) are included in the
system.

Connections for 6 voltage-free contacts have been provided at the bottom of the module. Audio functions can also
be carried out using these contacts. Finally, there is an RJ connector, which is connected to the Allegretto A44 or
A88 audio system.

Programming with the Nikobus software

The easiest way of programming your Audio Link module is with the Nikobus software. Ensure that you are working
with Nikobus version 2.00 or later. You can check which Nikobus software version you have by clicking About
Nikobus... in the Help menu.

In your project, define a fuse box as a location, and select it by clicking it with the left mouse button. Ensure that the
OUT button of the Project overview window is pressed in. Click the New module icon. The Product list screen will
be opened. In this list, double-click 05-205: Audio link. The Audio Link will then be added to the Distribution panel
1 location.

Next, add two locations to your project: Location 1 and Location 2. Ensure that the IN button has been activated.
Select Location 1 and click the New module icon. You will now find all the input components of the Nikobus home
automation system in the product list. Find and double-click component 05-064: 4-key Audio Panel. Then double-
click 05-064: Bus push button, 4 operation points.

In the project, you now select Location 2 and double-click item 4*-078: 8-key Audio Panel in the product list. Your
project should now look like the picture below.
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Connection mode

M01 (4 key audio control)
M0O2 (2 key audio control)
MO3 (Source 1)

M4 (Source 2)

MOS (Source 3)

MO0E (Source 4)

MOT (Source S)

M0& (Source &)

MOS (Source 7)

M10 (Source &)

M11 (Change source)
M12 (Mic)

M13 Wolume higher)
M14 MWolume lower)
M1S (Onfoff)

M16 (COn})

MAT (OFf)

M1& (More high tones)
M1% (Le== high tones)
M20 (More low tones)
M21 (Le== low tones)
MZZ (Balance right)
MZ3 (Balance left)

- ﬁ Distribution pan

a

--£% Location_1

(I

-l-fat Location_2

el 1

ki
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As you now have your inputs and outputs, you can start programming. Click the New connection button. The
Connection editor screen will be opened.

Connection editor

Output

Connection mode

Input

21

Z1: Zone
Z2: Zone
Z3: Zone
Z4: Zone
Z5: Zone
Z6: Zone
ZT: Zone
ZB: Zone

¢ zewm ro

oo o o s o o

- (&} | Distribution panel 1
= x| AuD1: Audio Ink

wWer

Parameter 1

Parameter 2

| |
AB Condition

[ ........................................ J _J
Fiter condition

| #

> <|B|>|=|m| o]

[~ Display only unused inputs

il - RERE

The Audio Link with its 8 zones and its power-off function is now displayed in the left Output split window. Only the

first 4 zones can be programmed with an Allegretto A44 system.

You want to program zone 1 first. To do this, select Z1: Zone. Then open the Connection mode window by clicking
the arrow. It is possible to make a selection from 31 different audio functions. In this case, select M01: 4-key audio

control as a first function.

94



-I-fa} Distribution panel 1
- AUD1: Audio link
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{AD1A: Audio local input

Al01B: Audio local input
Al0ZA: Audio local input
Al0ZB: Audio local input
All34A: Audio local input
Al03B: Audio local input
Ald4a: Audio local input
Al048: Audio local input
Al0SA: Audio local input
Al0SE: Audio local input
AlSA: Audio local input
Al0SE: Audio local input
ion_1

2. Bus pushbutton, 4 operation points

A Input
B: Input
C: Input
D: Input
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The inputs we will be able to use for this function will now be displayed in the right split window. The only item listed
is the special 4-key Audio Panel. Click A4: Audio IN4 and confirm this program by clicking the Add connection
button.

Select zone 2 by clicking Z2: Zone. In the connection mode, now select function M02: 8-key Audio control. The 8-
key audio bus push button appears in the right split window. Select it and add the connection.

= ﬁ Location_2
SR BP3: E}ﬂ}r,—xudm Panel

Finally, select zone 3 by clicking Z3: Zone. Select M15: On/off as the connection mode. Using this function, you will
now be able to switch Audio Zone 3 “on” or “off”. Let's see which inputs you can now use.

First of all, you can make use of the 6 voltage-free contacts of the Audio Link itself (Audio local input) for carrying out
this toggle function. Please be aware that the function can be carried out both when the contact is made, and when it
is broken.

In addition, you can see that all parts of the bus push button BP2 can be used to carry out the programmed function.
If, however, you have programmed a clock function or a logic function, these would also be able to carry out the
programmed audio function, if required.

In this case, though, select input A of bus push button BP2. Select this item, click on the Add connection button
and close the Connection editor screen by pressing the Exit button.

Your connection list for the Audio Link module now looks as follows:

Qutput Description Input Description Connection Mode ™ T2 AB Condition | Filter condition
Z1. Zone Ad: Audio IN4 (BP1: 4 key Audio Panel - Location_1} MO1 (4 key audio control}

}2 Z3: Zone A Input (BP2: Bus pushbutton, 4 operation points - Location_1) W15 (On/off)

i}z Z2: Zone Ag: Audio IN8 (BP3: 8 key Audio Pangl - Location_2) M02 (8 key audie control)

The different functions

MO1 is a 4-key function. M02 is an 8-key function. All other functions are 1-key functions.

MO01: 4-key Audio control: this function is intended for a four-way bus push button. The functions of all operation
points are pre-determined.
Pressing the bottom left will switch the audio zone “on” or “off”.
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Each time you press the top left section, you will go to the next source.
Pressing the top or bottom right will respectively increase or reduce the volume of the zone in question.
MO02: 8-key Audio control: This function is intended for an eight-way bus push button. The functions of all operation
points are pre-determined.
The functions of the upper left, bottom left, upper right, bottom right correspond to those of the 4-key audio control.
The middle buttons, labelled 1, 2, 3 and 4, can be used to activate the first 4 sources.

MO03 to M10 incl.: Selection of sources 1 to 8 incl.: Select one of the connected music sources. M03, for example,
will select the music source on the first input of the A44 or the A88 Allegretto installation.

M11: Change source: When the button programmed with this function is pressed, the next connected source to the
A44 or the A88 will be selected.

M12: Mic: Selecting or de-selecting the microphone as sound source.
M13: Increase volume: The volume is increased.

M14: Decrease volume: The volume is decreased.

M15: On/off: This function toggles between switching the audio zone on and off.
M16: On: Switching on an audio zone.

M17: Off: Switching off an audio zone.

M18: More high tones: Strengthens the high tones in the music.

M19: Less high tones: Reduces the portion of high tones in the music.
M20: More low tones: Strengthens the low tones (basses) in the music.
M21: Less low tones: Reduces the portion of the low tones in the music.
M22: Balance right: Amplifies the balance of the right stereo channel.

M23: Balance left: Amplifies the balance of the left stereo channel.
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M24 to M31 incl.: Audio scene 1 to 8 incl. (Preset): Selection of a preset or audio scene. Presets are pre-

programmed sound settings in an audio zone. When choosing a preset, a particular source is immediately selected,

as well as a particular volume and sound setting. It is easy for the user to store a new preset by adjusting the sound

settings for a particular zone as desired and then pressing the Audio scene button for this particular zone for longer
than 2s. The function is similar to the light scene function of the dim controller.
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11. The SMS interface

Remote communication with the home automation system may be important for a number of people. For example,
consider the situation of a general practitioner who, during his final house call for the day, may wish to already open
the door to his practice and switch the lights on in the entrance hall and the waiting room, and perhaps also set the
heating to comfort temperature in the waiting and practice rooms.

All these operations can be carried out by remote control by means of the SMS interface. On the other hand, it is
also possible to transfer technical alarms to one or several GSM devices by means of an SMS message. This makes
the SMS interface a powerful means of communication with the home automation system.

Hardware

The SMS interface (05-203) is connected to a PC Logic module (05-201), that in it's turn is connected to the
installation as master. Making use of filters and logic screens is possible via the same PC Logic module.

-
o000 000
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A | SMS message from the home automation system to a GSM

Nikobus Verson 2 00
a Database version 16.008

s The SMS interface can only be programmed with the Nikobus software. Ensure that you are working with Nikobus
e e pareus version 2.00 or later. You can check your Nikobus software version by clicking About Nikobus... in the Help menu.

Website - hitp v wew nikp.

In your project, define a fuse box as a location and select it by clicking it with the left mouse button. Ensure that the
OUT button of the Project overview window is pressed in. Click the New module icon. The Product list screen will
now be opened. In this list, double-click 05-201: SMS interface. The SMS interface will now be added to the location

Product fist B fuse box. Also add a switch module to this project.
05-000-02 : Switch module

5-001-02 : Shutte dule . . . .
©002.02 - Compact swiahing unt With the OUT button pressed in, your project will now look as shown below.

5-007-02 : Dimcentroller

eontroler —-{a% Distribution board

+-E

--[I7} i SMS01: SMS interface
Q’} ..................................................

g
g
g
g
g
g
g
g

g
ﬁ Location_1

Copyright (C) 2003

05-205 : Audio link

SMS interface

Advice

ok Distribution board
Here, you can see that it is possible to send 10 SMS messages to GSM telephones.

= If you activate the IN button, the picture shown alongside will be displayed. You will also see that up to 10 SMS
output messages can be transmitted from any GSM to the home automation system. In addition, the SMS interface
also has 90 channels available with two operation points. If desired, these can be used to carry out remote control
activities.

We will also install a few bus push buttons in this project.

F A A " A
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SMS messages from a GSM to the home automation system

= SMSI1: SMS output
& Hie: Mes —
é% Wodify cutput name

i

ég EE' Mew connection

Using the Nikobus software, we will make it possible for an incoming SMS to carry out a function.

a. Working with output messages
The most obvious method is using the 10 output messages. These messages can be considered as the inputs to the
home automation system, similar to a bus push button.

We would, for example, like to switch on the light in the hall of a medical practice. We thereby click on the New
connection button. The Connection editor screen is opened. In this screen, we click LP entrance hall practice.
As connection mode, select M02 (the “on” function). In the split window inputs, the picture below will be displayed.

- {a} Distribution board
+-E3 51: Switch module
+ SMSC1: SMS channels
= SMEN: SMS output
= 1I01: Meszage output
f‘ 02: Mezzage cutput
é‘g I03: Mes=age cutput

f I04: Meszage output

ég I05: Mezzage cutput

é‘g 108: Mes=sage cutput

f I07: Meszage output

é“g 108: Meszsage cutput

é‘g 108 Meszage output

f H0: Mez=age output

- b [LBeslion 4]

+ D : Bug pughbutton, 2 operation points
+ D BF2: Bus pushbutton, £ operation points
+ BP3: Bus push button, & operation peints

Here, you will see the 10 lines with output messages that can be used as inputs. Click on 101: Message output and
confirm this program by clicking the Add connection button. For clarity’s sake, you can improve the name of this
input. In the project overview, select this input, click it with the right mouse button and then click Modify output
name. In this way, you can change the name of this input to, for example, switch on LP entrance hall practice.

Attention: It is only possible to carry out one-key functions with the Output messages lines.
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b. Working with SMS channels
The Output messages are primarily used to carry out certain functions by means of SMS messages. This is the
easiest method for the user. If all 10 of the Output messages have already been used, it is, however, possible to
use 90 SMS channels to carry out home automation functions. Each SMS channel can be compared to a bus push
button with two operation points. It is therefore possible to carry out both one-key and two-key functions.

=-¢2% Distribution board As an example, we would like to be able to switch the light point in the waiting room of a medical practice. Open the
2B 51 Switch module New connection screen and select 002: LP Waiting room from among the outputs. As connection mode, select

=% 001: LP entrance hall practice MO01: On/off. Under inputs, you will now find the 90 channels. As you have selected a two-key mode, both operation
=%~ {002 [P waiting room! points of each channel will be displayed. Select CH01AB: Channel and confirm this program by clicking the Add
=%~ 003: LP practice door connection button.
;ﬁ" 004: Switch output
"=§' 005: Switch cutput - SM
"=§' 008: Switch output
— CHOZAE: Channel

=%~ 007 Switch output
j‘ 008: Switch output
=~ 005 Switch output
j‘ 010: Switch output
ﬁ' 011: Switch output
ﬁ' 012: Switch output
+ SM301: SMS interface

CHO3AB: Channel
CHO44B: Channel
CHOSAB: Channel
CHO8AB: Channel
CHOTAB: Channel
CHO8AB: Channel
CHOSAB: Channel
CH10AB: Channel
CH11AB: Channel
CH124B: Channel
CH134B8: Channel
CH144B8: Channel
CH154B: Channel
CH18AB: Channel
CH17AB: Channel

NN N I N A A AN A A A AN A

The name of a channel cannot be modified.
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The SMS settings

You are now able to send SMS messages and carry out activities, but must obviously still indicate how these

messages should look and to which GSM telephones they should be sent.

The item SMS interface is listed In the Edit menu. This function can also be activated by clicking the similar icon in

the function toolbar. The function will open the screen below.

SMS settings

SMS messages SMS commands

Name:
I~ Gsm
™ Gsmz

- GsM3
[ GsMe

Inttialise interface

GSM number

Q01: Message

[~ Output sending text

Change name

To:

x|

>

Cancel

This screen contains three tab-sheets: SMS messages, SMS commands and Initialise interface. We will discuss

each of them separately.
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a. Tab-sheet SMS messages
On this sheet, we will define the outgoing messages and indicate to which GSM telephones these messages must
be sent.

First of all, enter the names and GSM numbers for those GSM telephones to which a message may be sent. When
entering the GSM numbers, however, ensure that you always start with a + sign, followed by the country code (32
for Belgium). This is followed by the GSM number (omitting the first 0). Except for the + sign and figures, no other
signs or letters may be used. Spaces are also not accepted.

Following this, select a message that you can work with. The name of the message can still be changed into an
understandable text here. Tick the Output sending text field. As a result, you will now be able to enter a text in the
field below. This could, for example, be the reporting of a technical alarm, as shown in the picture below. Finally, tick
those GSM telephones to which this specific message must be sent. Other messages can be sent to only one or to
all GSM telephones, as the case may be. The text must not be longer than a maximum of 150 characters.

|OD'1: Flooding atthe washing machine j Change name

W Output =ending text

Water has heen detected under the washing machine. Mikobus has switched off the voltage of
this appliance and has cut off the water supply.

To:

¥ GsM1 [ GsM3 [ G5SM4

b. Tab-sheet SMS commands

In the Commands tab-sheet, you can first enter a four-digit code. This code is, as it were, an access code to the
home automation system. In this way, only certain persons are able to activate the home automation functions with
their GSM telephone. Someone sending the same output message without this code will not be able to activate any
devices.

Then select an Output message, whereby you can modify the name by clicking the Change name button. Tick

Input sending text. You can now enter the text to be sent in the fields underneath it. A maximum of 25 characters is
available.
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Assume that you would like only two of the four persons defined in the previous tab-sheet to be able to send this
command to the home automation system. Click on the Send button. The adjacent screen will be opened. In this
screen, you can select a name (see previous tab-sheet), or have this SMS Output message sent to another GSM
number.

Other GSM number ﬂ

Dermian

Eva

Guy

Other GSK number
“Vera

If you select Other GSM number, you will be able to enter this number. Then click the Send button. The message,
including the access code, will now be sent to the person in question. It is therefore not necessary to enter these
GSM-output messages manually for each GSM.

c. Tab-sheet Initialise interface
Finally, the SMS interface must be initialised. This can be done in the third tab-sheet of the window SMS settings.
You must go through a few steps. This procedure must only be carried out once. To start, click the Start button.

Connect the SMS interface by means of the supplied cable to a computer COM-port. Then click the Continue
button.

The computer will detect the modem and ask whether it should initialise it. Click the Yes button and then the
Continue button.

nikobus

\i:‘) A modetn waz found on gate COM2. Do you want to initialize this modem? [SIEMENS_TC35 REVISIONOZ.10]

In the next screen, enter the PIN code of the SIM card installed in the SMS interface.
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Enter PIM code of the SIM card inthe SME modem.

b

Click the Continue button again. The SMS interface has now been initialised. Clicking OK will close the SMS
settings screen.
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12. FEEDBACK MODULE AND USE OF THE TOUCHSCREEN

The feedback module 05-207 makes a connection between the bus of the Nikobus home automation system and
the touchscreen 05-096 and/or the Nikobus push buttons with LEDs. Via this module, a clear status indication of
you installation is displayed on the touchscreen or via the bus push buttons.

Programming by means of the Nikobus software

The feedback module can only be programmed by means of the Nikobus software. Make sure you are working with
software version 2.3. You can check the version of your software by clicking the 'About Nikobus' in the Help menu.

Feedback rules

Only 1- and 2-button modes are supported. The feedback of a 2-button mode is always given on the upper LED. The
bottom LED is not changed. No feedback is given on sensors that are directly connected to the A or B input of the
switch or dim module. No feedback can be given on the functions of the Audio-Link or SMS module.

After a power interruption, the LEDs return to their previous value (on or off).

Adding a feedback module

Define a room for your project and select it by clicking on it. Make sure the IN button of the project overview window
is clicked.

- Click on the New module. icon. The product list window is opened.

- Double click on 05-207: feedback module. The feedback module is added.
You can add max. 5 feedback modules.
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& nikobus - [Mikobu10] [NEE
Zlee ot progam View Window Help CIET
RS GRETH Ruu R?PE>-<FA-oBOLO

Project overview = é
o] & gF=forfw
& Living No picture avalsble

Liste de produits

Comstion et Lik [E] 05-055 - Mocular irtertace
Hame the location of e project, stert by adding the actors snd describe tf !B 05-056 - Pustéution rtertace
e the sensors and the interfaces and describe the neme of each input, | [B] 05057 Switchinterface
(5] 05-050 7 4°-072 / 05-050-01 - Bus pushbubion, 2 operation
[E] 05-050-02 : Feedbackbution, 2 operations
[Z] 05-051 1 05-061-01 - Push kutton, 2 operation ponts + LEC
[ 05054 747074 1 05-064-01 : Bus pushiution, 4 operation
05064 © 4 key Aucko Panel
05-064-02 : Feedbackbutton, 4 operations
[E 05-076-02 : Feedbackbution, B operations
05-081 7 05-081-01 - IR bus pushiutton, 2 operation poirts:
05-085 7 05-085-01 - IR bus pushioution, 4 operation poirts
[S] 0509 1050801 - IR bus pushioution, identical sddresse
05-200 : PC-Link module
[B] 05-201 - Master FC-Logic componerd
B 05-201 - Sive PC-Logic component
206 - Modular interface § inp

Emmm

Em select a Nkobus component. ‘double chck” on the reguested Rem|

%Dﬁ!'ﬁgmm

For Help, press F1 s 00000

Adding feedback bus push buttons

You can only add feedback bus push buttons if your installation is provided with a feedback module. You can
simultaneously add a bus push button with 2 control keys and accompanying feedback LEDs by double clicking on
05-060-02: 2 control keys with 2 LEDs.

If the bus push button has been added, you can choose which feedback has to be given per key in the window next
to the product image.
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@) nikobus - [Nikobu11]

Z)Eie Edt Progam iew Window Help =l x|
DDU[&&«?QGQ@EE‘E‘ B R?PE>-<FRc-EB0g"0

t o\rn;;:u Output Addrezs / Parameters |
JﬁJJF . F:! i —
Gﬁgmn - -

ﬁ' Create a nevww connection. The function will be determined by the mods and the parametars.

3.:' Disleting & connection

< »
For Help, press F1 _a_. 00000

Possible selections are:
o Auto: the key gives the predefined feedback according to the table below

o Auto-inv: opposite of the previous function

o Permanently off

o Permanently on

o Direct: in the 2nd column, you select the output whose LED you wish to exactly follow the function of
the output.

o Direct-inv: in the 2nd column, you select the output whose LED you wish to exactly follow the

opposite function of the output.
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(COMPACT) SWITCH MODULE When does the LED light? When does the LED blink?
MO1: on/off upper LED lights if the output is on
MO2: on with control time LED lights if the output is on
MOQ3: off with control time LED lights if the output is out
MO04: push button LED lights for as long it is pressed
MO5: impulse LED lights if the output is on
MO6: delayed off, long times LED lights for as long as the output is | LED blinks during transit time
on
MOQ7: delayed on, long times LED lights if the delay time is started LED blinks during transit time
MO8: blinking LED blinks if blinking mode is
activated
M11: delayed off, short times LED lights for as long as the output is | LED blinks during transit time
on
M12: delayed on, short times LED lights if the delay time is started LED blinks during transit time
LED lights if the most recent
M14: atmosphere on adaptation of the output that is
connected to the atmosphere button is
carried out
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M15: atmosphere on/off

LED lights if the most recent
adaptation of the output that is
connected to the atmosphere button is
carried out

SHUTTER MODULE

When does the LED light?

When does the LED blink?

MO1: open stop close

upper LED lights if shutter is
completely opened

during transit time

MO02: open LED lights if shutter is completely during transit time
opened

MO03: close LED lights if shutter is completely during transit time
closed

MO04: stop no feedback

MO05: RF and interface (4-button)

no feedback

MOG6: open with control time

LED lights if shutter is completely
opened

during transit time

MO7: close with control time

LED lights if shutter is completely
closed

during transit time
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(COMPACT) DIM CONTROLLER When does the LED light? When does the LED blink?
MO1 dim on/off 2-button upper LED lights if output is between
min. and max.
MO2 dim on/off 4-button no feedback
MO3 atmosphere on/off no feedback
MO04 atmosphere on LED lights if the most recent
adaptation of the output that is
connected to the atmosphere button
has been carried out
MO5 on, possibly with control time LED lights if the output is between
min. and max.
MO6 off, possibly with control time LED lights if the output is out
MQ7 delayed off LED lights for as long as the outputis | during transit time
on
MO8 blinking LED blinks if blinking mode is
activated
M11 preset on/off no feedback
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M12 preset

LED lights if the most recent
adaptation of the output that is
connected to the preset button has
been carried out

M13 dim on/off, 1-button

LED lights if output is on

M14 dim on/off 1-button with memory

LED lights if output is between min.
and max.

Fow p g wow e o
DEFdLe » 20088 R L

N EE L .

..........................

[ ———

In the connection list, you can easily detect the exceptions:
‘red’: the function of the key is not supported by the feedback
‘orange’; the function of the key is only partially supported by the feedback
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Configuration of the touchscreen

The configuration of the touchscreen can be carried out without it being part of an installation. If it is connected
afterwards, it immediately takes on the preprogrammed functions.

You can start the configuration in 3 different ways:

1. First way:
Open the Edit menu and click on ‘Configuration touchscreen’.
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&) nikobus - [Nikobu4] L=
B Eee (g2 Program View Window Help T
O @ «» Undo: Edeparameters vz BP0 8.8 M T E>-<WHEAS-onB OG0

B Project info ]

ﬁ == Cresle input group
—— = Light scene J Central functions:
= &F New connection
. P8 Sequencer =
£= Logical function
oY Fiker ©
[ Clock tunction
(@ Presence simuiation
@ SMS interface
[0 Feedback module

Address | Parameters

IF  bew connection

list LEDA: F Module touchi <00 %> : <00 %> )

(4 add location IF  Creste anew connection. The function will be determined by the mode and the parameters.
o}, Modity location name
(o} Delete location

E] add module

B3 change module niame I Deleting a connection
£ Delete moduie

By Copy (button) module

# New connection

< >
Add module : Fesdback Module with{out) touch u — 00000

2. Second way:
Click on the icon & in the toolbar. The window ‘configuration touchscreen’ is opened.
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3. Third way: Double click on the touchscreen in the window project overview’.

Configuration of touchscreen

—T7 9

-

1. Knog

—_—» | kitchen (b

e

A

4

4

10, —--

~

=l

Lef L

K

Tab 1

Tab 2

Tab 3

Tab 4

Tab 5

Tab &
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1

Choice of the icon:

If you click on the arrow, a drop-down list with all possible icons is displayed (= combination of key and feedback).
There are icons with an up/down key + lamp, an up/down key + shutter, an icon with only a lamp (no control) or only
the symbol for all off.

2

You can assign a text to every location. The PC-software also automatically mentiones the unique number of the
location. This number and accompanying text are also displayed in the ‘make connection’ and ‘feedback connection’
editor. The number is not displayed on the touch screen.

3

Choose which feedback has to be given.

4

In this dialog, choose which touch screen you wish to configurate. (name: TOUCH x : <text entered by the user>).

5

Click here to choose the sheet you wish to show/modify. You can modify the name of the sheet.

You can max. add 60 2-button bus push buttons. There are 6 sheets with each 10 buttons. Every button
corresponds to max. 1 feedback indication. The touch screen has a fixed layout that is identical to the touch panel
editor. Only the buttons that are configurated in this touch panel editor will be visible on the touch screen afterwards.
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First of all, select an appropriate icon from the list.

g ®
@ b
H o
< Y

9 I

Provide a clear description of the function for the user that will be visible on the touchscreen, e.g. kitchen lamp
Define the action of feedback LED. You can choose from:
o Auto: the key gives the predefined feedback according to p.112-114
o Auto-inv: opposite of the previous function
o Permanently off
o Direct: in the 2nd column, you select the output whose LED you wish to exactly follow the function of
the output.
o Direct-inv: in the 2nd column, you select the output whose LED you wish to exactly follow the
opposite function of the output.

In case of Auto, it will be determined later on if a 1-button or 2-button icon is used, depending on the connection that
is made. In case of Direct, you can choose an output in the bottom ‘square’. If all keys have been defined, you can
close the editor.

| Adding connections

You can add connections via the button 'new connection'. Use the same editor as for any other control. The list with
inputs contains all touchscreens (if different touchscreens are added) and ONLY the controls that have been defined
in the editor ‘configuration touchscreen’.
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Connection editor
Ottt Connection moce Inpout
=-fai Location_t1 Mt ¢on fatf) =] (=@
- S1: Switch module - IE‘ : Feedbackbutton, 4 operations
=F- 001: Switch output Mo parameter 2B Input
ZF 002 Switch output | J C5 oo input
=F 003 Switch output B3 51: Switch module
ﬁ' 204 Switch output Mo parameter
=5~ 005 Switch output | J
=5~ 008 Switch output
=F- 007 Switch output 4B condtion
=E- 008 Switch output
Z O0%: Switch output [None EiE

ZF 010 Switch output
=5 011 Switch output
=& 012 Switch output | J

Fitter candition

| [T Display only unuzed inputs

EERER o

>|<|B|=|= 0| o]

If connections are made that give no feedback, this will be indicated in the overview list:
- ‘red’: The functions of the key are not supported by feedback
- ‘orange’: The functions of the key are only partially supported by feedback

Programming the touch screen

Finally, program your Nikobus installation using the PC software. This is identical to programming other push buttons
in the Nikobus installation.
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13. A PAPER PRINT-OUT OF THE PROJECT
13.1. Page settings

| Description

Working and programming with the computer is very convenient due to the fact that you can always maintain an
overview. A paper print-out of your project data is certainly a part of this.

File Edit Program iWiew Wind If you wish to obtain a paper print-out, you must first check the printer settings. To do so, click on the item Page
— S — settings in the File menu.

[ thew Clrih As a result, the Printer settings screen will be opened.
= Open... Cirl+0

iz Print Setup @E
E Zarvz Cirkes Frinter

Save 4s.. Hame: Jaws POF Creator Properties...

Print... Ctrl+P Statuz:  Feady

Type: Jaws PDF Creator
Where:  JawsPDFCreatorPart
Cammett: Jaws POF Creator

Exit Paper Orientation

1 Mikobus project 6 nkb oo H =l R

2 Mikobuz project 2 nkb Source: |Automatica|ly Select j " Landscape
3 Mikobus project 5.nkk

4 Mikobus project 4. nkb Help | Metwark... | IT' Cancel |
5 Mikobus project 3.nkk

Here, you can select the printer on which you want the data to be printed and, if required, you can adjust the
parameters of this printer by pressing the Parameters button.

In addition, you can enter the paper format to be used and select how the paper should be inserted into the printer.

Finally, select the printing position Portrait in the split window Paper orientation. Exit the window by clicking the OK
button.
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13.2. Print preview

| Viewing an example on the screen \

|File Ecit Program iiew Ainch The Nikobus software offers you the option of viewing an example of the print-out on the screen prior to printing.
= = = Depending on the size of your project, the print-out can take several pages.
[ e Cirl+rl
L2 Cpen... Chrl+0 E
Close Start the Print preview by clicking the Print preview item in the File menu or on the Print preview icon in the
- Standard toolbar. The Print-out components screen will be opened.
I = Eiiphes
Save Az Print components 7|
% B Select which parts you wish to print out:
Page settings... W project info
Exit M  Locations
I Input
1 Mikohus project 6 nkb TP R
2 Mikobus project 2 ikl P Output groups
3 Mikobus project 5.nkb ¥ Sensors
4 plikobus project 4. nkkb ¥ Actors
5 Mikobus project 3.nkb Iv  Interfaces
Ok Cancel

In this screen, you can select the components you wish to print out. You have a choice of seven components:
installation data or project info, the different locations, the input and output groups, the sensors, the actors and,
finally, the interfaces. For all these components, very detailed information is included on the print-out.

When you have made our suggested selection, click on OK. The picture below will be the result.
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ikobus project 1.nkb]
MNewt Page | Frev Fage | One Page I Zoom |h | Zonm | LCloze I

2. Locations
rrys——"—
) Dnung pras g
= Bl Ewinch sodule (05-000-07 - Ewich awdule) Mo ald s

T 5 T e
gnabus-damuﬂcusgsieem

EE Erens

[] B Bus pushibumoa, 2 opession poias: (15064 = Bus pushbumon, 7 opestivn poias) Ko addess

1. Installation
Nt el Nalcobus meie
Telephon s auster mailer
N cean
Telephon s austser csoaes
Paojerd m s

Weskead diys Situali, Suadicy

Pages 1-2 [ [ > - |o:omon

M“ AE B < »|J|Qnikohus - [Nikobus pr... |@,@?%$@5®%g§ 1648

With the sliding bar at the right side of the screen, you can view the following pages.
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You can, however, also use the Next Page or Previous Page buttons to browse through the document. Buttons are
also provided for zooming in or out on a page. With the toggle button One Page or Two Pages, you can select
whether to have one or two pages on the screen at the same time. The Print button allows you to print the example
out on paper.

Exit the screen by clicking Close.

Mext Page | Frew Fage | One Page Zoom |n ) [t LCloze
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13.3. Printing

| The project on paper

[ e Cirl+rl

L2 Cpen... Chrl+0
Close

I = Eiiphes

Cirl+P

& Prirt Prewview
Page zettings..

Exit

1 Mikobus project 1.nkk
2 Mikobus project 6.nkk
3 Mikobus project 2.nkk
4 Mikobus project 5.nkkb
5 Mikobus project 4 nkb

In order to print out on paper, click the Print item in the File menu, or use the print icon = in the Standard toolbar.

This will open the Print screen.

Print
Frirter
M ame:

Status:
Type:
Where:

Comment;

Frint range
Al
" Pages

~

2 POF Creatar

Ready

Jawsz PDF Creator
JawzPDFCreatorPort
Jaws PDF Creator

from: |1 b

Help

?)x
Properties...

[ Prirt to file

Copiez

HNumber of copies: 1 3:
:
(1] | Cancel

You must click OK to start the printing.
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14. DOWNLOADING THE PROGRAM TO THE INSTALLATION
14.1. Making a connection to the computer

| The physical connection

If you wish to download the created program to the installation, you must first establish a physical connection
between the computer and the installation. This is done by connecting one end of the RS-232 cable to a COM port
of the computer, while plugging the other side, (fitted with an RJ connector) into the PC-Link module of the PC-

Logic module.

Setting the correct COM port

A computer usually has several COM ports. By means of the Programming menu and the menu item Port, the

correct COM port can be set.

Program  Migwy Windows  Help

[Logd project ayeriesy fharm Pe-ink
lzl Eragramm
'Z. [La existin inetallstian

>
o Connect
e addresses

AR

Gl

—1

Cokd 1
Lt o IS N e (=)
Comd 2
Lt o Vel e (=)
CoOM 3
O S EEET
Cond 4
L) [ e =2

Ramaman's
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The data link

Once the physical connection has been established, you will be able to set up a data link for the communication
between the computer and the installation. Ensure that the installation is under voltage.

In the Nikobus software toolbar, click on the Connect icon. Establishing a data link is also possible, however, by
clicking the Connect command in the Programming menu.

Program  Miewy Aindowe  Help

[Coad| project aversiesy framm Pe=Link
'Z. Eragramm
% [Load exieting|installstion

Port 4

E} Connect

Aasinnaddresses

As a result of this action, the Connect icon will appear on the status bar at the bottom of the screen, together with
the used COM port.

If no data link has been established, the status bar will appear as shown on the left.
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14.2. Addressing the components

| Introduction \

Every Nikobus component (switch module, dim controller, shutter module, push buttons, PC-Link, PC-Logic, RF-
receiver...) has a unique address. This address is assigned to the components at the factory.

In the traditional Nikobus way of programming, a push button must be pressed in order to indicate that this particular
push button will carry out the established programming for the selected output(s). By this action, the address of the
push button is assigned to the output module concerned and will be used by it.

In the software, you must do something similar. You have included several input and output components in the
Project overview window. All these components must be assigned a physical address corresponding to the
physical component of the installation.

Assigning addresses can be done in two different ways.

First method: individual assignation

-2 Distribution board Select a component in the Project overview window; for example, a switch module.

--E O1: Dimcontraller
E-E3 R1: Shutter module
EEB==F =1: Switch module

Then click the Address / Parameters button in the Info window, in the upper right of the computer screen. The
screen below will be opened.

Physical address ﬂ
Address / Parameters |

Component's address: IE

(5et the address from the Mikobus: et itl

Cancel (0]
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Get it

Ensure that the data connection is active, as described in section 10.1.
| Click the Get it! button.

In your screen, you will see that the Get it! button makes way for the message Waiting for an address...

Component's address:

Get the address from the Mikobus:

YWaiting for address. .

Cancel ]k

The address of the selected switch module must now be transferred to the computer. In order to do this, briefly press
the yellow Mode key of the relevant switch module until you hear a beep. At that moment, the address of this
component will be displayed on the screen (see picture below).

Physical address ﬂ

Component's address: IBEJH

(>et the address from the Mikobus: et il

Cancel 0]

Exit the Physical address screen by clicking the OK button.

In the same way, you can now, for example, assign the address of a push button. Follow the same procedure, but
now briefly press the relevant push button in order to assign its address and transfer it to the computer program.
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EiSacEEG naa K1E3 Depending on the type of component, the screens may slightly differ from each other. In case of the dim controller,
for example, you will also see a list of the set parameters per dim channel.

Component's address: I5245

Get the address from the Nikobus: | Get itl i

|T Cancel | oK I

Setting for Dimmer Output
Output

01. LP staircase
2. LP dining table
3. LP couches

4: LP coffes table
5. LP television 1
5. Standing lamp di
_Standing lamp lo
8. Standing lamp off . |

ol

1.
2

ODOOOPOEQQ!":
] el ]
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Second method: through the “Assign addresses” command

[Program iew Window Help In order to start the second assignation methoq, click the command Assign addresses in the Pr.ogramming menu.
The screen shown below, Input addresses, will be opened. The command Assign addresses is only accessible if
data communication between the computer and the installation has been set up previously, as described in section

Load project overwviewy from PC-Link

83 Program 10.1.
% Load existing installation
Port ¥ Input adresses HE
>
¢ Sonnect Received address | Time | Type | Ascigned address | Type | Input
i acidr : D D1: Dirncontraller (Distribution board)
B R R1: Shutter module (Distribution board)
S 31: Switch module (Distribution board)
------ EBF BP1: Bus pushbutton, 2 operation points (L
------ EBF BP2: Push button, 2 operation points + LEC
------ EBF BP3: Bus pushbutton, 4 operation points (L
------ EP BP4: Bus push button, 8 operation paints (1
------ I IE1: IR bus pushbutton, 4 operation points {
------ RF RF1: EFE6S Transmitter, 16 operation paint
==lecignEs |
BElete |
Delete all
4] | |
I Only display addresses that have nat yet been assigned, [ Only display modules that have no address,
Listen [n]%4

Now click the Listen button at the bottom left of the screen.

Listen The computer is now ready to receive the address data of any component.

As an example, press push button BP2 of the installation. As a result of this, three columns will appear in the left split
window. In the first column, the hexadecimal address of the component - in this case a push button — is indicated.
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In the second column, the time when the push button was pressed is indicated. The third column indicates the type

of component.

Feceived address | Time Type
105676 072234 | BRAG/CFEARY. ..

Click this line with the mouse pointer. Then select the corresponding component in the right split window using the

mouse pointer. In this case, this is BP2. Only now can the Assign button be clicked.

By doing this, the address is assigned to the bus push button BP2 of our project. In the Assigned column of the right

split window, you will find the address next to the name of the push button.

Assigned address | Type | Input

D 01: Dimcontroller (Distribution board)

B E1: Shutter module (Distribution board)

5 51 Switch module (Distribution board)

- BP EF1: Bus pushbutton, 2 operation points (L
] BPZ: Push button, 2 operation points + LEQ

------ BF EF3: Bus pushbutton, 4 operation points (L
------ BF BP4: Bus push button, 8 operation points (1
------ IR IR1: IR bus pushbutton, 4 operation points |
------ RF RF1: RFEES Transmitter, 16 operation point

Provide all other components of our project with an address in the same way.

When finished, exit the Input addresses screen by clicking the OK button.
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14.3. Downloading a project to an installation

| Description \

Now that the addresses of the installation components have been assigned to the corresponding components in
your programming, you can download the programming of the various components to the installation.

3> First, establish the data communication link between the computer and the installation. To do this, click the Connect
<« icon in the toolbar or the Connect command in the Programming menu. You should see the following in the status
bar at the bottom of the screen:

3% comi | C:oD:0d

= Open the Programming window by clicking the relevant icon on the toolbar or by clicking the Programming
command in the Programming menu. You will obtain the screen shown below.

Programming ﬂ E

ﬁ“ Distribution hoard

== 1 Dimcontroller

Installation progress:

fodule progress:

Program |

Select modified modules

Select all [8]%4 |

The modules that are displayed inversed (blue background colour and white letters) are those modules to which
modifications have been made. If you want to download a completely new programming, then select all the modules
by clicking the Select all button.
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If, however, you do not wish to reprogram certain modules, you can de-select them by clicking them. In this case,
they will not be displayed inversed.

Click the Program button. The download of the program to the installation is starting.

Installation progress:
]

Module progress:

O1: Dimcontraller : 1416,2000

When the programming of all modules has been read into the installation, exit the window by clicking the OK button.

Important: If several sets of programming are transferred to the installation consecutively, it is desirable to carry out
a new initialisation of the installation by briefly (minimum 5 seconds) cutting the power supply of the installation.
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15. REFERENCE SECTION
15.1. Menu structure

File Ecit Program “iew wincdow Help The Nikobus software contains a menu bar in which the following items are included:
File
dit
Program
View
Window
Help
File Menu
| File Edit Program Wiew Windo The File menu is used to carry out different actions with files, for main printing files and for closing the program. It

[ Hew Clrie contains the following items:

(= Open.. Clri+ [0 hew tir+ The New command is used for starting a new Nikobus project. It can also be activated by
Close clicking the relevant icon in the main toolbar or by typing the combination Ctrl+N (keep the key Ctrl pressed in
Save Crl+s while typing the N key) on the keyboard. A new project will be opened. The software will give a name to this new
Save A, project. It is, however, recommended that you name your projects yourself. This will make it easier to find projects on

the hard disk. To do this, see the Save as command.

& Frint... Ctrl+P

[, Print Preview (= Qpen... Lir+2 Use the Open command to open a project that already exists. The command can
Page settings .. also be activated by clicking the relevant icon on the main toolbar or by typing the combination Ctrl+O (keep the

key Ctrl pressed in while typing the O key) on the keyboard. The Open window will come up.
Exxit
1 Mikohus project 20.nkb
2 Mikobus project 1 .nkb
3 Mikobus project B.nkb
4 Mikobus project 2 nkb
5 Mikobus project 5.nkb
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Open ?)X)
Look in: |_; Examples ﬂ - CF '
- | gNikobus project 1.nkb
Le) K
My Recent
Documents
Desktop
My Documents
8
My Computer
‘Lj
Mypl;vlait:sork File name: || ﬂ Open |
Files of type: |".nkb ﬂ Cancel
Select a project in the relevant folder and click the Open button.
ez Use the Close command to close the current project. If any modifications have been

made to the current project, the screen below will be opened automatically.

nikobus |

:\?I) Do you wyart to =ave changes of ‘Mikobus project
20.nkk"?

Mo Cancel

If you want to save the modifications, click the Yes button. If the project has not yet been given a name, the Save as
screen will be opened, with which the project can be assigned a name. In addition, the folder or directory in which
the file should be saved can also be selected.

If you do not wish the modifications to be saved, simply click the No button. All modifications to the project will then
be lost.
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Savein: | | Examples
: = Nkobus project 1.nkb

My Recent
Documents

€

Desklop

My Documents
(-
J'g

My Computer

<9

x| e @B

My Network  File name:

Places

Nikobul.rkb]

Save az hype: “nkb

Pt
] | 8 % [t b

T

RPN S ]

Print Setup @E
Prrbe
SN FOF Creator -| Propesties.
Statuz:  Ready
Type: Jawrs POF Creator
Where  JawePDFCreatoPost
Comment Jawes PDF Creator
Paper Oiienston
Size: Im - * Portisit
Souce  |Automatically Select - ™ Landscape

Heb | Metwark. Cancel
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Should you now decide to continue working with the current project after all, click the Cancel button. You can
achieve the same result by pressing the Esc key on the keyboard (top left of the keyboard).

& save “*S The Save command is used to save the modifications that have been made to the
current Nikobus project, without renaming the project. This command can also be activated by clicking the relevant
icon in the toolbar. It is recommended to use this command regularly while working with the software, in order not to
lose too much data in case, for example, a power cut should occur while you are working with the software.

SElE i The Save as command is used to save the Nikobus project under a different name. It is
recommended to use this command after you have used the command New. In this way, you can select a suitable
name for your projects yourself, so that they can easily be retrieved from the hard disk.

In the Save as screen, you can create a suitable directory in which to save your projects. In addition, a name can be
assigned to the project.

&) brirt... S The Print command is used to obtain a paper printout of your project’s program. It can
also be activated by clicking the relevant icon on the main toolbar or by typing in the combination Ctri+P (keep the
Ctrl key pressed in while typing the P key) on the computer keyboard. The Print components screen will be
opened. In this screen, you can tick which components you wish to print.

[& Print Preview With the Print preview command, an example of a printout will be displayed on the

computer screen. The Print components screen will be opened first. In this screen, you can select what you would
like to include in the printout example.

All print preview pages can be viewed using the scrollbar on the right hand side of the screen. This command can
also be activated by means of the main toolbar by clicking the relevant icon.

It is also possible to zoom in on the pages, and you also have the choice as to whether you would like to view one or
two pages on the screen.

Page settings. . The Page settings command allows you to select the printer and to set up the correct

settings for this printer. This command opens the Windows® screen Printer properties.
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2 Mikobus project 1 .nkk
3 Mikobus project 6.nkb
4 Mikobus project 2.nkb
S Mikobus project 5.nkb

Edit Program iew Window Help
7 Undo: &dd module Ctri+Z

[®] Project infa

= Create input group
=— Light =cene J Central functions
EE' Mewy connection
Fg Sequencer

o= Logical function
@y Fiter

Clack function

(%) Presence simulation
&% SMS interface

[ Feedback module

{a}. Add location

ﬁ, Modify location name
ﬁ Delete location

B sdd module

% Change madule name
% Delete module

Copry Chutton) mocule

I Mew connection
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Exit The Nikobus software can be exited using the Exit command.
Most recently opened files: At the bottom of the File pull-down menu, you will find the names of the 5 files that

where opened most recently. Clicking one of the names will open the corresponding file directly. This is a quick way
to open those projects on which you have been working most recently.

Edit Menu

The Edit menu provides all the tools necessary to carry out the required programming of Nikobus projects. The
items and functions listed below are available in this menu.

[l Project info With the Project info command, every project can be supplied with the necessary
project data. This data is included in the printouts. The command can also be activated by clicking the relevant icon
in the function toolbar.

= ClEE S TS FED The Create input group command enables several sensors (inputs) to be placed in
the same group. In this way, push buttons that will perform the same function need only be programmed once. The
command can also be activated by clicking the relevant icon in the toolbar.

== Light seene fCentral functions. By means of the Light scene / Central functions command, several outputs can be
placed in a group. The command can also be activated by clicking the relevant icon in the toolbar.

207 EarnEEen By means of the New connection function, outputs and output groups will be
connected with sensors or inputs through a mode or function. The command can also be activated by clicking the
relevant icon in the toolbar.

P& Seuencer By means of the Sequencer command, it is possible to create the program for a
sequencer function. The command can also be activated by clicking the relevant icon in the toolbar.

B | LCEICE] (UG This function opens the Logical functions screen. With this function, logical functions
can be created from the inputs. The command can also be activated by clicking the relevant icon in the toolbar.

ey Filter This function opens the Filter screen. With this function, any input can be used as a
filter function for another input. The command can also be activated by clicking the relevant icon in the toolbar.
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GHEIEts el tel) This function opens the Clock function screen. With this function, various clock
channels can be created. Using a clock line, it is possible to activate or de-activate any function. The command can
also be activated by clicking the relevant icon in the toolbar.

(@ Presence simulation This function opens the Presence simulation screen. In the simulation, activities are

recorded that will be carried out when the family members are absent. This command can also be activated by
clicking the relevant icon in the toolbar.

Feedback Modul
03 Feedback Madule The feedback module makes a connection between the bus of the Nikobus home

automation system and the touchscreen 05-096 and/or the Nikobus push buttons with LEDs. Via this module, a
clear status indication of you installation is displayed on the touchscreen or via the bus push buttons.

oy Aeld location With the Add location command, it is possible to add a room or a distribution panel to
the project. The command can also be activated by clicking the relevant icon in the toolbar.

fa, Modity locetion neme By clicking Modify location name, the name of a room can be changed.

{a} Delete location With Delete location, an room that has already been created can be deleted from the
locations tree structure. The command can also be activated by clicking the relevant icon in the toolbar.

E Add madule The Add module command is used to add a Nikobus component to the locations tree
structure. The operation of the command is dependent on the buttons OUT and IN. If the OUT button is activated,
only output modules can be added. If, on the other hand, the IN button is activated, all other Nikobus components
(sensors) can be added. The command can also be activated by clicking the relevant icon in the toolbar.

E Change madule name If a Nikobus component (output module or sensor) has been selected, the name of the

module can be adapted to your individual requirements using the Modify module name command.

B2 Celcio il If a module has to be deleted, this can be done by using the Delete module

command. The command can also be activated by clicking the relevant icon in the toolbar.

Macify output name The Modify output name command is used to adapt the output names of the output
modules to your individual requirements.

Nz EarnEien By means of the New connection function, outputs and output groups are connected

with sensors or inputs through a mode or function. The command can also be activated by clicking the relevant icon
in the toolbar.
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HI3EliF? GBI e With the Modify connection command, it is possible to modify an already existing

connection between an output or output group and an input or input group.

- :
bx CEEEEENEEHEn By means of the Delete connection command, an already existing connection can be

deleted. The command can also be activated by clicking the relevant icon in the toolbar or by clicking the button
Delete connection.

\ Programming Menu

By means of the Programming menu, all kind of activities can be carried out that are related to transferring the
computer program to the installation, or the other way round. This menu must also be used for the assignment of
addresses.

Load project overview fromPC-Link~ Use this menu item to read the configuration of an installation into the
computer. This then causes all Nikobus components to be placed in a new file. This command can only be activated
if an RS-232 connection between the computer and the installation has been previously set up.

3, Brogram The Programming command is used to channel programs from the computer
to the installation. The command can only be activated if an RS-232 connection between the computer and the
installation has been previously set up. The command can also be activated by clicking the relevant icon in the main
toolbar.

2 e el stttz By means of the Load existing installation command, the programming of an

installation can be transferred to a computer. The command can only be activated if an RS-232 connection has first
been set up between the computer and the installation, and after the command Load project overview from PC-
LINK has been carried out.

Part k By means of the Port command, the COM port that will be used for the RS-232
connection to the installation can be selected on the computer.

>
€ Connect With the Connect command, a data connection is established between the

computer and the installation.
Agsign addresses The addresses of the various Nikobus installation components can be assigned

to the corresponding software components using this menu item. This command can only be activated if an RS-232
connection has been previously set up between the computer and the installation.
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View Menu

Product list

L Modify Languade
Extensive Layout
Fort size

With the View menu, a number of screen layout parameters can be set. It is possible to choose whether or not
certain windows and toolbars should be displayed and/or adapted. Other languages can also be selected here.

v Toolbar Clicking the Toolbar command several times will turn the main toolbar alternately visible
or invisible on the screen. If Toolbar has been ticked, it will be visible.

[DeEHRE BAaES=E7H | B2 % (2R

v Function bar Similarly, an additional toolbar will be alternately displayed or not displayed on the screen
by clicking the Function bar command several times. If Function bar has been ticked, it will be visible. Various
icons that allow access to separate dialog windows can be found on this toolbar. All these functions can also be
found in the Edit menu.

Bl =< 4 ooy {7 O

v Statushar By clicking the Status bar command several times, the status bar will be alternately
displayed or not displayed at the bottom of the screen. If Status bar has been ticked, it will be visible. This bar
provides the user with context-sensitive information.

For Help, press F1

Msan| |4 €@ B =)

nikobus - [Mikobus pr__.

B Log By clicking the Log command several times, the Log window will be alternately visible or
invisible at the bottom of the screen. If Log has been ticked, it will be displayed. In the Log window, information
regarding the operation of the program can be found. Possible errors in the program or in the communication can be
traced here.

5.1 1=l
3.1
3.1

05/0172003 11:45:17 (I» Version mamber of Niko_05_007.DLL
02/0L72003 11:45:17 (I* Version mumber of Nikeo_0&_Z00.DLL
03/0L/2003 11:45:17 (I¥ Version mumber of Niko_05_l00.DLL
02700172003 15:33:06 (I» Document saved.

08/01/2003 15:33:06 (I» Document closed (deleted niko_ .mdb)

x|
o

FlL
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IE Broject overview With the Project overview command, it is possible to select whether the Project
overview window should be displayed on the screen or not. This window shows the project as a tree structure.

Project overview | x|

NEIETES

=- ﬁ Distribution board

- -[J CAL1: PCLink module

=B ‘ﬁ’ Location_1
------ ~.[E] BP1: Bus pushhutton, 2 operation points
------ SEE £~ Fush button, 2 operation points + LED

Display guide windows In the Guide windows, you can indicate whether these windows should be displayed
again or not. When opening a new logical function or clock function in the future, these windows can be displayed
again by activating the Display guide windows command.

Procuct list By means of the Product list command, the Product list window can either be shown
on the screen or not.
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L Modify Language The Modify language command makes it possible to use the program in other
T languages. Select the desired language and click the OK button. Obviously, only the language of the program will
M_ change, and not the names that you have possibly already entered yourself for rooms, distribution panels, output or
Fangais input modules.
ederlands
Extensive Layout By clicking the Extensive layout command, a choice between two screen visualisations

of the basic screen can be made. If no tick has been placed, a fixed screen for the Project overview can be found
next to the Info window. In the other case, the Info window takes up the entire screen, with the Project overview
window on top of it. The latter window can be dragged anywhere on the screen by means of the screen’s title bar. Its
size can also be adapted to your individual requirements.

e Pi] riikobus - [Wikobus project 21.nkh]
Uk Cancel [ ke gt Program iew Window Heln =l81x|
NSHRS AAEIFEIR- NE[E>-<FRcaEO
= k 1 Nass arametars
. . B N Addrass | Paramet
kG Ty T New connaction
& [ L I Delate connaction
°m. -m° —
Display all connactions 7
Connection list BP1: Bus pushbutton, 7 operation points
NREIETE
=il Distribution board
F? _CAL1: PCLink module
= fat Location_1
10 L] BP1: Bus pushbuttan, 2 operation paints
)
11
12
13
14
For Help, press FI ¥ o000
13 5] |2 8 W 55 7 [ mivabun - Wit BF LIl 2% 85
v 15
17 Fort size b By means of the Font size command, the size of the used font can be set. It is possible
i to choose a font size from 10 to 18.
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Window Menu

If desired, several info windows can be used. The commands in the Window menu can only be clicked if the
Extensive layout command of the View menu is activated.

oy Mesw wincloy

=

Creates a new Info window.

Cascading windows

manner.
B Mikobus project 21.nkb:1 - |EI|§| -

Mikobus project 21_nkb:2

Il = | |

........ Address [ Parameters |
Bl xavaxsueﬁlqsvxmvszx?ﬁ- B

TERE TR R T AR

-ﬁ:ﬂh—i‘iﬁfﬂ- -_:I
wrrrrr | FA¥¥7f @ ..:w@ (3]

(- .
Mews connection

rFerE 2
-.....__. _:I :x- Delete connection
FTPTIPrreS
] _::‘-_-.‘!_-’_'_-’_'_(::?‘;I o [i _ik_f_l.g:

Dizplay all connections ™
___ Connection list D1: Dimcontroller{ 0.5 % : 0.0 % ) - OU1: Dimmer

.I*

output 0-10%
Dutput Descript... | Input Description Connection Mode | T1
¥ 001: Dimme...  AB: Input (BP1: Bus pushb...  WO1 (Diman/.. T2=.
] | -

(Cascading windows) Puts the different windows over each other in an overlapping
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O] x|

Address / Parameters |

Nikobus project 21.nkb:2

e . 0
Mew connection

Delete cannection

Display all connections—
Connection list D1: Dimcontroller{ U5 % : U.U %

) - 001: Dimmer output 0-10V

=10l %]

. Address / Parameters |

- L
[ ] e
_|® - ’ -uu_g_' Mews connection
= - [} [m]
B | (& 060 D — ;
@ © Delete cannection
— Ii‘ 1 Bl |: .

Display all connections =
___ Connection list BP1: Bus pushbutton, 2
operation points

Input Description
AB: Input (BP1: Bus pushb. ..

Qutput Descript.
[¥] 001: Dimme. ..

001: Dimmer output 0-10% .

[=] AE: Input

| |
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(Arrange windows) Puts all open Info windows next to each other on the screen.

Nikobus project

143



nNiko

Iluminating ideas.

Help Menu

Hel If help is required while using the program, the Help topics command can be used. Activating the command will
- result in the screen below. The help function is structured as in any other Windows® program. Consult your

Bl Tagies Windows® manual if you wish to make use of it.

Imfa Mikobus installstion

Infa Mikobus software @ About HikoBUS. . | The About Nikobus... command opens an info screen in which the version of the
Nikobus program that is being used will be indicated.

R About NikoBUS...

Over NikoBus...

Nikobus Version 2.23
Database version 9.002

103

Contact :  supporti@niko.be
or 432 [0)3 /760.14.82

Website :  hitp./fwww niko be

Copyright (C) 2002
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15.2.Toolbars and icons

| Main toolbar \

DEERES AAFIFRF 22222

You can decide whether to display the main toolbar on the screen or not by clicking the View / Toolbar command

O Create a new Nikobus project.

|

L= Open an existing project.

I Save the opened project without renaming the file.
[&, Print preview.

= Print command.

i Add a location or a room.

i~ Delete a location or a room.

= Add Nikobus components (sensors, actors).

= Delete Nikobus components (sensors, actors).
Create a new connection.

Delete an existing connection.

« Create an RS-232 connection with the installation.

% Download the program from the computer to the installation.
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% Upload the program from the installation to the computer.
K? Context-sensitive help indicator.

7 Opens the About Nikobus info screen.

Function bar

Blo=<iHTonGEOG O

The Function toolbar can either be displayed on the screen or not by clicking the View / Function bar command.
This toolbar contains icons allowing the direct opening of various dialog windows.

7 Clicking this icon will display the Project info dialog window, in which the project coordinates can be stored.
= Create new or edit existing input groups.

< Create new or edit existing output groups.

Create a new connection.

k= Allows the creation of a new sequencer or the editing of an existing sequencer.

> Allows the creation of new logical functions or the editing of existing logical functions.

oy Allows the creation or modification of filter functions.

Create or modify clocks.

© Create or edit a presence simulation.
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Qﬁ SMS interface

ETJ Feedback module

| Project overview toolbar

(| oy | = EFfour | w

Some icons have also been placed in the Project overview window.

Add a location or room.

Delete a location or room.

Add Nikobus components (sensors, actors).

0 0 R P

Delete Nikobus components (sensors, actors).

Allows the viewing of only the outputs in the Project overview window. The output groups are also visible.
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ARSI o

Eﬁ Distribution panel garage
=-Ef $1: Switch module

=& 001: Sprinkling group 1
-Z§ 002: Sprinkling group 2
-z 003: Sprinkling group 3
-Z§ 004 Switch output

2§ 005 Switch output

2§ 006 Switch output

= 007 Switch output

= 008 Switch output

-2 009 Switch output

-Zf 010 Switch output

-ZF 011 Switch output

012: Switch output

SEQ01: Garden sprinkling

b

B4

nNiko

Iluminating ideas.

4| Allows the viewing of only the inputs in the Project overview window. The input groups are also visible. In

addition, the PC-Link and PC-Logic modules are also displayed.

Project overview

NNEIETEEN

=- ﬁ Distribution board

- -[J CAL1: PCLink module

El-ﬁ’ Location_1
------ ~.[E] BP1: Bus pushhutton, 2 operation points
------ SEE £~ Fush button, 2 operation points + LED

| =
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15.3. Basic screens

The basic Nikobus software screens include the Project overview, Info and Connection list windows.

Project overview window

— Prsjectemerview ] In the Project overview window, a tree structure of the project is created. The items displayed in the window
/ﬁ'\. %J%JI oUT 1IN | depend on the position of the IN and OUT buttons. If the OUT button is activated, the module outputs and the output
groups will be shown in the tree structure. If the IN button is activated, the input modules, such as push buttons,
=i [ Groups interfaces and PC-Logic and PC-Link module, will be shown. In addition, you can also view the input groups here.
] CF1: Master-off
=@ Distribution panel garage The Project overview window is always in one of the two positions, either IN or OUT.
--EF D1: Dimcontroller
:g; 2: gx&r:ﬁiﬂf a. Adding and deleting rooms and distribution panels
=-Ef §2: Switch module
=44 Distribution panel attic Rooms and distribution panels can be added to the tree structure In both the OUT and IN position. To do so, click
E.E gg g:';z:':]"::]';irle the New location i3 icon. This icon can be found in both the Project overview window toolbar and in the main
=-Ef S4: Switch module toolbar.
{5 Garage
-1 Office A new room/distribution box is thereby created. The standard name is Location_1. The new location can, however,
-l Entrance hall be immediately renamed by typing in a new name and closing this action with the Return key. In this way, a list of
~fat Toilet ground floor distribution panels and rooms belonging to the project is obtained.
-fay Staircase
:g f;lf::':ﬂum It is also possible to enter a different name after a room has been created. To do this, select the relevant room and
{3 Front door outside click it with the right mouse button. A pop-up menu is thereby opened in which you can select Modify location
-4 Night hall name. Type in the new name and close the action by pressing either the Return or the Enter key. This command
{3 Bathroom can also be found in the menu displayed under Edit / Modify location name.
~fai Bedroom 1
- {a; Bedroom 2 b ﬁ Terrace
~{ai Guest room ﬁ
-fai Bedroom parents o W‘ ;
@4 Terrace fa} A location

ﬂ Madify lacation natne

fry Delete location

E Acdd module
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=3 05-000-02 : Switch module
= 05-001-02 : Shutter module
= 05-007-02 : Dimcontroller

Switch module

Elﬁ Distribution panel garage
B2 51: Switch module

Madity output name

;ﬁ' Q03 Meswy connection

-Zg 0047 =wiTen oot

=-Ep S52: Switch module

-2~ 001: LP front outer wall

.25 002: LP rear outer wall

.25 003: LP office

.25 004: LP office cabinet

~Z& 005: LP living room wall

ZF 006: Doorbell

-2~ 007: Garagedoor pulse open
-2~ 008: Garagedoor pulse close
-Zf 009

-.Z& 010: Office heating nicht

-2~ 011: Living rooms heating night
-2&" 012: Bedroom 1 heating night
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Using the same method, a room or distribution box that has already been created can be deleted. To do this, click
the above command window or the Delete location command in the Edit menu. A location can also be removed by

selecting the location to be deleted and then clicking the Delete location icon (et in the various toolbars.
b. Adding and deleting output modules

Make sure the OUT button is activated by clicking it.
Once the different distribution panels and rooms have been created, the output modules can be placed and the
outputs can be named. Select a distribution panel in which you want to place a module and click the New module

= icon. This command is also available under the Edit / Add module menu. If it was not already visible, the
Product list window now appears. This window only lists the output modules of the Nikobus home automation
system.

In the product list, double-click the module to be added. This will cause the module to be added to the previously
selected distribution panel.

To rename or delete a placed module, select the module in question in the Project overview window and click the
right mouse button. A pop-up menu will be opened in which the Modify module name and Delete module
commands can be activated. Both commands can also be clicked in the Edit menu. To delete a module, the Delete

module % icon, which can be found in the toolbars, can also be used.
c. Naming and renaming outputs

Once an output module has been placed under a distribution panel in the Project overview window, the outputs of
the installed module must be named. This is quite convenient, as it is possible to use normal, intelligible words in
order to indicate which load will be connected to a particular output.

In order to view all the outputs of a particular module, click on the square with the plus symbol (on the left of the
selected module). Now select an output, and click the right mouse button. The Modify output name command can
now be clicked. Then type in the name of the load and close the action by pressing either the Enter or the Return
key.

The Modify output name command can also be activated under the Edit menu or the F2 key.
If no programming has been assigned to an output yet, the output will be displayed in light grey in the Project

overview window. If programming has been assigned, the output will be shown in black. If an output belongs to an
output group, it will be displayed in blue in the Project overview window.
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The same applies to the way in which the output modules are displayed. As soon as a module output has been

programmed or has been added to an output group, the colour with which it is represented in the Project overview
window will change.

d. Dragging output modules

If an output module has not been placed in the correct distribution panel, it can be moved to another distribution
panel. To do this, select the module to be moved. Click the module and drag it to another distribution panel (by
keeping the left mouse button pressed in). Once it has arrived at the correct distribution panel, let go of the left
mouse button. The module has now been moved to the other distribution panel.

e. Adding and deleting input modules

Make sure the IN button is activated by clicking it.
Once the different components in the distribution panels have been created, the input modules will be placed and, if

desired, named. To do this, select a room where you wish to place a module and click the New module = icon.
The Product list window now appears if it was not already visible. This window now only lists the input modules of
the Nikobus home automation system.

In the product list, double-click the item to be added. This will add the item to the previously selected room.

In order to delete an installed input module, select the module in question in the Project overview window and click
with the right mouse button. A pop-up menu will be opened in which the Delete module command can be activated.

The command can also be clicked in the Edit menu, or can be activated by clicking the relevant icon = in the
various toolbars.

f. Naming or renaming inputs

Once an input module has been placed under a room in the Project overview window, it can be named. This is
quite convenient, as it is possible to use normal, intelligible words to indicate the function that a particular input will
operate. The name of a push button always starts with the letters BP, for Bus Push button Location, followed by a
number. The program automatically increases the figure by one for every newly placed push button. The coded
names of the push buttons can be transferred to the drawings of the floor plan. In this way, every push button in the
Nikobus software can easily be found on the floor plans, and vice-versa.

To view all inputs of a particular room, click the small square with the plus symbol (on the left of the selected room).

Now select an input, and click on the right mouse button. The Modify module name command can now be clicked.
Then type the name of the input, and close this action by pressing either the Enter or Return key.
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The Modify module name command can also be activated by means of the Edit menu or F2 key.

If no programming has been assigned to an installed push button yet, the push button will be displayed in light grey
in the Project overview window. If programming has been assigned, the push button will be shown in black. If a
push button belongs to an input group, it will be displayed in blue in the Project overview window.

g. Dragging input modules

If an input module has not been placed in the correct room, it can be moved to another room. To do this, select the
module to be moved. Click the module and drag it (by keeping the left mouse button pressed in) to another room.
Once it has arrived at the correct room, let go of the left mouse button. The module has now been moved to the
other room.

h. Adapting the Project overview window

The Project overview window can be adapted to your personal requirements.
First of all, it can be switched on or off by means of the Project overview command in the View menu. It the window
is visible, it can also be switched off by clicking the cross Xl in the upper right corner of the screen.

If the Extensive lay-out command in the View menu has not been selected (i.e. if it has not been ticked), it will not
be possible to move the Project overview window to another location on the screen. It is, however, possible to vary
the width of the window by clicking the right hand side and dragging it left or right.

If the Extensive lay-out command in the View menu has been selected (i.e., if it has been ticked), the Project
overview window is placed next to the Info window and the Connection list. The Project overview window can be
moved, and its size can be reduced or increased. To do this, first click the square icon Bl located in the upper right of
the window. The window can now be moved to another location by clicking and dragging. In addition, all the sides
can be modified by clicking and dragging.
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The info window

Adddress | Parameters |

Mew connection

Delete connection

Display all connections =

A Local input A
LOCE: Local input B

MDB F Iasl‘ n|

.| Filter condition

013

2 012 il

" 001 LP gar AB: Input [BF1: LP gar age W01 [On / off) Hone
" CO1_LP gar. | AB. Ingut (BF3. LP garage MO1 (O / off None
= 001 LP gar CF \ Ir off (Groups 03 (O, with F None
=& 002 LPkitc CF MO3 (OF, with 2s Hone
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As indicated by the name, the Info window offers information concerning different items. The content of the Info
window depends on the selected item in the Project overview window.

If, for example, the OUT button is activated, and, for example, a switch module has been selected in the tree
structure, an illustration of a switch module will be displayed at the top of the Info window.

EI ﬁ Distribution panel garage D cecsocce® coeoeeesppmm|E [ o Address / Parameters
- l =-Ep D1: Dimcontroller —las e e ™ : = g "
-llIIII__llllll-ll_?\. ew connection
IE' R1: Shutter module Lty (11T @~
. E- M ML E B e R L e e SmE e F Delete connection
.55 $2: Switch module iTiee e e

Display all connections ¥

In addition, an indication of the amount of module memory that has already been used will be shown. This memory
use depends on the number of programmed module outputs, the number of programs and the type of programming.

—— Connection list 51: Switch module( 11.0 % )

The largest part of the Info window is taken up by the Connection list. In our example (OUT button activated and
Switch module S1 selected), you will obtain an overview of all programming carried out for every output of the
selected switch module. You will, for example, find the output 001: LP garage three times. This output has been
programmed twice with the M01 (on/off) function for two different bus push buttons (BP1 and BP3). Furthermore,
you will see that the same output has also been included in the Central function group Master-off. There, the
output 001: LP garage is switched to the off-position by function M03. In column T1, you will see that you will have
to press the push button in question for two seconds in order to carry out this “Master-off* function.

Qutput Description Input Descri Connection Mode | T1 Filter
] : ICA: Local input A, /
012 LED Stawcase LOCE: Local input B h0B (Flashing)
=& 001: LP garage AB: Input (BP1: LP garage onfoff... | MO1 (On / off) N...

;ﬁ' o01: LP garage AB: Input (BF3: LP garage frear... | MO1 (On / off) N...

=£" 001: LP garage CF1: Master-off (Groups) MO3 (Off with ... | 28 N...

If output 1 of switch module 1 is selected in the Project overview window (with the OUT button still activated), the
content of the Connection list will be changed. You will now only see the programming for output 1 of switch
module S1.
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Cutput Description Input Description Connection Mode | T1 T2 A | Filter
001: LP garage AB: Input (BP1: LF garage onfoff...  MO1 (On f off) N...
=& 001: LP garage AB: Input (BP3: LF garage f rear... | WMO1 {On f off) N...
=%~ 001: LP garage CF1: Master-off (Groups) MO3 (Off, with ... | 28 N...

If the IN button is activated and an input has been selected in the Project overview window, the Connection list
will show the programming of the selected input.

Input Description Dutput Description Connection Mode | T1 T2 A | Filter
[E 2B Input 001: LP garage (S1: Switch ma...  MO1 (On f off) N...

[7 C: Input O02: LF rear outer wall {(52; Swit... | MOB (Delayed ... | & m N...

[d D¢ Input 002 LP rear auter wall (=2 Swit... | MO5 (Impulse) N...

If you double-click a row in the Connection list, the Create connections window will be opened. Here, you can
view the programming that has been carried out, and can modify it if desired.

The Info window buttons

Using the Address / Parameters button, you can assign an address to the currently selected module. Clicking the
button will open the Physical address screen.

If the New connection button is clicked, the Create connections screen will be opened.

If a programmed output or an input has been selected in the Project overview window, the Delete connection
button can be clicked. This will also open the Create connections window and will display the programming of the
selected output or input. This programming can be modified if desired.

If you have selected an output or an output module, you will only see the programming of the selected output in the

Connection list. If you wish to see the full programming of the output module to which the selected output belongs,
you can tick the option Display all connections.
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The Info window illustrations

If a module (input or output) has been selected in the Project overview window, an illustration of it will be displayed
in the Info window. If an output of an output module has been selected in the Project overview window, this output
will be indicated on the illustration by means of an inverse bar.

1 4
/7
/

Clicking an output in the illustration with the left mouse button will select this output in the Project overview window.

When a communication (RS-232) has been established with the installation, the output LEDs of the illustration will
also react in the same manner as the output LEDs of the relevant module in the installation. The illustration below
indicates that outputs 1, 2 and 12 of this switch module are in the on-position.

_________________ 1l
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If a 230V power supply is connected to the local inputs A and B, the corresponding LEDs on the illustration will also
light up.

If an output in the illustration is double-clicked while an RS-232 connection is active, the output in the installation will
be switched over.

If a bus push button has been selected in the Project overview window, you will also find an illustration of this in the
Info window. If an RS-232 connection to the installation is in place, and this bus push button is pressed in the
installation, this will also be visible in the illustration of the bus push button. When inactive, the bus push button
opposite, for example, will be pictured. If one of the buttons in the installation is pressed, the illustration below will be
seen.
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If the button is being pressed, it will be shown briefly as an orange circle.
If a data connection has been established, it is, however, also possible to proceed in the opposite way. Clicking one

of the buttons of a bus push button in the illustration of the Info window with the mouse will result in this command
being carried out in the installation.
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15.4. Project info screen

When creating a project, it is recommended to fill in the Project info screen. This data will also be used in the
printouts and for the clock functions.

@ Project info The screen can be called up by clicking the Project info command in the Edit menu. If the Function toolbar is
visible, it is also possible to click the relevant icon in order to open the screen.

Project info ﬂ E

Mame installer INiknhus installer

Telephone number installar IEIEISQB?BEIM?EI

Marme client INiknhus customer

Telephone number customer IDDSQB?EDMTD

Praject info | Starting programming the Mikobus software. =
Explained in a few steps.

¥
4 F

“ersion |12.002

Weekend days ™ Monday [ Tuesday
I Wednesday ™ Thursday
[ Friday IV Saturday
¥ Sunday
Q

The required data has been entered into the screen.

In any case, place a tick next to each weekend day of the end user. For clock functions, this information is used if
clock lines are only to be carried out on weekend days or on working days.

The window is closed again by clicking OK.
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The telephone number of the customer must be indicated in the Telephone number customer field. If it is the
intention to call up the installation of the end user by means of a modem, only figures may be used for this number.
For example, you should type in 037601470 and not 03/760.14.70. The customer’s area code must obviously also
be included. If the modem of the installer is connected to an internal analogue line of a telephone switchboard, it is
possible that another number (in most cases 0) must be dialled prior to the area code in order to first select an
outside line for the connection. For more details, please consult the switchboard manual.

The window is closed by clicking OK.
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15.5. Input groups screen

—= Create input group

==
foude |

Input groups: the use of this function is to group an unlimted number of inputs.
E g operation of 1 user from differant places

Make nes |

I~ Dont show this window again

Please enter the pame of the new Input Group:

|_P staircasa 5 min. on

OK | Cancel

TAE (reetimce- i RE-cortral)

General

In every installation one can find several push buttons that are to carry out exactly the same function. In order to
save time while programming, this type of push buttons can be placed in an input group. The input group will then be
selected while programming instead of an individual push button.

Opening the screens for the creation of input groups can be done in several ways. First of all, by selecting the
Create input group command in the Edit menu.

If the Function toolbar is visible, the Input groups icon it contains can be clicked. The same symbol is also visible,
and can also be clicked, in the Create connections screen.

If the command is activated, the Guide window will open. In this window, you can choose to either create a new
input group or to modify or delete an already existing input group. If desired, it is possible to put a tick next to the text
Do not display this window again at the bottom of this screen. If this field has been ticked, this screen will not be
displayed the next time the Create input group command or the Input groups icon is activated. If, in the course of
time, you would like to start the command again with the Guide screen, this can be done by clicking the Display
guide windows command in the View menu.

Creating a new input group

Click the Create new button in the Guide screen. A new window will open, in which the name of the new input group
must be entered. Enter a name here that is easily understood by everybody. The name LP (light point) staircase 5
min on indicates clearly what you wish to achieve with the push buttons that are part of this group.

Exit this screen with the OK button.

A new screen, Select mode, will then be opened. Contrary to what the name of this screen suggests, it is not the
intention that you select a mode, but that you indicate here whether the function you wish to program for the input
group can be carried out by a one-button operation, a two-button operation or a four-button operation. Depending on
this decision, only certain functions will be available.

Click one of the 1-button, 2-button or 4-button buttons and close the screen by clicking the OK button.

The Input groups screen will be opened. You will find the name you have just given to the input group in the top left
of the window. To its right, you will find your selection for a 1-button, a 2-button or a 4-button operation. In
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addition, the Input groups screen consists of two split-windows. In the split-window on the right, you will see the
tree structure of all inputs, as can also be seen in the Project overview window. In this split-window, an input that
belongs to the input group will be selected. By clicking the Add button, this input will be placed in the left split-
window. The name and location of an installed input is also indicated in a column.

This procedure must be repeated for each input that is part of the group.
Input groups HE

Inputgroup Type Mew input graup |

ILF' staircase 5 min. on j |1-buttnn il ify by e | Delete input group

Change narme input group

| Input ohject Component Location ﬁ Garage
=] A Input BP10: LP staircase Entrance hall E-fal Entrance hall
= =-E BP1D: LP staircase
B A Input
“.= B: Input
#-faj Toilet ground floor
#-faj Kitchen
=% Might hall
| E||:| BP11: LP staircasze
E| A Input
»= Delete == | ~[=l B Input
E-fa] Bathroom

<2 Add ==

When all inputs for this input group have been added, exit the screen by clicking OK.

In the Project overview and Create connections windows, the new input group has now been included under the
item Groups. By means of the latter screen, a program must now be connected to it.
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| Buttons and selection windows of the Input groups screen

Input
R In the Input group selection window, you can select the input group you wish to create, modify or delete.

LP kitehen central onfoff j

LP kitchen central ondoff
Waster-off kitchen
Type The Type of input can only be modified if no program has yet been linked to the currently selected input group. In

r this case, the Modify type button is clicked. By doing this, the Select mode window will be opened again, and the
| choice of a 1-button, 2-button or 4-button operation can be made.

1-buttan Modify type

When the Input groups window has opened, a new input group can be created by clicking the New input group
button on the upper right of the screen.

Plew input group

A selected input group can be deleted by clicking the Delete input group button. A confirmation window then

Delete input group appears in which the input group can be deleted or not.

The name of a selected input group can be modified by clicking the Modify input group name button. A window in

Change name input group which the new name can be entered will then be opened.

Adding a new input to a selected input group can be done by selecting the input in question and clicking the Add

<< Add << button.

An input can be deleted from a selected input group by selecting the input in question in the left split-window (where

o Laliiie =2 the inputs that already belong to the group are listed) and by clicking the Delete button.

The Input groups screen can be exited by clicking the OK button.
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15.6. Light scene / Central functions screen

=— Light scene f Central functions

Light scene / Central function: the objectif of this function is to group a limited number of outputs
e.g.: all on, all off, panic bution,

Make new

I~ DonY show this window again

| General

Please enter the name of the new light scene / Central Function

|M'=~s1e--u-T kitchen

oK I LCancel

In an installation, it often happens that several outputs must be operated by the same push button. It would be
possible to program each of these outputs in turn by means of the Create connections screen. In this case, every
output would have to be selected separately and a mode would have to be added every time. In addition, the
programming of every output belonging to a group would have to be assigned to the push button that operates this
group. This working method would be rather cumbersome.

Using the Light scene / Central functions command, it is possible to place several alliances in a group and to
program them all at the same time. This programming and the corresponding adjustments of the parameters can be
different for every output that is part of the group.

The screens for the creation of output groups can be opened in several ways. First of all, this can be done by
selecting the Light scene / Central functions command in the Edit menu.

If the Function toolbar has been made visible, it is also possible to click the Light scene / Central functions icon
here. The symbol is also visible and can be clicked in the Create connections screen.

If the command is activated, the Guide window will open, in which it is possible to create a new output group or to
modify or delete an existing output group. At the bottom of the screen, a tick can be placed next to the text Do not
display this window again if this is desired. If a tick has been placed, this screen will not be displayed the next time
the command or the Light scene / Central functions icon is activated. If, in the course of time, you would like to
start the command with the Guide screen again, this can be done by clicking the Display guide windows command
in the View menu.

IH
2humion

A-hurn

Lo e ||

Creating a new output group

Click the Create new button in the Guide screen. A new window will be opened, in which the name of the output
group must be entered. Enter a name here that is easily understood by everybody. The name Master-off kitchen
clearly indicates what we wish to achieve with this group.

You exit this screen using the OK button.

A new Select mode screen will be opened. Contrary to what the name of this screen suggests, it is not the intention
that you select a mode, but that you indicate here whether the function you wish to program for the output group can
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be carried out by a one-button operation, a two-button operation or a four-button operation. Depending on this
decision, only certain modes will be available.

Click one of the 1-Button, 2-Button or 4-Button buttons and close the screen by clicking OK.

The Light scene / Central functions screen will now be opened. Here, you will find the name you have just given to
the output group at the top left of the window. To its right, you will find your selection for a 1-button, 2-button or 4-
button operation. In addition, the Light scene / Central functions screen consists of two split-windows. In the split-
window on the left, you will see the tree structure of all outputs, as can also be seen in the Project overview
window. In this split-window, the output that should become a part of the output group will be selected. By clicking
the Add button, this output is placed in the right split-window. This installed output can be assigned a mode and the
corresponding parameters can be set up. In addition, a possible condition for the 230V inputs A and/or B can be
chosen.

This procedure is repeated for each output that belongs to the group. It is possible to assign another mode,
parameters or conditions to each individual output.
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e function

IMaster—oﬁ kitchen

j |1-hutt0n

Iyfodify type |

Delete function

Change function name

E-{5} Distribution panel garage
--E 01: Dimcontroller
#E2 R1: Shutter module
=2 S1: Switch module
2§ 001: LP garage
002: LPkitchen central
003: LP kitchen cooking a
004: LP kitchen washing L
Q0s: LP cloakroom
00e:
Q07: LP entrance hall
Q08: LP office wall
009: Yentilator toilet
010: LP toilet
011: LED Master-off
012: LED Staircase
H-E2 52 Switch module
&-fay Distribution panel attic

&

A0 8B A AN A A% A8 B 58

= Add ==

<< Delete << |

Output description hode

T1 T2 AB co...

=5 002: LPkitchen central (S1: Sw... | M02 (On, with opera...

0s None

=5 003 LP kitchen cooking area (...
-

MO02 (On, with opera...

0s None
| one

In order to set a mode or a parameter for a specific output, click with the mouse in the row of the output in question
and in the column you want to adapt. A drop-down selection list will appear in which the desired mode or parameter

can be marked.

When all the outputs for this output group have been set, the screen can be closed by clicking the OK button.

In the Project overview and Create connections windows, the new output group is now listed under the Groups
item. In this last screen, this group must now be linked to an input. To do this, select the output group and choose
Connection mode MCF (Activate 'Light scene / Central functions’). Then select the input that will carry out this

function.
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Buttons and selection windows of the Light scene / Central functions screen

Mewy function

Delete function

Change function name

== Add ==

=« Delete <<«

Ok

In the Light scene / Central function selection window, you can select the output group you wish to create, adapt

or delete.

Light scene / Central function

Master-off kitchen j
Master-off

Master-off kitchen

As long as no outputs have been assigned to the output group, the Type of operation can still be modified by clicking
the Modify type button. The Select mode window will then be opened again, and a 1-Button, 2-Button or 4-Button

operation can be selected in this window.

If the Light scene / Central functions screen has been opened, a new output group can be created by clicking the

New function button in the top right corner of the screen.

A selected output group can be deleted by clicking the Delete function button.

The name of a selected output group can be modified by clicking the Change function name button. A window will

be opened in which the new name can be entered.

It is possible to add an output to an output group by selecting the respective output in the left split-window and

clicking the Add button.

An output can be deleted from an output group by selecting it in the right split-window and clicking the Delete button.

The Light scene / Central functions screen can be exited by clicking the OK button.
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15.7. Create connections screen

| General \
orecimaine x|
- e e 5 The Create connections window is used to link an output or output group to an input or input group by means of a
' . 4 function or mode. The window is split into a left and a right split-window. In the left split-window, all the outputs are
B — displayed in a tree structure, as well as the created output groups. In the right split-window, inputs and input groups
e | are displayed depending on the selected mode. The Connection mode and the corresponding parameters can be
J set in the space between the two split-windows. If one of the 230V inputs A or B is used as a condition for the
= performance of the function, this can also be displayed here.
— A The screen can be activated by clicking the New connection command in the Edit menu. It is also possible to use
MNevy connection the button with the same name in the Info screen. If you wish, you can also open the screen by clicking the relevant
El=lBl=lw|]e] yEEEr e icon in the main toolbar or in the Function toolbar.
| Work sequence
In the Create connections screen, the quickest way of working is to enter all outputs and inputs in the Project
Output overview window first.
-3t Groups

a. Select an output
Always work from left to right in the Create connections window. An output or an output group (central function) are
therefore first selected in the left split-window Output.

Elﬁ' Distribution panel garage
=B D1: Dimcontroller

5 b. Select a mode and setting the parameters
FH-E R1: Shutter module

The selection window Connection mode is then opened by clicking the arrow to the right of the empty field. The

"E 510 Switch module content of this selection window depends on the selected output.
H-E2 520 Switch module
E-ta} Distribution panel attic If the selected output is an output group, you will see the function shown below.
=-E D2 Dimcontroller
=B 53 Switch module Cannection mode

H-E 54 Switch module - -
IMCF (Activate light scene / Centj

ElE 01: Dimcantraller If the selected output belongs to a dim controller, you will see the functions of the dim controller in the list.
€2 001: LP staircase
¥ 002 LP dining table

------ £ 003 LP couches -



EI E R1: Shutter module

- - 001: Terrace sunblind
: 002: Kitchen shutter

------ % 003: Shutters dining roam

=B S1: Switch module
- ZF 001: LP garage

=¥ 002 | Pkitchen central

Z& 003 LP kitchen cooking area

niko
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Connection mode

01
02
03
h04
05
MOG
w07
MOG
11
12

Dirn on £ off (2 buttons))

Dirn on £ off (4 buttons)

Light scene onfoff)

Light scene on)

On (if necessary with operatin
Off [eventually with operating t
Delayed off)

Flashing)

Freset onfoff)

Freset on)

P e e N e S i T i B e T e Y e I i’

If the selected output belongs to a blind module, you will obtain the view shown below.

Connection mode

[
I
MOT (Open - stop - close)

MOZ (Open)

MO3 (Close)

MO4 (Stop)

MOS (Interface- and RF-cantral)

MOE (Open with operating time)

MO? [(Close with operating time)

Finally, if the selected output belongs to a switch module, the selection menu will look as follows.
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W01 (Dirn on / off (2 buttans)

WOZ (Dirn on / off (4 buttans)

WOZ (Light scene on/off)

MO4 (Light scene on)

MOS (On (if necessary with aperatin
WIOE (Cff (eventually with operating t
W07 (Delayed off)

WOS (Flashing)

M11 (Preset anfoff)

M12 (Preset on)

Long Delay (upto 2h.)

[10s B

AB condition

Mone j

Mone
A,

B
LB
A,

‘B
[ATE)

N
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Connection mode

[
]
MOT (On f off)

M0Z (O, with operating time)

MI03 (O, with operation time)

hi04 (Fushbutton)

M0S (Impulse)

MOE (Delayed off (long up to 2h))
MO7 (Delayed on (long up to 2h))
MOS (Flashing)

fl11 (Delayed off (short up to S0sec
hl12 (Delayed ann (shart up to 50se
hl14 (Light scene on)

hl15 (Light scene an f off)

B e e N e e N e S e T e S g T e N i T i B i

You will notice that mode 13 of the switch module is missing. This is the sequencer. The sequencer must be
programmed in a different way. Chapter 6 and section 15.8 of this chapter have been fully dedicated to the
sequencer.

In the above screens, certain modes are indicated in black, others in blue, and still others in purple.

For the modes indicated in black, a bus push button requires only one operating point (A, B, C or D).

For the modes indicated in blue, a bus push button requires two operating points. These operating points are fixed
above and below each other. A choice can therefore only be made between the AB input and the CD input of a bus
push button.

For the modes indicated in purple, a bus push button requires four operating points. A four-way bus push button is
therefore required to operate this function. A, B, C and D of the bus push button will be programmed immediately.

A specific connection mode is selected by clicking it in the selection list.
Depending on the selected module and the selected mode, a specific value may or may not be added for the two

parameters. The relevant selection window is opened by clicking on the arrow at the right of the window. The value
of the parameter is clicked in the list, which results in this value being selected and the window being closed.
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Input

w ]
w0
w0
wF
w-

=

Cw=O

g
s

{5 Groups

IG1: LP kitchen central onfoff
1G2: Master-off kitchen

I1G3: LP staircase on

IG4: LP staircase switching
IG5: LP staircase & min. on
1GE: 1t

=-fal Distribution panel garage

51: Switch module

-

“@  LOCA: Local input A

B LOCE: Local input B

BF1: LP garage on/off

BPF2: Shutter garage up/down
BF3: LP garage / rear outer wall
BF4: Garage door

BPa: Master-off

=-fat Entrance hall

BF10: LP staircase

fal Toilet ground floor

BFS: LF tailet

Kitchen

BF&: Lighting kitchen
BFY: Lighting kitchen

=-£% Night hall

nNiko
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c. A 230V condition on A and/or B

If a 230V input A and/or B of the selected module is to be used as a condition, this must be indicated in the AB
condition field. Click the correct condition. By clicking the square at the right of the AB condition selection window,
a screen opens in which every selection option is explained. Here also, a selection can be made by clicking on the
corresponding button on the left.

Help window: AB - Condition

Don't impose a condition
. None
A Connection will be made if input A is equal to 2304
A
A Connection will be made if input A is equal to 0%,
1A
B: Connection will be made if input B is equal to 2304
B
B: Connection will be made if input B is equal to 0%
/B
A*B: Connection will be made if input A AND B are equal to 2304
AB
(ATB): Cannection will be made if input A OR B are equal to 0%
JATE)

d. Selecting an input or an input group

If a function has been selected in the Connection mode field, a tree structure of all inputs that would be suitable for
this selected function appears in the right split-window Input, listed by room. This means, for example, that if a mode
has been selected that makes use of 4 operating points, only bus push buttons with 4 operating points will be
displayed. For modes that require two or only one operating point, all bus push buttons will be shown.

For the input groups, this means that only those input groups will be displayed in which the number of operating
points corresponds with the selected function or mode.
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Add connection

IR1: IR bus pushbutton, 4 operation points

LOM1T: Master PC-Lagic campanent

=-F] PIRT Mikobus PIR

34AB: Input
L8 34CD: Input
35A8: Input
[& 35C0: Input
36AB: Input
[& 36COD: Input
I7AB: Input
[& 37CD: Input
3BAB: Input
[a] 35CD: Input
39AB: Input
L& 39CD: Input
EI] AE: Input

3 cO: Input

niko
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You will find a square with a plus symbol inside in front of every bus push button. If this is clicked, you will obtain a
breakdown of the components of the bus push button, again depending on the selected mode. For a bus push
button with two operating points, this will be A and B. For a four-way bus push button, this will be A, B, C and D. You
will find three examples below, one for a 1-button, one for a 2-button and one for a 4-button mode.

Eﬁ Garage
=[] BP1: LP garage an/off

B3 Garage

= D BP1: LP garage an/aff

L LE A8 Input

EI D BP2: Shutter garage up/down

: ------ L= AB: Input _

B D BPF3: LP garage / rear outer wall Eﬁ Garage

- E] AB Input =[] BP3: LP garage / rear outer wall
------ L cO; Input ...[58 ABCD: Input

Depending on particular modes, it is also possible to use the 230V inputs A and B of the selected module as inputs
for the execution of a function.

EI ﬁ Distribution panel garage
' El@ =1 Zwitch module
@ LOCA: Local input A
. g LOCB: Local input B

e. Confirmation of the settings and programming
Every assignment of a program to an input must be confirmed by clicking the Add connection button.

IR channels in the Input split-window

If one or more IR bus push buttons have been included in the project, you will also be able to see this in the Input
split-window. If you click on the small square with the plus symbol next to the IR bus push button, you will see the 39
channels plus the buttons of the bus push button itself. Now, which channels should be used for what?

The image you see in the Input split-window depends on the selected connection mode. Opposite, you will see an
example for the case in which the mode M01 has been selected for a switch module. This is a 2-button mode. For
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each channel, you will therefore see that the A and B inputs and the C and D inputs have been put together. If you
have selected a 1-button mode, you would see four inputs (A, B, C and D) per channel.

At the very bottom of the list, you will find the following: AB: Input and CD: Input. These are the buttons of the IR
bus push button.

It is possible to work with three different IR remote controls In the Nikobus range.

a. The Pronto remote control

When using the Pronto remote control, you have 39 channels available.

Niko delivers the Pronto together with a Nikobus application. By means of channels 1 to 30, the normal standard
operations can be transferred to the IR bus push button. In addition, two screens are available for storing 4 light
scenes each. Those two screens must be programmed in the Nikobus software under IR channels 38 and 39.

If you have the standard software of the Pronto remote control available, all 39 channels can be programmed
according to your personal requirements. You must then obviously create all windows and the layout yourself.

Other buttons and selection windows of the Add connection screen

bodify [ast added link |

[~ Display only unused inputs

Filter condition
ITrue j

False

= = B [

If it is found that the last programmed and added link was not entirely correct, the programming can be modified, and
the modification can be confirmed by clicking the Modify last added connection button.

If you only want to see the bus push buttons and other inputs to which no programming has yet been linked, place a
tick by Display only unused inputs under the Input split-window.

If a filter function has been programmed, this can be seen from the Filter condition window. Here, either a normal
or an inverted filter can be selected by clicking either the True or False option.

Starting from the Create connections window, it is also possible to open the screens for creating input groups,
output groups, sequencers, logical functions, filter functions, clocks or the presence simulation. This is done by
clicking the corresponding icon.

If you are operating several clock tables for, e.g., working days, weekend days, continuous clocks, etc., one or

several clock icons can be clicked in the Input split-window. By doing this, the corresponding clock tables will be
displayed in the Input split-window or not. See chapter 8 and 15.11 concerning working with clocks.
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The Create connections screen can be exited by clicking Exit. The added programming will be displayed in the

Exit Connection list of the Info window.
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15.8. Sequencer screen

| Description \

The sequencer is available as a function (or mode) of the switch module belonging to the Nikobus home automation
system. In order to program this special function within the Nikobus software, individual screens have been
developed.

F& Sequencer The Sequencer screen is activated by clicking the Sequencer command in the Edit menu. It is also possible to call

up the screen by clicking the relevant icon £ in the Function toolbar or in the Create connections screen.

The buttons and selection windows of the Sequencer screen

In the Module selection window, select the switch module with the outputs that will be used in the sequencer. If
several switch modules are included in the installation, you will find a list of those modules here.

Create a new sequencer by clicking the New sequencer button. The New sequencer screen is opened, and a

Mew sequencer name can be given to the sequencer. Exit this screen by clicking the OK button.

Hew Sequencer ﬂ

Please enter the name of the new Sequencer:

IGarden sprinkling]

(9]¢ Cancel

Selected sequencer If several sequencers have been created, the correct sequencer can be chosen in the Selected sequencer
SEQO1: Garden sprinkling j selection window.

By means of the Delete sequencer button, a selected sequencer can be deleted.
Delete sequencer
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Add output

Delete output
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The name of a selected sequencer can be changed by means of the Modify sequencer name button. On clicking
this button, the New sequencer window will be opened with the current name of the sequencer in the insertion field.
This can now be modified. Click the OK button to exit this screen.
Add an output of the selected switch module to the selected sequencer using the Add output button.

If an output is selected in the list of added outputs, it can be deleted using the Delete output button.

The second to the last output included in the sequencer can be moved up in the list by selecting the respective

el Move up output and using the Move up button. The sequence in which the outputs are shown in the list is also the sequence
in which the outputs will be switched on or off when the sequencer is activated.

1 Mave down The first to the last-but-one outputs included in the sequencer can be moved down the list by selecting the output
and using the Move down button. The sequence in which the outputs are shown in the list is also the sequence in
which the outputs will be switched on or off when the sequencer is activated.

Step | Dutput Maode Delay

1 001: Sprinkling group 1 M13 (Sequencer on / offi 10s

002: Sprinkling group 2 M13 iSequencer on / of 10 s

003: Sprinkling group 3

M13 iSequencer on / offi

In the large split-window of the Sequencer screen, all outputs that are part of the sequencer will be listed one below
the other. Click a row in the Output column to select the switch module output. Click the Delay column to set the
time frame during which the selected output should be in the “on” position.
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15.9. Logical functions screen

| Description \

With the Logical function command, it is possible to introduce powerful logical functions. A total of 64 logical
functions can be created within the Nikobus software. In order to be able to use these logical functions, a PC-Logic
module (05-201) must be part of the installation.

Calling up the screen

%= Logical function The Logical function command can be opened from the Edit menu. In addition, you can also make use of the
relevant L icon. This icon can be found in the Function toolbar and in the icon bar at the bottom left of the Create
connections screen.

In order to be able to use the command, a LOM1: PC-Logic used as ‘master’ module must be included in the
project. Add this module by means of the Product list.

The logical function screen

The Guide window is normally opened when the Logical function command is called up. Here, click on the Create
new button if you want to create a new logical function. If, however, you wish to modify or delete an existing logical
function, use the Modify or delete existing button.

Please enter the pame of the new Logical function:

[ If you select the Create new option, a name for the logical function you wish to create can be entered in the New
i logical function screen.

If the Guide windows have not been activated, you will jump directly to the Logical functions screen on activating
the Logical function command.
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L03: Function 1

Mew Logical function

Delete Logical function
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Logical functions

i i A Mew Logical functi |
Logical module Logizal functian Ut Lot LT

ILOM1: tlaster PC-Logic compaonent j ILDB: Function 1 j Delete Logical function |

taodify name logical function |

2B LOMT: Master PC-Logic compu;l = i [ |

..... BF L02: Light high £ wind low ilil I J | e
..... ::;-: LO2A: Light high / wind low | =] =] I j_|—’ -‘—
----- = L02E: Light high / wind low -y
----- 4 LMO1: Local input 1 ilil I I J
----- £ LMD1A; Local input 1 ili” | H— Function name:
----- 48 LMO1B: Lacal input 1 I o
----- 4 LMO2: Local input 2 — o Fneten |
..... £ Lvo24: Local input 2 == I ! L
..... I8 LMO2B: Local input 2 - = =
----- B LMO3: Local input 3 I e | - — T :
----- B LMO3A; Local input 3 == 22| ! LT
----- 48 LMO3B: Local input 3 I —
..... 4 LMO4: Local input 4 ilil I I J
----- 4 LhO4A: Local input 4
----- 48 LMO4B: Local input 4 === =
..... B LMOS: Local input 5 _I_II I E
..... B LMO5A: Local input 5 == ! j_l—_’ -‘—
..... £ LMOSE: Local input 5 i ' —|_|
----- 4 LMOE: Local input § ilil I J Ok

A I L RANE A | mmal bt | _'l_l ili” I j —

There is a lot to be seen in this screen. The different components are discussed below.

If a logical function has already been created, or if you have entered a name for a logical function that is still to be
created in the New logical function screen, it is possible to select the function you wish to perform, modify or delete
in the Logical function selection window.

From this screen, it is possible to create a new logical function by clicking the New logical function button. As a
result, the New logical function screen will be opened, in which you will be able to enter a name for the new
function.

In order to delete an existing logical function, you must first select the function in the Logical function selection
window. It is then sufficient to click the Delete logical function button to delete the selected logical function.
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Modify name logical function

|

I:l BF2: Bus pushbutton, 4 Dperatit;l
w-E CALT: PC-Link module

B- . LOM1 Master PC-Logic compo
LOZ: Light high £ wind low
LOZA: Light high £ wind low
LOZE: Light high /wind low
LO3: Function 1

LO3A: Function 1

LO38: Function 1

3 LMO1: Local input 1

48 LMO1A: Local input 1

48 LMO1B: Local input 1

-4l LMO2: Local input 2

-4 LMO2A: Local input 2

48 LMOZE: Local input 2

4 LMO3: Lacal input 3

-4 LMO3A: Local input 3

48 LMO3E: Local input 3

4 LMO4: Local input 4

4 LMO4A: Local input 4

SR RAOAR | el iv\n||+l.l| _I_'l
L3

www
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In order to modify the name of an existing logical function, first select the logical function to be modified in the
Logical function selection window. Clicking the Modify name logical function button will open the New logical
function screen, in which a new name can be entered for the selected logical function.

In the left split-window, all the inputs of the installation are listed, including the inputs of the PC-Logic module. In
addition, any clock channels are also displayed.

With the mouse pointer, select an input from this list that should be added to the logical function you wish to create.
The selected input is represented inversely.

EI LOM1: Master PC-Logic compo
----- D= L02: Light high / wind low

----- B= LD2A: Light high / wind low
----- B= LOZB: Light high / wind low
----- I L0O3: Function 1

----- P= LO3A: Function 1
----- P- LO3B: Function 1
Lh01: Local input 1
----- 4 LWO1A; Local input 1
----- 48 LMO1B: Local input 1

Add the selected input to the logical grid by clicking the button with the arrows pointing to the right.

5

As a result, the previously selected input will be included in a line in the logical grid.

ILMEH: Local input 1 (LOM1T: Mas

At the right side of this newly introduced input, you can decide to either opt for a normal operation of the input or for
an inversed operation of the input, depending on the type of input selected Have a look at the example below.
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LMOT: Local input 1 (LOM1T: Mas IDn { off j
CHOO1A: Channel (CALT: PC-Lin IF'uIse f Taggle j

A Input (BFZ: Push button, 4 op IF'uIse { Togale j
AB: Input (BFZ2: Fush button, 4 o IDﬁf an j

In the first line, the logical input 1 of the PC-Logic module is listed. This input can have two states, on or off. If you
wish to generate a True logic for this input at the moment that the input is high, select the option On / off in the
selection window.

A clock line is included in the second line of the logic grid. The complete clock channel has not been selected as the
input here, however, but only the rising edges of the time blocks that are present in this clock channel. In the
selection window, you will now find the word Impulse. It is not possible to modify this choice here.

You will also find the word Impulse in the third line. Here, you have, in fact, added only one operating location for a
bus push button.

In the fourth line, however, you have included the AB input for a bus push button. Here, you again have the choice
between normal or inverted operation. In this case, you have chosen an inverted operation here by selecting Off / on
in the selection window.

A maximum of 12 inputs can be included in a logic grid, divided into three groups. A logical operator can be
determined for each group of four inputs. In addition, another logical operator for the three groups can be chosen.
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Simulation

,

LhA01: Local input 1 (LOMT: Mas If:ln i off

CHOO1A: Channel (CALT: PC-Lin IImpuIae

g
| AT
| | —

Lk03: Local input 3 (LOMT: Mas IDn ! off ™| —

CD: Input (BFZ: Bus pushbutton, If:ln i off j—l__
| 1=
| [

A Input (BF1: Bus pushbutton, 2 IImpuIse

Fann)- -|—
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Simulation |

Function name:

L03: Function 1

Fany- | —

,_

8]

There is always a choice from 4 logical operators. In order to explain how this works, try the following: select one
operator after the other and then click the Simulation button. This will bring you into the Simulation screen, in
which you can test the reaction of the logical function output when the inputs are either on or off.

| The logical operators

a. The AND function:

As inputs, use logical input 1 (rising and falling edges) of the PC-Logic module and Clock channel CH001 (rising

and falling edges). Start with the AND function.
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Here, you will find two grey squares next to the inputs. This indicates that the inputs are low. By clicking one of the
squares, the input will become high. The colour of the square will then turn to green.

The status of the output is indicated next to the logical operators (in this case, two AND functions). The current
position is low. When the output is high, the output square will turn to green.
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el

=

J_.__J|L_

D [LMO1: Lacal input 1 (LOMT: Master PC-Logic com  [on / off B
[ ] [cro01: Channel (CAL1: PC-Link module - Distribu [0n / off j_|_|
| |
ILMD1: Local input 1 (LOM1: Master PC-Logic com IDn f off j
[ ] [cHont: Channel (CAL1: PC-Link module - Distribu [0 / of j_|_|
| | '
D [LMOT Local input 1 (LOMT: Master PC-Logic com  [n / of B
i ICHEID1: Channel (CALT: PC-Link madule - Distribur IOn { aff
| | 1T
[LMDT: Local input 1 (LOM1: Master PC-Logic com  [On / off B
[ ] [cHo0T: Channel (CALT: PC-Link module - Distribw [on / off j_|_|

1=

The output of the logical function only becomes high when both inputs are high.

b. The OR function:

Now select the OR function as the logical operator. This will result in the following possibilities.

D [LMOT Local input 1 (LOM1: Master PC-Logic com  [On / off

B

D [CHODT: Channel (CALT: PC-Link module - Distribu  [On / off

1 L

1

181



|me; Local input 1 (LOM1: Master PC-Logic com [ On / off

D [CHODT: Channel (CALT: PC-Link module - Distribu’ [On / off

D [LMDT: Local input 1 (LOMT: Master PC-Logic com  [On / of

|:| [CHODT: Channel (CALT: PC-Link module - Distribu’ [On / off

|me; Local input 1 (LOM1: Master PC-Logic com [ On / off

|:| [CHODT: Channel (CALT: PC-Link module - Distribu [0 / off

The output is high if one or both inputs are high.

c. The NAND function:

The third logical operator is the NAND function. This offers the following possibilities.

D [LMOT: Local input 1 (LOM1: Master PC-Logic com [0 / off -l

E' [CHOD1: Channel (CAL1: PC-Link module - Distribu  [On / off j_l_l 7 High
| | - |—E.

|Lmn1; Local input 1 (LOM1- Master PC-Logic com |On / off B

D [CHODT: Channel (CALT: PC-Link module - Distribu  [On / of j_|_| High

,
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|:| [LMDT: Local input 1 (LOMT: Master PC-Logic com  [On / off -l
D [CHOD1: Channel (CALT: PC-Link module - Distriby  [On / off j_|_| = | i
| | FI=TT— 39
ILMD1: Local input 1 (LOM1: Master PC-Logic com IOn ! off j
|:| [CHOD1: Channel (CALT: PC-Link module - Distribu” [0n / off j_|_| o - Low
| i |—E.
With the NAND function, the output is always high unless both inputs are high.
d. The NOR function:
Now select the last logical operator: the NOR function. Below possibilities are available.
EI ILMD1: Local input 1 (LOM1: Master PC-Logic com IDn ! off j
E| [CHOD1: Channel (CAL1: PC-Link module - Distribu  [On / off j—l_l , High
| | AT =
|me; Local input 1 (LOM1: Master PC-Logic com  [On / off [
D [CHOOT: Channel (CAL1: PC-Link module - Distriow  [on / off j_l_l ) | Low
| | 11 =
|:| ILMD'I: Local input 1 (LOM1T: Master PC-Logic com IOn ¥ off j
|:| [CHOD1: Channel (CALT: PC-Link module - Distribu [On / of j_|_| Low

|
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E' [LMOT: Local input 1 (LOM1: Master PC-Logic com [On / off

D [CHOD1: Channel (CAL1: PC-Link module - Distribu  [On / off

The output is now only high when all inputs are low.

@Dv ‘an

| Incorporating logical functions into other logical functions

One or more previously created logical functions can be incorporated into a logical function. The split-window with
the inputs of the Logical functions screen is, however, only refreshed when it is re-opened. If you have just created
a logical function, and you wish to incorporate it into another logical function, you must therefore first exit the Logical
functions screen by clicking the OK button and then re-open it by activating the Logical function command.

Logical functions

[21]

New Logical function

LMO2E: Local input 2

Logical module Logical function |
|LOM1 Master PC-Logic component _'I [LD& Function 2 j Delete Logical function |
Modify name logical function |
= o} Distribution board = : N : ' - ’ .
+[E] BP1: Bus pushbutton, 2 aperati ﬁlzl L03: Function 1 (LOMI: Master ¥ Iom o J | &I
+ [ BPF2: Bus pushbutton, 4 operatit _Iil | J—l_
= [ CAL1: PC-Link module | I J_l N i
CHA01: Channel g | |
CHOD1A: Channel = e [ [ Function neme:
gy CHOO1B: Channel
= B LOM1: Master PC-Logic compo - |Lﬂ4: Function 2
B LO2 Light high / wind low (_.:Izl ILMJ1: Local input 1 (LOM1: Mas IOn.-"off j
D* LO2A: Light high / wind low CHOD1: Ch | (CAL1: PC-Link |On / off
B L028B: Light high / wind low =2l e ok [on /o J_|— _: o —
B L03: Function 1 = =3 [ J_I_| |
BX LO3A: Function 1 )
B L03B: Function 1 ==l l
B LMO1: Local input 1
B LMO1A Local input 1 5 -
4+ LMD18: Local input 1 _I_“ l J |
$ LMO2: Local input 2 | | J_I_ |
B LMO24 Local input 2 >3 B |
- >l : g
- P

il e -v\nufﬁ ;lﬂ —Iill

Powerful logical functions can be created in this way.
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Creating connections with logical functions

Creating connections with logical functions takes place in the same way as making connections with bus push
buttons. Here also, the created logical functions are selected in the split-window Input of the Create connections
screen.

Depending on the connection mode chosen, the rising and falling edges of the entire function (rising and falling
edges) can be selected as the inputs for a program.

5B

T TAR LY

LOM1: Master PC-Logic component

LO1: Light low £ wind |ow
LOZ: Light high £ wind low
LO3: Function 1

LO4: Function 2

Lk0O1: Local input 1
LMOZ: Local input 2
LM03: Local input 3
Li04: Local input 4
LMOE: Local input &
LMOG: Local input B

=[] LOMI: Master PC-Logic component
LOTA: Light low / wind low
LO18: Light low § wind T
LOZ2A: Light high / wind low
LO28: Light high £ wind low

LO3A: Function 1
LOZE: Function 1
LO4A: Function 2
LO4B: Function 2

LhA01 A
Lh01 Bt
LA02A:
LhOZE:
Lr03A:
Lh03E:
Lra04A:
Lh04E:
Li05A:
LhOSE:
Lr0BA:
LhOBE:

Laocal input 1
Local input 1
Local input 2
Local input 2
Local input 3
Local input 3
Local input 4
Local input 4
Local input 5
Local input 5
Local input B
Local input B
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15.10. Filter function screen

| Description \

The Filter function command is used to create a filter or a flow function. The programming of an input will be carried
out or not depending on the position of another input. The Shift key implemented in chapter 7.2. is an example of
this.

Calling up the screen

@y Fitter Start the filter function by clicking the Filter command in the Edit menu. It is also possible to start the command by

clicking the relevant icon oy in the Function toolbar or in the icon bar at the bottom left of the Create connections
screen.

The Filter screen

The Filter screen mainly consists of three columns.
The first column indicates the number of the filter function. A maximum of 64 filter functions can be defined.

The input to be filtered must be selected In the second column (Input to be filtered). To do this, click an empty row

input to be filtered | Fi L. . . . L i

[ABCD: Input (BF2: Interior and exterior lighting - Living room) = inside this column. Select the input to be filtered by clicking it In the small drop-down screen.

LMO1: Local input 1 (LOM1: Master PC-Logic component - Distribution pand . agn . . . . . . .
LMO2: Local input 2 (LOM1: Master PG-Logic component - Distribution pand The last column (Filter condition) is used to select the particular input that will function as a condition for carrying
LMO3: Local input 3 (LOM1: Master PC-Logic component - Distribution pand t the i t lected in th d [ t H | lick th | t in th | d
LMO4: Local input 4 (LOM1- Master PG.Logic component - Distribution pand out the input program selected in the second column or not. Here also, click the relevant row in the column an
LMOS: Local input 5 (LOM1: Master PC-Logic component - Distribution pang SeleCt the deSired input by CliCking it.

LMOB: Local input 6 (LOM1: Master PC-Logic component - Distribution pang
AB: Input (BP1: Shift key - Living room

ABCD: Input (BP2: Interior and exterior lighting - Living room)

In the picture below, a first filter function has been defined.
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Filter n
Define Filters:

Number | input to be filtered Filter condition 1=
ABCD: Input (BPZ2: Interior and exterior lighting - Living room} AB: Input (BP1: Shift key - Living roomj)

.0 (00 |4 || i 3 [

3bd

]
[~ [0 i o (O 0 o 0 0 00 P i f P = (D

I

e
O

[ oK I Delete row |

In the above example, you can see that the program of bus push button BP2 is dependent on the position of bus
push button BP1.

| A normal or an inverted condition

Filter condition When making a connection to an input that is provided with a filter, you can indicate whether this is a Normal or an
T j Inverted filter in the Create connections screen. In the same way as for the Shift key of chapter 7.2., it is possible
I rue to link two different programs to the input with a filter, whereby one program will be performed if the condition input is

_ True and the other program will only be carried out if the condition input is False.
False
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15.11. Clock function screen

| General \

By using the PC-Link module (05-200), powerful clock functions can be implemented in every Nikobus installation.
We would refer you to chapter 8, Working with clocks, and in particular to section 8.1. Using Clocks, for a
practical example of working with clock functions.

Opening the clock function screen

Clack function The Clock function screen can be opened by clicking the Clock function command in the Edit menu. It can also

be activated by clicking the relevant icon in the Function toolbar or in the icon bar at the bottom left of the
Create connections screen.

The clock function screen and its components

Below, you will find an example of the Clock function screen in which eight clock channels have already been
created. The screen that appears is always in the display mode Month, with the current day active.

The largest part of the screen is taken up by the grid. Every row represents one clock channel, and a maximum of

100 clock channels can be created. Per clock channel, time blocks can be fixed, with 500 time blocks being available
on the full clock function.
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W =

Channel Modify channel name |

|CAL1: PC-Link module

=] |cHoos: channel 5

Delete channel |

Weekday

Day | Weak

WWeekend day

Simulation Continuous I Exception

I Manth ‘fear | |12 j IAugust j |2IZII33 :I

CHOO3
CHOD4
CHOOE
CHOO?
CHOOZ
CHO0S
cHO10
CHO11
CHO12
cHO13

Mewr tirme block I

_Iﬂilililililﬁ

Delete time block |

Iililﬂlﬂlﬂlﬁlﬂlﬁlﬁlﬂﬁlﬁl&l&lﬁlﬁlﬁlﬁl&l&lﬁlﬁlﬂlﬂl 4

hodify time block | (8]

The different components of the screen are discussed below.

In most cases, only one PC-Link module (05-200) will be installed per Nikobus installation. It is, however, possible
to implement several PC-Link modules within the same installation if this is required. For this reason, select the
module you wish to program under the PC-module item.
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Select a clock channel by clicking the channel in the Channel window. It is also possible to select a clock channel by
clicking one of the buttons while the mouse pointer is on the left of the grid.

CHOOS

The name of a selected channel can be modified. As a matter of fact, the name Heating ground floor reveals much
more about what you wish to achieve with this clock channel than the standard name CH005. Select the channel
and click the Modify channel name button. The Channel window will be opened, in which you can enter a new
name.

Channel x|

Modify channel narme:

IGraund flaor heating|

8] Cancel

Exit this window by clicking the OK button. The modifications will be saved.
If you wish to delete a clock channel, first select the channel and then click the Delete channel button.
Every clock channel is related to a particular clock schedule. Five clock schedules can be used within the Nikobus

home automation system: these are: Weekday, Weekend day, Simulation, Continuous and, finally, the Exception
schedule. These five schedules are represented by different colours in various screens.

Weekday Wweekend day Simulation Continuous Exception

In order to keep an overview, it is possible to make the clock channels that are linked to a certain schedule visible or
invisible in the grid. To do this, you click the button with the colour that is relevant to the clock channels. Assuming
you do not wish to see the simulation channels on the screen, the red button should be clicked. This then results in
picture below.
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_Iﬂililﬂililﬁllililﬂlﬂlﬂﬁlﬂﬁlﬁlﬂﬁlﬂlﬂlﬂl&lﬁlﬂlﬂﬁlﬂﬁlﬁlﬂlﬂl -
[CHon2 | |
CHOO3
CHOO4
CHODB

YWeek

The buttons and drop-down windows shown below are all related to what is displayed in the time grid.

Day Week | I Month Vear | 12 2] |August B

Whenever the Clock function screen first appears, the Month button is selected. A column is displayed in the time
grid for each day of the month. It is, however, possible to look at the clock channels in more or less detail by using
the Day, Week or Year buttons. These screens will be briefly discussed below.

With the day overview, you will obtain the picture below.

lo |1 J2 Iz 4 |5 s Jz I o Jiwo [11 J12 J13 |14 15 |16 J17 |18 [19 |20 |21 [22 |23 | j

% Channel

CHOO3 Channel
CHOD4

There are now 24 columns, one for each hour of the day. This will give you a clearer view of exactly what will be
carried out in terms of clock lines on certain days.

The overview for the week will produce the following picture.

| MWonday - 11 | Tuesday - 12 | YWednesday - 13 | Thursday - 14 | Friday - 15 | Saturday - 16 | Sunday - 17 | ﬂ
CHOOZ Cl Cl Cl
CHOO4 Ch Ch
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There are now seven columns, one for every day of the week. The selected day is represented by the white

background of the column header. Clicking one of the column headers will return you to the day display of the day
you clicked.

The month overview will result in the following picture.
_|L|ﬂilﬂililﬁllililﬂlﬂﬁlﬁlﬂlﬁlﬁlﬂﬁlﬁlﬂl&lﬂlﬁlﬁl&l&lﬂﬁlﬁlﬂlﬂl -

CHOO3
CHOD4

Depending on the month, there will be as many columns shown as there are days in the selected month. The
selected day is indicated by the white background of the column header. By clicking on one of the column headers
on a certain day, the day schedule for that day will appear.

Finally, you will obtain the following as the picture for the overview of the year.

| Jan. | Feh. | hdar. | Apr. | lay | June | July | A | Sep. | COct. | Mo, | Dec. |ﬂ

CHOOS
CHOO4

This picture represents a full overview for the year. There are now 12 columns, corresponding to the months of the
year. The selected month is represented by the white background in the column header. If you click one of the
column headers, the display for the month on which you clicked will appear.

It is also possible to select a date by means of the selection fields next to the display buttons.
In this screen, another four buttons are shown. The first one of these is New time block. After you have selected a

clock channel, it is possible to add a new time block by using this button. This will open the Time block screen,
which is discussed below.
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Using the Delete time block button, it is possible to delete a selected time block from the grid. A time block is
selected by clicking with the mouse pointer in the time block in question inside the clock channel in which it is
located (one of the rows of the grid). When doing this, and where required, use the display buttons to provide
yourself with more detail in order to make a correct selection where several time blocks have been assigned to the
clock channel.

Attention: The selected time block will be deleted immediately after clicking the Delete time block button; there is
no subsequent confirmation screen. A deleted time block can only be recovered by creating a new time block and re-
programming everything.

A selected time block can also be modified by clicking the Modify time block button. Here also, the Time block
screen discussed below will be opened.

Finally, there is the OK button, which allows you to exit the Clock function screen.

Creating a time block

One or more time blocks can be inserted into every clock channel, with a maximum of 500 time blocks per PC-Link
module (05-200).

In the Clock function screen, first select the clock channel in which you wish to add a new time block. Clicking the
New time block button will result in the screen below.
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Time block

it [NATER

E=rid bt

el = pjelefzji=s

Channel |CHODB: Channel If you have already selected the correct clock channel in the Clock function screen, this screen will also display the
selected clock channel. If this is not the case, you must first select a clock channel here, in the Channel selection
field (see left).

194



ISaturday

|25

j I.January

NIEENE

ISaturday

|25

j I.January

NS
Starts: | £:30:00 j
Ends | 8:00:00 j

niko

Iluminating ideas.

You must then indicate the clock schedule in which you wish to create the time block by clicking one of the coloured

buttons. You therefore click either the Weekday, Weekend day, Continuous or Exception button. At this stage,
you are not able to create a Simulation schedule. A separate function and separate screens exist for this.

You will only be able to enter the start date and the end date in the relevant selection windows once a schedule
button has been clicked.

You then indicate the times at which a time block should start and end. This will result in the following picture.

x|
| Weekend day | |
[term infa
Channel CHOOE: Channel Duration: |1 Haur, 30 Minutes
Start Date: ISaturday |25 j IJanuary j IEDDS :I Starts: | 6:30:00 j
End Date: ISaturday |25 j IJanuary j IEDDS :I Ends | 8:00:00 j

Assuming you would like to have only this one time block carried out for clock channel CH006, you can return to the
Clock function screen by clicking on the OK button at the bottom of the Time block screen. By putting the other
schedules in the “invisible” position in this last screen, the picture below is obtained.

| Weekend day | | |

Day || Week Month | Vear | |25 z|Juanuary N

| Monday - 20 | Tuesday - 21 | Wednesday - 22 | Thursday - 23 | Friday - 24 | Saturday - 25 | Sunday - 26 | il
CHooz2

On the channel CH006 row, you will find the newly created time block in the Saturday - 25 column. Clicking the
column header Saturday - 25 will take you to the day display. If you touch this time block with the mouse pointer,
you will see the information concerning this time block in the small Tooltip window.
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2 o{CHOOE: Chanrel

Starts: 25/1/2003 &:30:00
Ends: 25/1/2003 &8:00:00
Duration: 1 Haour, 30 Minutes
A epetition;: --

Modifying a time block

If you wish to modify a time block, you can click the Modify time block button in the Clock function screen.

Modify time block | Double-clicking on the time block itself will take you back to the Time block screen.

Using repetitions

F Use repetition You want to program the created time block with a repetition, as it should not be carried out only once, but several
times. Select the correct time block and return to the Time block screen. In this screen, tick the Use repetition
option. By means of certain buttons, you can select a daily, weekly, monthly or annual repetition. All these options
are discussed in detail for the Continuous clock schedule. Certain items may or may not be used, depending on the
clock schedule selected.

Daily repetitions for the Continuous clock schedule

Daily

a. Every how many days?

Click the Daily button. Three options are offered. The first option is a repetition every x days. Should the repetition
take place every day, you leave the number 1. It is, however, also possible to select, for example, a repetition every
three days by selecting 3 by means of the arrow buttons.

—Repetition Type

Draily o Every how many days ? m
Waekly
. Every g dag
Manthly
Yearly (o Everyweelend day
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b. Every working day
By clicking the selection circle next to Every working day, the time block will only be repeated on working days. If

you have ticked the weekend days in the Project info screen, the software will obviously “know” which days are
working days.

& | Bvery working day

c. Every weekend day
By clicking the selection circle next to Every weekend day, the time block will only be repeated on weekend days.

You indicated which days are the weekend days for the end user in the Project info screen.

= Every weekend day

o Weekly repetitions for the clock schedule Continuous

Click the Weekly button for repetitions every x weeks.

—Repetition Type
Daily
— Every how many weeks ? 2 =
I Weekly
On which day(s) ? [~ Sunday [~ Monday
Monthly
[~ Tuesday v Wednesday [~ Thursday [w Friday [~ Saturday
Yeatly

Here, you can indicate the number of weeks between each repetition, and the days on which is to take place. In the
above example, the time block is repeated every two weeks on Wednesdays and Fridays.
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........................ M Elr'lt|“'I|'_'," Monthly repetitions for the Continuous clock schedule

If the repetition should only take place on a monthly basis, click the Monthly button.
—Repetition Type

Daily Ewery how many months ? 1 =

Weekly :

Cl | Every Iﬂrst j IMUnday j
Yearly

S a. Every how many months?

: 1
Every how many menths ? s By means of the arrow buttons, indicate in the number field every how many months the repetition must take place.
& | On which day 7 % - b. On which day?
Click in the On which day selection field to select a particular day for the monthly repetition. Select the day in the
number field.
c. Every

If you do not wish to select a fixed date number for the repetition, you can also click the selection circle Every. In
here, you can indicate on which day in which week of the month the repetition should be carried out.

2 Every second j Thursday
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- | Annual repetitions for the Continuous clock schedule

For annual repetitions, will click the Annual button.

ey O

-

a. In which month?
First, select the month in which the repetition should take place.

b. On which day?
Click in the On which day selection field to select a particular day of the selected month for the annual repetition.
Select the day itself in the number field.

c. Every
Or, click in the selection field next to Every if a fixed day of a fixed week in the selected month is required for the
annual repetitions. Click on the week of the month In the first field, and on the day of the week in the second field.

TR | R
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Indicating the repetition duration

The duration of the repetition must be determined for every programmed repetition. There are several possibilities.
Whether a particular possibility can be used or not depends on the type of repetition.

—Repetition duration
Start Date: |Saturday 25 January 2003 10 Mo Enddate
i Enid after I1 3 Repetitiaris).
C End Dzte (130 2] fAugust o ooz 4

It is necessary to indicate a start date. This is the date on which the original time block will be carried out for the first
time.

a. No end date
If you click the No end date selection circle, the established repetition will never stop.

(o Mo Enddate

b. Stop after x repetitions
You can, however, also indicate that the repetition should only take place a few times.

0 End after IE 3: Repetition(s).

In the above example, the number of repetitions is set for 3. The time block in question will be carried out three times
in total.

c. Using an end date
Finally, you can also choose to set an end date for the repetitions. On the determined end date, the time block will
be repeated for the last time.

5 End Date [25 =] [Apri
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Suspending repetitions

A programmed repetition can also be suspended for a certain period in time. This is, for example, handy if a holiday
period has been planned. In order to arrange for this, put a tick next to Exclude repetitions. Subsequently, you
enter the date on which you would like the exclusion to start, followed by the number of days the exclusion should be
applied for.

¥ Exclude repetitions Starts: |11 jIJuIy j IEDEB :I Duration: IM 3: Day(s)

In the above example, the time block will not be carried out during the holidays.

Within the Clock function screen, the exclusion will be indicated by the colour grey.

Azl als e |7 |8 | o [hal r{ 2] ] 14l ls] 161 17| 161 18] 20] 21 22]/55] 24] 25 | 261 27] 56 28] 501 51| =
choms| | 1L

CHOO?7

Assigning a clock channel to a alliance

When exiting the Clock function screen with the OK button, you will find the programmed clock channels in the
Project overview window together with the sensors (inputs). Creating a connection between a alliance (output) and
a clock channel id carried out in the same way as programming a push button. The only difference is that you assign
a clock channel in place of a push button. Every time a time block becomes active or inactive in the clock channel,
the selected function (mode) will be carried out.

The view you will obtain in the Input split-window depends on the selected function.

If, for example, you select connection mode M1 (on/off) for an output of the switch module, the selected alliance will
be switched on when a time block becomes active, and this alliance will be switched off when this time block is
finished.

If, however, you select connection mode M2 (on), the picture will look quite different. The selected alliance of the
switch module can now be switched on according to your wish, either when the time block becomes active, or when
the time block is finished.

After assigning the input, the program must be confirmed by clicking the Add connection button.
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If a number of clock channels have been created, it is handy to use the coloured icons under the Input split-window
in order to make certain clock schedules alternately visible or invisible. In the opposite example, you will only be able
to see the clock schedules Continuous and Exception.

| @ [n [~

Assigning a clock schedule to a push button

Normally, you can use the feedback bus push button to activate or de-activate clock schedules. The description of
the clock schedules and the feedback bus push button can be found in section 8.3. The different clock schedules.

You can, however, also activate a clock schedule by connecting it to an ordinary bus push button. To do this, open
the Create connections screen. Select the clock schedule you wish to activate in the Output split-window. For
example, MO2: Weekend mode.

Note that the Continuous schedule is not pictured here, and, as a result, cannot be selected. As a matter of fact,
this schedule is always active and cannot be activated by a push button.

On the other hand, you will see M03: Automatic mode. You have not met this schedule before. If this schedule is
activated, either the working day schedule or the weekend day schedule will be activated, depending on the point in
time (working day or weekend day) at which this schedule is called up.

As Connection mode, select MSM (Activate mode) and then select an operating time for the push button. The

program is finalised by selecting a bus push button in the Input split-window and then clicking the Add connection
button.
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15.12. Presence simulation screens

| General \

With the powerful presence simulation function of the Nikobus home automation system, burglary prevention can be
actively practised. This function can only be carried out and programmed if a PC-Link module (05-200) has been
included in the installation.

Opening the presence simulation screen

The presence simulation screen can be opened by clicking the Presence simulation command in the Edit menu. It

can also be opened by clicking the presence simulation icon G:'. This icon can be found in the Function toolbar
and in the icon bar at the bottom left of the Create connections screen.

Presence simulation [ 2] ]

Starls | Ends | Output | Connection mode | Vanation

Qutput for feedback |

Add activities |

oK |
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| Adding activities to the simulation

Add activit Activities have to be added to the presence simulation. Each activity represents the performance of a function by a
activities certain alliance at a certain point in time. Click the Add activities button. The screen below, Select output, will be
opened.
Select output EE
Cutputs
[ER%J Distribution panel garage
. =B D1: Dimcantraller Output
B R1: Shutter module I
E-ER 51 Switch module
- =-E2 520 Switch module i g
=-fal Distribution panel attic cONNBCHon made
=-E3 D2: Dimcontraller I j
w-E2 53 Switch module
H-E 54: Switch module Time (On/Open)
. =
1015 o
Time (OfiClose)
. =
[10:15 =
A Eetivity
Cancel
connection mode In the left split-window, an output is selected by clicking it. The connection mode is also activated. The connection
mode is limited to one possibility for every output module. For the dim controller, this is mode M01 (Dim on/off 2-
IMEH (On £ off j buttons). For the blind module, this is connection mode M01 (Open-stop-close). And, finally, mode M01 (On/off) is

used for the switch module.
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In addition, the points in time at which the alliance must be switched on and off must be indicated in this screen. This
can be easily done by using the arrow keys next to the relevant fields. To change the minutes, first click the minutes
with the cursor and then use the arrow buttons.

Click the Add activity button to add the newly created activity to the presence simulation. A new activity can be
created and added to the simulation straight away. Once the last activity has been added to the simulation, leave the
Select an output screen by clicking the Cancel button. You will now see the added activities in the Presence
simulation screen.

otarts Ends Clutput Connection mode

2322 2341 001: LP garage (S1: Switch module) BAOT (O F offt

2315 2339 Q07 LP entrance hall (S1: Switch module) 01 (O off)

2115 0730 Q05 Office shutter (E1: Shutter module) 01 {Cpen - stop - close)

Determining an output for the feedback

When the presence simulation is active, it is possible to receive feedback, for example by means of a push button
with LED. In this way, the user is aware of whether or not the simulation is “on”.

To arrange this, click the Output for feedback button.

The Select output screen will be opened. Here, click the desired feedback output in the tree structure with the
outputs. In this case, this is output 011: LED Simulation of switch module S1. Exit the screen with the OK button.
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Choose output ﬂ E

Select the output that will flash 5 times
if the simulation is activated.

Elﬁ Distribution panel garage

®E=2 D1: Dimcontroller

2B 51 Switch module

~Zg= 001: LP garage

-.ZE= 002: LPkitchen central

2§~ (003: LP kitchen cooking area
2§~ 004: LP kitchen washing up
.25~ 005 LP cloakroom

2 OB

-.2F= O07: LP entrance hall

-2g= 008 LP office wall

2§ 009 Wentilator toilet

28 010 LP toilet

2R LED Sirmulation
.25 012: LED Staircase
H-E 52 Switch module
#-{ai Distribution panel attic

0k I Cancel

| Working with variations in the presence simulation

If the inhabitants of the house have left for two weeks (holidays), it does not make much sense to perform the same
activities every day at the same time. The pattern would appear too structured to the outside world. As a matter of
fact, the presence simulation may thereby cause exactly the opposite effect.

With the Nikobus home automation system, a variation can be linked to the simulation. By means of the small
Variation window, you have a choice between: no variation, 10 minutes or 30 minutes. If you select the “no
variation” option, the activities will be carried out at the scheduled times.

If, however, you set the variation for 10 minutes or 30 minutes, every activity will start and stop within a time frame of
10 or 30 minutes before or after the scheduled time. Assume you have selected the setting of 10 minutes variation in
a particular case, the activity that would normally start at 20:00 h, will, for example, start at 19:54 h on one day and,
for example, at 20:08 h on the next day. Using this variation, the simulation becomes more realistic, which is exactly
its purpose.
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Other buttons in the Presence simulation screen

Modify activity

=-F CALL PC-Link maodule
MOT: Week mode
MO2: Weekend mode
MO3: Automatic mode
MO4: Exception mode
=ih: Simulation

Some additional buttons can also be used in the Presence simulations screen.

Select an activity line and click the Delete activity button in order to delete the selected activity from the simulation.
Select an activity to be modified by clicking the corresponding activity line. Now click the Modify activity button in
order to adapt the selected activity. The Select an output screen will be opened. Modify the activity in this screen

and exit by clicking the Modify activity screen.

Use the OK button to exit the Presence simulation screen.

Connecting the simulation to a push button

By making use of the feedback bus push button, the user can switch the presence simulation to the active or the
non-active position. The feedback bus push button does not need to be programmed for this.

It is, however, also possible to have the simulation activated by making use of an ordinary bus push button. To
arrange this, it is best to select a type with LED for the feedback. Connect the LED of the bus push button to the
selected feedback output (by means of a bell ringing transformer).

Open the Create connections screen in order to do the programming. In the left split-window Output, select SIM:
Simulation under CAL1: PC-Link.

As Connection mode, choose MSM (Activate Presence simulation).

Then select the push button that will have to activate the simulation in the Input split-window. Close the program by
clicking the Add connection button and exit the window by means of the Close button.
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Port

>
o Connect

Az=ign addresses

15.13. Download and upload screens

A project that has been configured in the computer can be transferred to the installation. This is called
“downloading”. The data that is present in an installation can also be transferred to the computer. This we refer to as
“uploading”. Both functions can be carried out if the computer is connected to the installation by means of a PC-Link
(05-200) or a PC-Logic module (05-201). Furthermore, downloading, uploading and even remote operation of
circuits is possible by making use of two modems. One modem is placed at the installer's premises, while the other
has been installed at the customer’'s premise. For more information on this, see chapter 15.15. Remote log-in
through a modem.

Connection between computer and installation

From the computer, an RS-232 connection is made to the installation. Two Nikobus components can play a role in
this. You can use the PC-Link module (05-200) or of the PC-Logic module (05-201). Once the physical connection
has been established, it is possible to start the communication. To do so, first of all identify the correct COM-port in
the Program menu by using the Port command.

The connection is then made by clicking the Connect command in the Program menu, or by clicking the icon for
this command in the Function toolbar.

The connection status can be seen in the status bar at the bottom of the screen.

® | 0:00:00 There is no communication between computer and installation.

e com  |oo004 There is active communication between computer and installation.

The Input addresses screen

If the communication between computer and installation has been established, the addresses of the installation
components must be assigned to the components in the software.

The screen is opened by using the Assign addresses command from the Program menu.
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Input adresses K=
Received address | Time | Type | Assigned address | Type | Input
D D1: Dimcontroller (Distribution board)
R R1: Shutter module (Distribution board)
S 31: Switch module (Distribution board)
------ EBF BP1: Bus pushbutton, 2 operation points (L
------ EBF BP2: Push button, 2 operation points + LEC
------ EBF BP3: Bus pushbutton, 4 operation points (L
------ EP BP4: Bus push button, 8 operation paints (1
------ I IE1: IR bus pushbutton, 4 operation points {
------ RF RF1: EFE6S Transmitter, 16 operation paint
==lecignEs |
BElete |
Delete all
4] | |
I Only display addresses that have nat yet been assigned, [ Only display modules that have no address,
Listen [n]%4
Listen Click the Listen button to receive the addresses in the left split-window.
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Transferring addresses of components

Received address

Time

Type

105676

07:22:34

BPAG/CRARY...

Every component has its own specific system for transferring its address to the computer.

a.

c

"o Qoo

RF hand transmitter: First, press one of the small keys (humbers 1 to 4) and immediately afterwards one
of the large keys (A, B, C or D) to transfer the address.

RF wall transmitter: Press one of the operating locations of the push button in order to transfer the
address. It does not matter whether the upper or lower part, or the left or right part are pressed.

(Compact) switch module: Press the Mode button until you hear the beep.

Blind module: Press the Mode button until you hear the beep.

(Compact) Dim controller: Press the Mode button until you hear the beep.

PC-Link module: Press the navigation button of the PC-Link module several times (the button in the
middle of the module) until you see the message SEND ID at the top of the small LCD screen. Confirm this
menu selection by pressing the confirmation button (with the green tick) once. Now press the confirmation
button once again in order to actually transfer the address.

PC-Logic module: Press the navigation button of the PC-Logic module several times (the button in the
middle of the module) until you see the message SEND ID at the top of the small LCD screen. Confirm this
menu selection by pressing the confirmation button (with the green tick) once. Now press the confirmation
button once again in order to actually transfer the address.

Nikobus motion detector: The flush mounting motion detector consists of a flush mounting socle (05-7X5
/ 430-0050X) and a sensor (XX-784 / 1XX-78400) that is clicked onto the socle. Pressing long on the button
at the top of the cover results in sending a Nikobus address. Data transmission security: in case there is a
conflict on the bus, the telegram is automatically resent.

Binary interface: Activating one of the inputs of the binary interface results in sending a Nikobus address.
Push buttons interface: Press a connected push button of the push button interface (05-056) to transfer
its address to the computer.

Switch interface: Put the switch that has been connected to the switch interface (05-057) briefly in the on
or off position to transfer the address to the computer.

IR bus push buttons: Press one of the operating locations of the push button to transfer the address. It
does not matter whether the upper or lower part, or the left or right part are pressed.

Thermostat: press the arrows to manually increase/decrease the temperature until the contact
closes/opens. You hear a beep in confirmation.

Feedback bus push buttons: press one of the control spots of the push button to send the address. It
does not matter whether you press on top or at the bottom, left or right.

Feedback module: Press the navigation button (middle button on the module) until SEND ID is displayed
on the LCD display. Confirm your menu choice by pressing the confirmation button once. Press again to
send the address.
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Assigned address | Type | Input
O 01: Dirncontroller (Distribution board)
R F1: Shutter module (Distribution board)
5 S1: Switch module (Distribution board)
BP BF1: Bus pushbutton, 2 operation points (L

BP2: Push button, 2 operation points + LED
BP3: Bus pushbutton, 4 operation points (L

------ BFP EFP4: Bus push hutton, 8 operation points (1
------ R RE1: IR bus pushbutton, 4 operation points {
------ RF RF1: RFEEE Transmitter, 16 operation point
Delete
Delete all
I Only display addresses that have not yet been assigned,

[T Only display modules that have no address,

oK |

nNiko
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Transfer the address of the Nikobus component to the computer. This address can be seen in the left split-window,
together with the time it was transferred and the type of component.

This line is selected by clicking it with the mouse cursor. The component is then selected in the right split-window of
the Input addresses screen. Only now can you connect both the selected lines (in the left and right split-window) by
clicking the Assign button.

FrAssigh=s

The address will now appear next to the module in the right split-window.

Assigned address | Type | Input

O 01: Dirncontroller (Distribution board)
R F1: Shutter module (Distribution board)
= 51 Switch module (Distribution board)

BEF1: Bus pushbutton, 2 operation points (L
BF2: Push button, 2 operation points + LEQ

105676

------ EP EF3: Bus pushbutton, 4 operation points (L
------ BP BP4: Bus push button, 8 operation points (L
------ IR IE1: IE bus pushbutton, 4 operation points |
------ RF EF1: FF868 Transmitter, 16 operation point

The other buttons and fields to be ticked in the Input addresses screen

If a component has been selected in the right split-window to which an address has already been assigned, the
Delete button will delete this address.

If all the assigned addresses should be deleted, use the Delete all button.

If several allocated addresses are already displayed in the left split-window, it may be more convenient to place a
tick next to Only display addresses that have not yet been assigned.

In the same way, a tick can be placed next to the message under the right split-window: Only display modules that
have no address.

Use the OK button to exit the Input addresses screen.
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The program screen

Select modified modules

If the components’ addresses have been assigned, the computer program must be transferred to the installation. A
communication link must obviously already be in place between the computer and the installation.

The Program screen is opened by clicking the command with the same name in the Program menu, or by clicking

the corresponding icon in the standard toolbar.

In the left split-window, all the programmable modules of the installation are listed. For the initial programming, all
modules will be displayed inversely. This means that they must all be programmed. If programming has already
taken place at an earlier stage, only those modules that must be programmed anew will be displayed inverse.

Programming

@
- CALT: PC-Link module
D1: Dimcantroller

LOM1: Master PC-Logic component

Installation progress:

=1: Switch module

Module progress:

Program

Select modified modules

Select all

If required, all modules can be selected by using the Select all button.

If only those modules must be programmed for which the software has been modified since the latest download, use

the Select modified modules button.
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By clicking various modules with the mouse pointer, these can be selected or un-selected for program.
Click the Program button to start the program. The downloading process can be followed on the screen.

Installation progress:
]

Module progress:

CALT: PC-Link module : 336/4576

If the downloading process has been completed, the following message will appear on the screen.

Module progress:

Finizhed successfully

The Program screen is closed using the OK button.

Important: If several programs are transferred to the installation in succession, it is desirable to carry out a new
initialisation of the installation by briefly (for a minimum of 5 seconds) interrupting the installation’s power supply.
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Uploading installations

It is a good habit to make a back-up of the software used, both while programming in the software and after
downloading the data to the installation. In this way, you always has the latest version of an installation available.
This back-up can be saved on a diskette or on a CD-ROM. Store these media in a safe and dust free environment.

If you have to work with an installation for which no software file is available, you must work in a different way. The
installation can be read out. To do this, two steps must be taken. First, the project overview must be loaded down
from the PC-Link module. The program of the modules must then be read out.

Attention: When reading out from an installation, some information will always be lost. First of all, all output and
input names are represented in standard values. In practice, this means that if a switch module output was named,
for example, 001: light point staircase, it will only be referred to as 001: Switch output after an upload.
Furthermore, certain clock channel time blocks will no longer be represented as they have originally been
programmed. In particular, this concerns those time blocks that originally had been programmed with a repetition
including an end date for the repetition.

If it is necessary to carry out an upload, the time blocks of the clock channels must therefore be checked afterwards.

Reading out a project overview

The computer must be connected to a PC-Link module. A communication link must be established. Click the Load
project overview from PC-Link command in the Program menu.

A confirmation screen will be opened. Here, the Yes button is used if one really want to channel the project overview
from the installation to the computer. The current set-up of the software will be overwritten. Click the No button if you
do not wish to do this. If required, open a new project and carry out an upload afterwards.

If the uploading continues, all modules of the installation (both outputs and inputs) will be displayed in the Project
overview window after a brief waiting time.

Reading out the program

Once the project overview of an unfamiliar installation is available, the programming can be read out. Ensure that a
communication link has been established between the computer and the installation.
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The Load existing installation screen will be opened using the Load existing installation command from the
Program menu. This screen is almost identical to the Program screen. The Program button, however, has been
replaced here with the Load existing installation button.

Load existing installation

ﬁ Location_1
-2 CAL1: PC-Link module

~E2 D1: Dimcontraller

[ LOMI: Master PC-Logic corpanent Installation progress:
: . Switch module

Module progress:

| Load existing installation I

Select modified modules |

Select all | Ok |

Use the Select all button to display all modules inversely. Then click the Load existing installation button to start

the upload to the computer.
oK

Exit the screen by using the OK button.
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15.14. Print screen

The Nikobus software is provided with the option to make an extensive print-out of your projects. This can be added
to the home automation file in order to complete the information concerning a project.

Screen Print components

Print components HE After clicking the Print or Print preview command, the Print components screen will be opened. Here, tick those
items you wish to have printed on paper or displayed on the screen. You have a choice of one or more of the
Select which parts you wish to print out; following components:
- Installation: The data you have completed in the Project info window will be printed out.
¥ project info
_ - Locations: A list of the various locations in the project. The installed Nikobus components are indicated and
[v  Locations . .
printed out per location
¥ Input groups
- Input groups: Provides an overview of the various input groups that have been created.
¥ Output groups
¥ Sensors - Output groups: Provides an overview of the various output groups that have been created.
G s - Sensors: This list shows the sensors that have been used in the project.
[V  Interfaces
- Actors: Provides a list with all output modules. Every programmed output is listed here. In addition, the connection
mode, parameters and possible conditions and filters for every program have been included in the list.
— Lancel | - Interfaces: Prints a list of the interfaces that have been used and their programs. The PC-Link and the PC-Logic
modules have been included here, among others.

Print preview screen

If the Print preview command has been activated in the File menu, the Print components screen will be opened
and completed. Exit this screen by means of the OK button. The print preview will be opened.
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@ nikobus - [Nikobus project 1.nkb] = 5]

ﬂextF‘ageI Erey: F'agel QnePagel Zoom [n | Zoomgutl LCloze |

2. Locations
ry——
34 Disasibusion posd sy e
A Bl Enich awdule (0500007 - Bvack sodule) No sddsss
i e
[5] BBL: Bus puskibums, 7 oo g 05060 - Bus pushlbiume, 7 opesii poms) Mo s

1. Installation

Telephias ausder st
Puujert i

Wi dii

Pages 1-2 | [ [ R |o:omon
s A@ W 7 |[ 2 nikobus - mikobus pr.. [Ble #L2d &OD 15848

A button bar is included at the top of the screen.

Erint... | et F"agel Frex Page | One Page Zoom |k I Zn:n:-mQutI{_ L

Prirt... | You can go to the print order using the Print button.
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The next page or the previous page can be viewed by clicking the Next Page or Prev. Page button respectively.

If there are 2 pages visible per screen, you can go to a print preview with 1 page per screen by clicking the One
Page button.

Enlarge or reduce the details on the page by using the Zoom In and Zoom Out buttons.

Use the Close button to exit the Print preview screen.

Printing

Select the Print command in the File menu. The Print components screen will be opened. Here, tick the items that
must be printed and exit the screen by means of the OK button. The Print screen will be opened. Complete this
screen according to your requirements and click the OK button to start printing.
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15.15. Remote log-in through a modem

In chapter 15.13. Download and upload screens, you have seen that it is possible to transfer the program from the
computer to the installation (downloading), but that you can also transport data from the installation to the computer
(uploading) by means of a direct link between the computer and the installation. It is, however, also possible to carry
out these functions from a distance. In this case, you must make use of two modems and a telephone connection.

System requirements for installations and modems

At least one PC-Link module (05-200) must be present in the installation.

Two modems must be available: one at the installer’s and a second one at the customer’s. Both modems must have
been initialised previously (more about this later in this document). The modems must be HAYES-compatible and
must have non-volatile memory. For example, a US Robotics 56K fax modem is recommended.

Initialising and connecting the modems

a. The installer’'s modem

First of all, the modem is connected to the installer's computer by means of the cables that are delivered with the
modem. For an external modem, two cables are used. On the one hand, a connection with an analogue telephone
line is made. On the other hand, the modem is connected with the computer’s serial port (COM port). Initialise this
modem by means of the modem’s installation instructions.

b. The customer’s modem

First, initialise the customer's modem with the installer's computer. Connect this modem to a free COM-port of the
installer's computer by means of the supplied PC cable (with DB9 connector).

Start up the Nikobus software and open the customer’s project. There, first check that the customer’s telephone
number, which will be used to call his installation by means of the modem, has been correctly entered. To so this,
open the Project info window. This window can be made visible by clicking the Project info command under the
Edit menu or by clicking its icon in the Function toolbar.

The customer’s telephone number must be indicated in the Telephone number customer field. Only figures may be
used in entering this number. For example, type 037601470 and not 03/760.14.70. The area code of the customer
must obviously also be entered. If the installer's modem is connected to an analogue internal switchboard line, it is
possible that an additional number (usually 0) must be dialled prior to the area code in order to obtain an external
line for the connection. Please consult the switchboard manual for more details.
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Mame installer |Mikobus installer
Telephone number installer |003237601470
Mame client |Mikobus customer
Telephone number customer 003237601470
Program Wiews Window  Help If the customer’s telephone number has been entered correctly, the Project info screen is closed by clicking the OK
[Laed|projet oyeryieyy fram EE=Lik % %| N o @ button.
.2_. Bragramm x|
5| (Lol exsting mstalation Move the mouse pointer over the Port item in the Program menu. A selection menu will be opened in which all
nJ CoM 1 serial ports of the computer are listed. Here, click the COM-port to which the customer's modem has been
¢ Connect & COMi et connected. In most cases, this will be COM 1 or COM 2.
Assipmaddresses m COM 2
e >
%% Connect e Then click the Connect command in the Program menu or the icon with the same name %€ in the Standard
_'i’ L8 1 RS e = toolbar.
0J coma

The customer’'s modem is now being initialised. When the sounds (made by the modem) stop (this only lasts a few
seconds), this task is finished. The customer’'s modem can now be disconnected and be taken to the customer’s
installation.
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At the installation, the customer’s modem will now be connected to an analogue telephone line. On the other side,
the cable with a DB25 connector, which is part of the Niko delivery, is connected to the modem. The other end of this
cable (with RJ12 connector) is connected to the PC-Link module.

Attention: If the customer's modem is only fitted with a DB9 connection, you must use an DB9-DB25 adapter.
Under no circumstances should the connector that has been delivered by Niko be used for this purpose.

Calling in via the modem

Load the Nikobus software on the installer's PC. Open the customer project with which you wish to call in through
the modem. Then select the correct serial port which is linked to the modem (of the installer). This is done by means
of the Port item in the Program menu.

Following this, click the Connect command. This command can be also found in the Program menu. The SET
ACCESS text will appear on the small LCD screen of the PC-Link module. If you do nothing now, this text will be
displayed for approximately 30 seconds, after which the connection will be interrupted. To establish a connection

with the PC-Link, the user must now manually allow access by briefly pressing the confirmation key of the PC-
Link module twice.

Downloading and uploading through the modem

The process for downloading or uploading by means of the modem is identical to the standard procedure for
downloading or uploading. We therefore refer you here to chapter 14: Downloading the program to the
installation and to section 15.13. Download and Upload screens.

Apart from downloading and uploading entire projects, it is obviously also possible to carry out operations from a

distance and to receive feedback about, e.g., when a push button is pressed or concerning the position of the
outputs of an output module.
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More information required? Call on Niko any time!
The Niko Customer Service

tel. +32 3 760 14 82
fax +323 77771 20
e-mail: support@niko.be

The Niko helpdesk is a team of enthusiastic and experienced specialists. They are happy to help and to offer advice
in many areas, such as drawing up offers, calculations and the selection of materials.

Niko not only delivers quality products, but also supports installers, inspectors and project managers with the
selection and installation of its products.

Documentation required? Catalogues and folders can be obtained from the Communication Department.

e-mail: sales@niko.be
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